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LICENSE AGREEMENT 
 

YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE 

INSTALLING THIS SOFTWARE PACKAGE. INSTALLING THE SOFWARE PACKAGE INDICATES 

YOUR ACCEPTANCE TO THE CONTAINED TERMS AND CONDITIONS. IF YOU DO NOT AGREE 

WITH THEM, YOU SHOULD PROMPTLY RETURN THIS PACKAGE, IN REUSABLE CONDITION, 

FOR A FULL REFUND OF THE PURCHASED PRICE. 

 

SIMPLICITY SOFTWARE TECHNOLOGIES provides single copies of this software 

("computer program") and licenses its use. You are responsible for the 

selection of the program and the installation, use and results obtained. 

 

You may not sub-license, assign or transfer the license or the program 

without expressed permission from SIMPLICITY SOFTWARE TECHNOLOGIES. 

 

You further agree that this is the complete and exclusive statement of 

agreement, oral or written, and any other communications between us relating 

to the subject matter of this Agreement. 

 

SIMPLICITY SOFTWARE TECHNOLOGIES licenses this software as either a single 

user version or as a site license, unlimited users version. This is done 

through the activation file that is supplied by SIMPLICITY SOFTWARE 

TECHNOLOGIES. Once the software is activated, this licensing condition is 

also indicated in the About dialog screen found within the main section of 

the application. 

 

For Single User licenses, THIS LICENSE permits you to: 

 

1.  Use the program on a maximum of one computer or workstation at a single 

facility. 

2.  Copy the program onto a hard drive or other media for use on a maximum of 

one computer or workstation located at the same facility. 

3.  Modify the program and/or merge it into another program for use on the 

maximum of one computer or workstation. 

4.  Transfer the program and license to another party if the other party 

agrees to accept the terms and conditions of this Agreement. If you transfer 

the program, you must at the same time transfer all copies of the original 

single copy to the same party or destroy any copies not transferred, and 

5.  Copy the databases used by this program to single computer or to a 

network drive to be shared by no more than 1 computer or workstation. 

 

For Site licenses, THIS LICENSE permits you to: 

 

1.  Use the program on as many computers or workstations as needed, at a 

single facility. 

2.  Copy the program onto a hard drive or other media for use on as many 

computers or workstations as needed, located at the same facility. 

3.  Modify the program and/or merge it into another program for use at a 

single facility. 

4.  Transfer the program and license to another party if the other party 

agrees to accept the terms and conditions of this Agreement. If you transfer 

the program, you must at the same time transfer all copies of the original 

single copy to the same party or destroy any copies not transferred, and 

5. Copy the databases used by this program to single computer or to a 

network drive to be shared by a single facility. 
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The conditions above also apply to any portions of the program contained or 

merged in other programs. You must reproduce and include the copyright notice 

on any copy, modification, or portion merged into another program. 

 

YOU MAY NOT USE, COPY, MODIFY, OR TRANSFER THE PROGRAM OR ANY COPY, 

MODIFICATION, OR MERGED PORTION IN WHOLE OR IN PART, EXCEPT AS EXPRESSLY 

PROVIDED FOR IN THIS LICENSE. IF YOU TRANSFER ANY COPY, MODIFICATION, OR 

MERGED PORTION OF THIS PROGRAM TO ANOTHER PARTY, THIS LICENSE IS 

AUTOMATICALLY TERMINATED. 

 

YOU MAY NOT USE, COPY, MODIFY, OR TRANSFER THE ACTIVATION FILE SUPPLIED BY 

SIMPLCITY SOFTWARE IN ANY WAY WHATSOEVER. You may however make a single copy 

of the file for backup purposes only. 

 

This license is effective until terminated. You may terminate it at any time 

by destroying the program along with all copies, modifications and merged 

portions in any form. It will also be terminated upon conditions set forth 

elsewhere in this Agreement. 

 

THIS PROGRAM IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER 

EXPRESSED OR IMPLIED. THE ENTIRE RISK AS TO THE PERFORMANCE OF THE PROGRAM IS 

WITH YOU, IF THE PROGRAM PROVE DEFECTIVE. YOU ASSUME THE ENTIRE COST OF ALL 

NECESSARY SERVICING, REPAIR, OR CORRECTION. SOME COUNTRIES DO NOT ALLOW 

EXCLUSION OF IMPLIED WARRANTITES, SO THE ABOVE EXCLUSION MAY NOT APPLY. 

 

SIMPLICITY SOFTWARE TECHNOLOGIES does not warrant the function contained in 

the program will meet your requirements or the operation of the program will 

be uninterrupted or error-free. However, SIMPLICITY SOFTWARE TECHNOLOGIES 

does warrant that the media on which the program is furnished is to be free 

of defects in materials and workmanship under normal use for 180 days from 

the date of shipment. 

 

SIMPLICITY SOFTWARE TECHNOLOGIES ENTIRE LIABILITY AND YOUR EXCLUSIVE REMEDY 

FOR THE PROGRAM SHALL BE THE REPLACEMENT OF ANY DISKETTE OR CD-ROM FOUND TO 

BE DEFECTIVE. IN NO EVENT WILL SIMPLICITY SOFTWARE TECHNOLOGIES BE LIABLE FOR 

DAMAGES, INCLUDING ANY LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR 

CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABLILTY TO USE SUCH 

SOFTWARE. SOME COUNTRIES DO NOT ALLOW EXCLUSION OF IMPLIED WARRANTITES, SO 

THE ABOVE EXCLUSION MAY NOT APPLY. 

 

IF THIS SOFTWARE IS INSTALLED AS A "TRIAL VERSION", IT SHOULD EITHER BE 

REGISTERED WITH SIMPLICITY SOFTWARE TECHNOLOGIES, OR REMOVE FROM ALL 

COMPUTERS WITHIN FOURTY-FIVE DAYS OF INITIAL INSTALLATION. 

 

THIS LICENSE CAN ONLY BE MODIFIED BY AN AUTHORIZED REPRESENTATIVE OF 

SIMPLICITY SOFTWARE TECHNOLOGIES, AND MUST BE SIGNED BY AN AUTHORIZED 

REPRESENTATIVE. 
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Human Resources 

The Human Resources module is used to store important information about your work force or 

associates. Information found here includes their position, address, telephone numbers, emergency 

contacts and more.   

Please note that this database is the same database used by the Scheduler module where you create 

work assignments. It’s also used in virtually every module in the system that use employee assignments 

of one type or another 

 

This module does not stop at just being used as an employee assignments database. There are many 

other features such as training scheduled and completed, insurance options elected, scheduled 

activities, dependents and more.  Each employee can even include their own Documents Database 

where the information tracked can be almost unlimited. 

Ribbon Control 
The comprehensive functionality of the Human Resources module is provided via a set of Ribbon tabbed 

pages. Ribbon pages are structurally and visually split into logical groups. Each of these groups includes 

commands that perform specific functions. 
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HOME TAB 

 

The following are the elements on the Home ribbon tab, reading left to right: 

• Add New – Creates a new blank record in the database. 

• Save Changes – Saves all current changes from all elements of a record (master save). 

• Lookup – Invokes the Employees Lookup dialog to select a record. 

• Activities Calendar – Invokes the HR Calendar or Scheduler where you can view scheduled 

training, vacations, leaves and more. 

• General HR Documents- Invokes the Documents Database routines as it related to the Human 

Resources database and discussed in the Common Features chapter. 

• Individual Documents- Invokes the Documents Database routines as it related to the currently 

selected associate record and discussed in the Common Features chapter. 

• Individual Notes – Allows the viewing and editing of the notes assigned to the current record. 

• Search - Invokes the search/find routine on the Lookup Grid. 

• Exit Module - Close and exits the module. 

FILTERS TAB 

 

The following are the elements on the Filters ribbon tab, reading left to right: 

• Default Filter – Shows every record in the database. 

• Active Employees – Shows every record in the database that has not been marked as Inactive. 

• Inactive Employees – Shows every record in the database that has been marked as inactive. 

• Maintenance Lists – Show only those records that have the Include in Maintenance Lists set. 



Maintenance Coordinator – Professional Features 

 

Simplicity Software Technologies Inc. | Lookup Tab 35 

 

REPORTS TAB 

 

The following are the elements on the Reports ribbon tab, reading left to right: 

• Comprehensive Employee – This allows you print on selectable elements of an employee’s 

record. 

• Training Report – Invokes the Training Report Setup wizard to assist creating a training report. 

• Telephone List – Create a telephone list report. 

• Address List – Creates a report with all employees and their addresses and phone numbers. 

• Calendar – Activities Reports – All the available reports in this section invokes a date selection 

dialog to report on the scheduled activities of the selected type. 

Lookup Tab 
This tab helps in locating records by grouping, filtering and sorting them. All the records in the current 

filter are located in the grid found here. To select a record and make it the active record, the user needs 

only to click on the record from within the grid. Once selected the user can click on the other tabs to 

view or edit the record itself. 

The following image illustrates the features available on the Lookup tab: 

 

The functions of the Lookup tabs are used through-out the system and are fairly common regardless of 

the modules that use them. Please review the chapter on Common Features to read about the 

functionality of the controls located on this tab. Pay special attention to the following: 

• Using the Lookup Grids 

• Searching 
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Details Tab 
Under the Details tab you can setup your identification information, and general assignments for the 

selected associate.  

General Information 
This section allows you to specify general information about the current associate. This information is 

found in the General Information group, location within the Details tab.  

The following illustrates the elements found in this section: 

 

Reference ID 
This field should be unique in your database, but it’s not an enforced rule. It is used to help identify your 

associate. Edit this field by typing in the space provided. This field can accept up to 30 alpha/numeric 

characters. 

Once the Full Name field has been entered you can click on the Auto Reference button to have the 

application create the Reference field for you. 

To insure the Reference is unique in the database, click on the Check Reference button. 

Full Name 
This alpha/numeric field will accept up to 40 characters and represents the employee’s full name. For 

lookup purposes it is recommended that you use the format: last name, first name. 

Job Title 
This alpha/numeric field will accept up to 30 characters and represents the associate’s assigned job. 

Shift/Crew 
This alpha/numeric field will accept up to 30 characters and represents the associate’s assigned shift or 

crew. 
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Department 
This alpha/numeric field will accept up to 30 characters and represents the associate’s assigned 

department. 

Reports To 
This alpha/numeric field will accept up to 40 characters and represents the associate’s assigned 

supervisor or team leader. Clicking the Select button adjacent to this field will invoke the Employee 

Database lookup dialog which can be used to make the assignment. 

E-Mail 
This alpha/numeric field has no size limitations and represents the associate’s email address. 

Telephone Numbers 
The information stored in this area represents the phone numbers related with the selected associate. 

Each of these alpha/numeric fields can contain up to 15 characters each with the exception of the 

Extension field. The Extension field is limited to 5 characters. 

The following illustrates the elements found in this section: 

 

Address Information 
The information stored in this area would represent the resident information as it applies to the 

selected associate. 

The following illustrates the elements found in this section: 

 

Address 
Both of the address fields found in this section would indicate the street addresses of the selected 

record. These alpha/number fields can contain up to 30 characters each. 
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City 
This alpha/numeric field can contain up to 30 characters and represents the city the associate resides in. 

State/Region 
This alpha/numeric field can contain up to 30 characters and represents the state or region the associate 

resides in. 

Postal Code 
This alpha/numeric field can contain up to 10 characters and represents the postal code used for the 

associate’s resident. 

Country 
This alpha/numeric field can contain up to 30 characters and represents the country the associate 

resides in. 

Picture 
This section allows you to set or store a picture of your associate. Options available to this feature are 

accessible from the pop-up menu associated with the image. 

The following illustrates the elements found in this section: 

 

To set the Associate’s picture 

• Move to the Picture group found on the Detail tab. 

• Right mouse click on the picture control to invoke the pop up menu. 

• Click on the Load option. 

• Using the Open dialog, browse to where you have the picture stored on your system. Supported 

formats include: bmp, gif, jpg, ico, png and tif. 

• Click on the image file to select it and click the Open button. 
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• Save your changes by clicking on the Save Changes option in the ribbon.  

Memo 
This is an on screen notes section and can be directly edited. This alpha/numeric field has no size 

limitations. 

Confidential Profile Tab 
Under the Confidential Profile tab you can continue making assignments as they apply to the selected 

record. 

Confidential General Information 
This section allows you to record some additional, general type information on the selected associate. 

The following illustrates the elements found in this section: 

 

Date of Hire 
This date only field would indicate the date the associate was hired. 

Date of Birth 
This date only field would indicate the date of the associate birthday. 

Gender 
Selectable from the drop down, this would indicate the sex of the associate. 

Status 
Selectable from the drop down, this would indicate the current status of the associate. Options include: 

Active, Leave of Absence, Medical – Personal, Medical – Business, Family Medical Leave and Terminated. 

Payroll Information 
This section allows you to record payroll information on the selected associate. The following illustrates 

the elements found in this section: 
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Hourly Rate 
This floating point field is used to record an associate’s hourly pay rate. This information is used with 

work order labor calculations. 

Social Security Number 
This alpha/numeric field can contain up to 12 characters and is used to record an employee’s social 

security number. 

Marital Status 
This alpha/numeric field can contain up to 12 characters and is used to record an employee’s marital 

status. 

Exemptions Claimed 
This is a numeric only field and is used to record tax related exemptions. 

Additional Amount 
 This floating point only field is used to record any additional amount an associate my want withheld 

from the pay. 

Payroll 1 – 3 
These 3 alpha/numeric fields can each hold up to 30 characters each, and are used to record any 

additional payroll information you may want to maintain (union dues, etc.). 

Emergency Contact Information 
This section allows you to record contact information to be used in the case of an emergency. 

 

Emergency Contact Name 
This alpha/numeric field can contain up to 40 characters and is used to record the name of the 

associate’s emergency contact. 

Emergency Contact Relationship 
This alpha/numeric field can contain up to 30 characters and is used to record the relationship the 

emergency contact has with the selected associate. 

Emergency Contact Telephone Number 
This alpha/numeric field can contain up to 15 characters and is used to record the telephone number to 

use when contacting the emergency contact. 
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Miscellaneous Checklist 
Found on the Confidential Profile tab, and the sub tab of Miscellaneous, this section allows you to 

check-off specifics on the selected associate. 

 

These fields are self-explanatory, and you would place a checkmark for each item that apply. 

Termination Record 
Found on the Confidential Profile tab, and the sub tab of Miscellaneous, this section allows you to 

record termination information on the selected employee. 

 

Date Terminated 
This is a date only field and would indicate the date that employment with the company was 

terminated. 

Reason for Leaving 
This alpha/numeric field can contain up to 50 characters and is used to record why an employee left the 

company. 

Willing to Rehire 
Checking this field would indicate your willingness to rehire a former employee. 

Security (Clearance) 
Found on the Confidential Profile tab, and the sub tab of Miscellaneous, this section allows you to 

record an associate’s security clearance. 
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Security Clearance 
This alpha/numeric field can contain up to 30 characters and is used to record the assigned security 

clearance of the selected employee. 

Security Level 
This alpha/numeric field can contain up to 30 characters and is used to record the assigned security level 

of the selected employee. 

Date Granted 
This is a date only field and would indicate when the above security information was granted. 

Training (Database) 
Found on the Confidential Profile tab, and the sub tab of Training, this section allows you to record 

training the employee has received by the company. The following illustrates the elements of this 

section: 

 

Creating a New Training Record 

• Move to the Confidential Profile tab and click on the sub tab of Training 

• Locate the data control found in this section and click on the Append (+) button. 

• From the invoked Training Record dialog, move through the various fields and enter the 

appropriate information. 

• Click on the Accept button when done. 

• Click on the Post (checkmark) button in the data control to save the new record back to the 

database. 
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Editing a Training Record 

• Move to the Confidential Profile tab and click on the sub tab of Training. 

• Locate and make active the training record you want to edit from those listed in the grid located 

there. 

• Click on the Edit Selection button. 

• From the invoked Training Record dialog, move through the various fields and edit the 

appropriate information. 

• Click on the Accept button when done. 

• Click on the Post (checkmark) button in the data control to save the modified record back to the 

database. 

Using the Training Record Dialog 
Training records are created and edited using the Training Record dialog screen. The following 

illustration shows the elements of this dialog: 

 

• Employee – This field is automatically set by the application and indicates the associate this 

record applies to. 

• Description – This alpha/numeric field can contain up to 30 characters and is used to identify 

the type of training that was provided. 

• Date – This date only field indicates the date the training was provided. This is set by using the 

attached drop down calendar. 
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• Certificate – This alpha/numeric field can contain up to 30 characters and is used to identify the 

type of certificate (if any) that was provided on the completion of the training. 

• Institution - This alpha/numeric field can contain up to 30 characters and is used to show where 

the training was conducted. 

• Renewal Date – This date only field would indicate when training on this subject will be required 

again (re-certification). 

• Schedule – Clicking this button will invoke the Employee Scheduler where you can schedule an 

event to be included with the Activities Calendar.  See the section on the Employee Scheduler 

found in this chapter. 

• Accept – Clicking this button accepts any changes and closes the dialog. 

Employee Scheduler 
The Employee Scheduler is used to create and edit planned activities as they relate to individual 

associates. The following illustration shows the elements of this dialog: 

 

• Employee – This field is automatically set by the application and indicates the associate this 

schedule applies to. 

• Start Date and Time – These two fields are used to schedule the start date and time of the 

event. 

• End Date and Time – These two fields are used to schedule the end date and time of the event. 

• Activity Type – This field is selectable from the drop down list box and would indicate the type 

of event being scheduled. Options include: Training, General, Renewal, Vacation and Leave. 
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• Comments –There is no size limitations to the alpha/numeric field and is used to record any 

additional information you want to include on the current schedule. 

• Accept – Accepts any new or changed information and closes the dialog. 

Employee Activities 
Found on the Confidential Profile tab, and the sub tab of Activities, this section allows you to schedule 

and maintain scheduled events for the selected associate. The following illustrates the elements of this 

section: 

 

Creating a Scheduled Event 

• Move to the Confidential Profile tab and click on the sub tab of Activities. 

• Locate the data control found in this section and click on the Append (+) button. 

• From the invoked Employee Schedule dialog, move through the various fields and enter the 

appropriate information. See the section on the Employee Scheduler found in this chapter for 

more information.  

• Click on the Accept button when done. 

• Click on the Post (checkmark) button in the data control to save the new record back to the 

database. 

Editing a Scheduled Event 

• Move to the Confidential Profile tab and click on the sub tab of Activities. 

• Locate and make active the event you want to edit from those listed in the grid located there. 

• Click on the Edit Selected Schedule button. 

• From the invoked Employee Schedule dialog, move through the various fields and enter the 

appropriate information. See the section on the Employee Scheduler found in this chapter for 

more information.  

• Click on the Accept button when done. 

• Click on the Post (checkmark) button in the data control to save the modified record back to the 

database. 
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Special Fields 
Found on the Confidential Profile tab, and the sub tab of Special Fields, this section allows you to create 

and use Special Fields. Special Fields can be thought of as groups of User Defined Fields. Each group can 

have a Group Name and 8 fields with user defined titles. 

The following illustrates the elements found in this section: 

 

For more information about this feature please refer to the Special Fields section of the Common 

Features chapter. 

Manage Selected Special Fields 
To setup the titles for the current set of special fields: 

• Select the Special Fields tab as found on the Confidential Profile tab. 

• Select the group you want to modify from those listed in the grid. 

• Open the File menu and expand the Manage Special Fields sub menu. 

• Click on the Manage Selected Fields option. 

WARNING: The above action will overwrite the existing user titles. 

For more information about this feature please refer to the Special Fields section of the Common 

Features chapter. 

Benefits - Dependents Tab 
Under the Benefits - Dependents tab you can continue making assignments as they apply to the 

selected associate. Information maintained on this tab deals with employee financial options, insurance 

options and dependents tracking.  

Financial and Insurance Options 
Found on the Benefits – Dependents tab, the options available to both the Financial Options and 

Insurance Options are almost identical in nature and will be group together in this discussion. The 

following illustrates the elements of this section: 
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• Plan Type – This section indicates the type of financial or insurance plan you are dealing with. 

• Date Eligible – This date only field is used to indicate the date the selected employee is eligible 

to join the selected plan. 

• Date Joined – This date only field would indicate the date the selected employee commenced, 

or joined the selected plan. 

• Date Withdrawn – This date only field would indicate the date the employee withdrew from the 

selected plan. 

• Plan – This alpha/numeric field can contain up to 40 characters and is used to indicate the plan, 

and or institution the plan is associated with. 

 Employee Dependents 
Found on the Dependents section of the Benefits – Dependents tab, this section allows you to track an 

associate’s defendants. 

 

Creating a Dependent Record 

• Move to the Benefits – Dependents tab and move to the Dependents group. 

• Locate the data control found in this section and click on the Append (+) button. 

• From the invoked Dependent dialog, move through the various fields and enter the appropriate 

information. See the section on the Dependent Editor found in this chapter for more 

information.  

• Click on the Accept button when done. 

• Click on the Post (checkmark) button in the data control to save the new record back to the 

database. 
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Editing a Dependent Record 

• Move to the Benefits – Dependents tab and move to the Dependents group. 

• Locate and make active the record you want to edit from those listed in the grid located there. 

• Click on the Edit Dependent button. 

• From the invoked Dependent dialog, move through the various fields and enter the appropriate 

information. See the section on the Dependent Editor found in this chapter for more 

information.  

• Click on the Accept button when done. 

• Click on the Post (checkmark) button in the data control to save the modified record back to the 

database. 

Dependent Editor 
The Dependent Editor is used to create and edit individual dependent records. The following illustrates 

the element of this editor: 

 

• Employee’s Name – This field is automatically set by the application and indicates the associate 

this dependent record belongs to. 

• Dependent’s Name – This alpha/numeric field can contain up to 40 characters and represents 

the name of the dependent. 

• Date of Birth – This date only field would represent the birth date of the dependent. 

• Relation – This alpha/numeric field can contain up to 30 characters and relates to the 

relationship the dependent has to the employee. 

• Gender – This field would indicate the sex of the dependent. 

• Accept – Clicking this button accept any added or changed values and closes the dialog. 

• Cancel – Clicking this button closes the dialog without applying any changes made. 
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Add a Record 
To add a new employee record: 

• Move to the Home tab in the ribbon and click on the Add New option. 

• Move through the various tabs and edit the new record. 

Save Changes 
To save changes to the main record, click on the Post (✓ check) button in the Data Control located 

within the ribbon’s Quick Access toolbar. 

To save changes to the main record and all the underlying records (links, attachments, etc.), click on the 

Save Changes button found on the Home tab of the ribbon control. 

Employee Lookup 
Use the Employee Lookup dialog to locate an employee record: 

• Move to the Home tab in the ribbon and click on the Lookup option. 

Please refer to the Lookup Dialogs section of the Common Features chapter to view procedures on 

using this dialog. 

Print Options 
To print basic information the current employee record: 

 

• Locate and select the record you want to print. 

• Open the File menu and expand the Print Options menu by clicking on it. 

• Click on the Print Option of your choice: 

o Print Current Contact - Allows printer selection and other options before printing. 

o Quick Print - Sends the document directly to the default printer. 

o Print Preview - Provides a print preview of the current record. 



Maintenance Coordinator – Professional Features 

 

Simplicity Software Technologies Inc. | Activities Calendar 50 

 

Activities Calendar 
The HR Calendar is used to show scheduled activities as it relates to your employees in calendar form. 

You can display, print and edit activities in single day, week, work week, month and time line views. It 

supports scheduled events for training, renewals, vacations, leaves and other general types. 

 

Access the Activities Calendar 
To access the Activities Calendar: 

• Click the Activities Calendar option found on the Home tab of the ribbon. 

Calendar - Ribbon 
The functionality of the Activities Calendar is provided via the ribbon control. This control is structurally 

and visually split into logical groups. Each of these groups includes commands that perform specific 

functions. 

 

The following are the elements on the Calendar ribbon control, reading left to right: 

• Backward – Moves backwards through the current Active View. 
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• Forward – Moves forwards through the current Active View. 

• Go To Today - Moves focus to the current date, preserving the existing view mode. 

• Zoom In – Zooms in on the current view. 

• Zoom Out – Zooms out on the current view. 

• Day View - This view provides the most detailed view of appointments for a certain day. 

• Work Week View - This view displays appointments for the working days in a particular 

week. 

• Week View - This view displays appointments for any given week. 

• Month View - The month view is the least detailed of the views, and is designed to allow 

browsing and long-term plan analysis. This view positions the days one after another 

horizontally, so that they form weeks, while weeks are placed one under the other. 

• Timeline View - This view plots appointments as horizontal bars along the timescales, and 

provides a clearer overview for scheduling purposes. 

• General – Shows all scheduled activities regardless of their type assignments. 

• Training – Filters the calendar to show only those events marked as a Training type. 

• Renewals – Filters the calendar to show only those events marked as a Renewal type. 

• Vacations– Filters the calendar to show only those events marked as a Vacation type. 

• Leaves – Filters the calendar to show only those events marked as a Leaves type. 

• Exit the Scheduler – Close the Activities Calendar/Scheduler. 

Calendar Popup Menu 
The Activities Calendar has a pop up menu associated with it. This menu is invoked by right mouse 

clicking over the calendar control. The following illustrate this popup menu: 

 

 The following are the options found on this popup menu: 

• Go to This Day - Only available in the Week View and Month View modes. This item is active 

when only one day is selected, and when activated, displays the target day in the Day View 

mode.  

• Go to Today - Moves focus to the current date, preserving the existing view mode.  

• Go to Date... - Invokes the Go To Date dialog to select the date and view type. The date can be 

selected either by using the calendar or by entering a string with the placeholders. To select the 

desired view type, use the Show In drop-down box. 
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• Change View To – This pop out menu allows you to change calendar view types by clicking on an 

option available. 

Activities Calendar Filters 
In the Filter Options group of the ribbon’s HR Calendar tab are several filtering options available. These 

were already outlined in the Calendar – Ribbon section of this chapter. You activate a filter just clicking 

on the appropriate option in the ribbon. 

Print Options 
To print the current schedule: 

 

 

• Select the calendar view you want to print. 

• Open the File menu and expand the Print Options menu by clicking on it. 

• Click on the Print Option of your choice: 
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o Print Preview - Provides a print preview of the current record. 

o Quick Print - Sends the document directly to the default printer. 

o Page Setup - Allows you to setup properties for the document prior to printing. 

Editing an Event within the Activities Calendar 
You can edit or reschedule events from within the Activities Calendar. To edit an event: 

• From within the calendar, locate the event you would like to edit. 

• Double click on the event to invoke the Employee Scheduler. 

• Refer to the section on the Employee Scheduler found in this chapter for more information. 

General HR Documents Database 
This module supports its own Documents Database. To see how to use this feature, please refer to the 

Documents Database section of the Common Features chapter. 

To access the HR Documents database: 

• Move to the Home tab in the ribbon and select the HR Documents option. 

Individual Documents Database 
The Individual Documents database work in exactly the same way as the HR Document databases. The 

difference is that the HR Documents database is designed to support HR in general, with documents 

related to HR activities or functions. The Individual Documents database is assigned to each individual 

employee record. This is to say that each employee is assigned their own separate database without 

sharing information with other records. 

To see how to use this feature, please refer to the Documents Database section of the Common 

Features chapter. 

To access the Individual Documents database: 

• Move to the Home tab in the ribbon and select the Individual Documents option. 

Individual Notes 
You can keep detailed notes on each associate record in the database. These notes use our built in word 

processor that is used throughout the system. To find how to use the features of this word processor 

please refer to the Word Processor chapter. 

To access the Individual Notes option: 

• With the record selected, move to the Home tab in the ribbon. 

• Click on the Individual Notes button. 
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Search 
To perform a search on the Human Resources database: 

• Move to the Home tab in the ribbon. 

• Click on the Search option.  

• Refer to the Search section of the Common Features chapter for more information. 

Filtering the Human Resources Database 
On the Filters tab of the ribbon are a few filters that can be used to filter the database by. Each of these 

available filters are activated simply by clicking on the option of your choice. 

The following are the elements on the Filters ribbon tab, reading left to right: 

• Default Filter – Shows every record in the database. 

• Active Employees – Shows every record in the database that has not been marked as Inactive. 

• Inactive Employees – Shows every record in the database that has been marked as inactive. 

• Maintenance Lists – Show only those records that have the Include in Maintenance Lists set. 

Comprehensive Employee Report 
The Comprehensive Employee Report allows you to pick and choose the elements of an employee’s 

record to include in the report. This includes some very basic information, to more sensitive information 

such as payroll. 

 

To create the Comprehensive Employee Report: 
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• Select and make active the employee record you want to base your report on. 

• Click on the Reports tab in the ribbon, and then click on the Comprehensive Employee option. 

 

• Move to the Report Title input box and type in an optional title for your report. 

• Move to the various checkboxes found on this dialog and check the items you want included on 

the report. 

• To include all items on your report, click on the Select All button. 

• Click on the Accept button to create your report. 

Training Report 
The Training Report allows the creation of a report based on completed training for all employees in the 

database. 
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To create a training report: 

• Move to the Reports tab in the ribbon and click on the Training Report option. 

• Move to the Report Title input box and type in an optional title for your report. 

 

• Move to and click on the Select button in the Description to base report on group. 

• From the invoked lookup dialog, move to the grid and select the description you want to use. 

• Click the Select button. 

• To report on all training regardless of description, place a check in the Use All Descriptions 

checkbox. 

• Move to the Start Date and End Date fields and setup the date range for your report. 

• To ignore dates, place a check in the Use All Dates checkbox. 
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• Move to the drop down list in the Sort report by group and select how you want the report 

sorted. 

• Click on the Accept button to create the report. 

Telephone List Report 
This report provides a Telephone List including all employees. 

 

To create the Telephone List Report: 

• Move to the Reports tab in the ribbon and click on the Telephone List option. 

Address List Report 
This report provides an Address List including all employees. 

 

To create the Address List Report: 

• Move to the Reports tab in the ribbon and click on the Address List option. 

Calendar – Activities Reports 
There are 6 reports found in this section and are all basically the same. The only difference is found in 

the type of calendar activity being reported on. 

 

To create a Calendar – Activity Report: 
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• Move to the Report tab in the ribbon and locate the Calendar – Activities Report section. 

• Select one of the available options found in this ribbon group. Options include: 

o Training – This report is based on scheduled training events. 

o General – This report is based on scheduled general type of events. 

o Renewals – This report is based on scheduled renewal events. 

o Vacations – This report is based on scheduled vacations. 

o Training – This report is based on scheduled training events. 

o Leaves – This report is based on scheduled leaves of absents. 

o All Items – This report is based on all scheduled activities. 

 

• From the invoked Date Range Selection dialog setup the date range you want to base your 

report on. 

• Click on the Accept button to create the report. 
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Tools Database 

The Tools Database module was designed to help you keep track of your tools inventory. With this 

module you can maintain all the important information on each of your tools. This includes the 

description of the tools, serial numbers, asset numbers, storage locations, a picture of the tool and 

more. The program tracks the complete check out history of the tool, including when the tool should be 

returned, and who has it. 

 

This module also tracks the inspection history of your tools. This is valuable as OSHA requires electrical 

tools and such to be inspected at regular intervals. These inspection records can be printed and kept in a 

safe place to prove compliance to these regulations. By running one of the built in reports the program 

can flag when these tools are due for re-inspection. Some of the other available reports include tools 

that are overdue for return, all available tools, and all tools currently checked out. 

Ribbon Control 
The comprehensive functionality of the Tools Database module is provided via a set of Ribbon tabbed 

pages. Ribbon pages are structurally and visually split into logical groups. Each of these groups includes 

commands that perform specific functions. 
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TOOLS DATABASE TAB 

 

The following are the elements on the Tools Database ribbon tab, reading left to right: 

• Add New – Creates a new blank record in the database. 

• Save Changes – Saves all current changes from all elements of a record (master save). 

• Check In-Out – Invokes the check-In or Out dialog. 

• Tool’s Notes – Allows the viewing and editing of the notes assigned to the current record. 

• Print Record - Allows printer selection and other options before printing. 

• Quick Print - Sends the document directly to the default printer. 

• Print Preview - Provides a print preview of the current record. 

• All Checked Out – Filters the database to show all records that are currently checked out. 

• All Past Due – Filters the database to show all records that are overdue for return. 

• View All – This is the default filter and shows all records in the database. 

• Search - Invokes the search/find routine on the Lookup Grid. 

• Exit Module - Close and exits the module. 

CHECK OUT HISTORY TAB 

 

NOTE: This ribbon tab is only available when the main Check-Out History tab is selected. 

The following are the elements on the Check-Out History ribbon tab, reading left to right: 

• Edit Entry – Allows you to edit a checked out history record. 

• Delete Selected Entry – Allows you to delete or remove the selected record. 

• Delete Date Range - Allows you to delete a date range of entries. 

• Print History Log – Allow you receive a print preview of the current log. 
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TOOL INSPECTIONS TAB 

 

NOTE: This ribbon tab is only available when the main Inspections tab is selected. 

The following are the elements on the Tool Inspections ribbon tab, reading left to right. 

• Add Inspection – Invokes the Tool Inspection Editor to assist in creating a new record. 

• Edit Inspection – Allows you to edit an inspection record. 

• Delete Selected Entry – Allows you to delete or remove the selected record. 

• Delete Date Range - Allows you to delete a date range of entries. 

• Print Inspections Log – Allow you receive a print preview of the current log. 

REPORTS TAB 

 

The following are the elements on the Reports ribbon tab, reading left to right. 

• All Checked Out – Provides a listing of all tools currently checked out. 

• All Past Due – Provides a listing of all tools overdue for return. 

• All Tools Available – Provides a listing of all tools available for checkout. 

• All Tools – Provide a listing of all tool records. 

• Upcoming Inspections – Provides a listing of all tools coming up for inspections. 

• Print Barcode Labels – Allows you print barcode labels. 

Shortcut Bar 
Located on the far left side of the Tools Database is a Shortcut bar. Items found in this Shortcut bar are 

normally duplicated in other area of the module. They are only provided here as shortcuts. 
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Features of the Tools Database Module 
There are various features of the Tools Database module, with the majority of these features found on 

either the tabbed pages found there, or within the tabbed ribbon control. We are going to explain the 

use of these features as we move through the tabbed pages.  

Lookup Tab 
This tab helps in locating record by grouping, filtering and sorting them. All the records in the current 

filter are located in the grid found here. To select a record and make it the active record, the user needs 

only to click on the record from within the grid. Once selected the user can click on the other tabs to 

view or edit the record itself. 

The following image illustrates the features available on the Lookup tab: 

 

The functions of the Lookup tabs are used through-out the system and are fairly common regardless of 

the modules that use them. Please review the chapter on Common Features to read about the 

functionality of the controls located on this tab. Pay special attention to the following: 

• Using the Lookup Grids 

• Searching 
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• Scanned Lookups (Barcodes Support) 

Details Tab 
Under the Details tab you can setup your identification information, and general assignments for 

selected tools. You also have the ability to check tools in and out of the Tool room or crib. 

General Information 
This section allows you to specify a description, reference ID, manufacturer and other general 

information specific to the current record. 

The following illustrates the elements found in this section: 

 

Reference ID 
This field should be unique in your database, but it’s not an enforced rule. It is used to help identify your 

tool, and is also used in conjunction with barcode scans. Edit this field by typing in the space provided. 

This field can accept up to 25 alpha/numeric characters. 

Once the Description field has been entered you can click on the Auto button to have the application 

create this field for you. 

To insure the Reference ID is unique in the database, click on the Check button. 

Tool Description 
This field should provide a brief description of the tool. This field can contain up to 50 alpha/numeric 

characters. 
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Location 
This alpha/numeric field can contain up to 30 characters and would be used to track the physical storage 

location of the tool. This could represent a property or facility. 

Classification 
This alpha/numeric field can contain up to 30 characters and would be used to record the Classification 

you want to assign the current record. 

Storage Location 
This alpha/numeric field can contain up to 30 characters and would be used to indicate the storage 

location of the tool. 

Building 
This alpha/numeric field can contain up to 30 characters and would be used to represent the building 

the tool is stored in. 

Serial Number 
This alpha/numeric field can contain up to 30 characters and would be used to record the serial number 

of the tool. 

Asset Number 
This alpha/numeric field can contain up to 30 characters and would be used to record the asset number 

assigned to the tool in the case tool is considered an asset. 

Manufacturer 
This alpha/numeric field can contain up to 40 characters and would be used to record the manufacturer 

of the tool. 

Model 
This alpha/numeric field can contain up to 30 characters and would be used to record the model type of 

the tool. 

Purchase Price 
This floating point only type field would be used to record the price paid when the tool was purchased. 

Next Inspection 
This date only field would indicate the date in which the next inspection should be conducted on the tool. 

Selected 
When checked, this would indicate that the record is selected. This is normally used with barcode printing 

routines. 



Maintenance Coordinator – Professional Features 

 

Simplicity Software Technologies Inc. | Tool Picture 65 

 

Tool Picture 
This section allows you to set or store a picture of your tool. Options available to this feature are 

accessible from the pop-up menu associated with the image. 

The following illustrates the elements found in this section: 

 

To set the tool’s picture 

• Move to the Tool Picture group found on the Detail tab. 

• Right mouse click on the picture control to invoke the pop up menu. 

• Click on the Load option. 

• Using the Open dialog, browse to where you have the picture stored on your system. Supported 

formats include: bmp, gif, jpg, ico, png and tif. 

• Click on the image file to select it and click the Open button. 

• Save your changes by clicking on the Save Changes option in the ribbon.  

Checkout Information 
This section displays check in and checkout information as it relates to the selected tool record. The 

following illustrates the elements of this section: 

 



Maintenance Coordinator – Professional Features 

 

Simplicity Software Technologies Inc. | Tool Check Out-In Editor 66 

 

All the fields of this section are completed for you as tools are checked in and checked out of the 

database. 

Tool Check Out-In Editor 
The Tool Check Out-In Editor is used both when checking tools out, and checking them in. It is also used 

with editing a check out record in the Check-Out History log. 

The following illustrates the elements found in this editor: 

 

• Name – This alpha/numeric field can contain up to 40 characters. You can set this field by typing 

in it or use the Select button in the Employee Information group. To use the Select button: 

o Move to the Employee Information group and click on the Select button. 

o Select the Employee you want to assign from the grid of the invoked Lookup dialog. 

o Click on the Select button. 

• Reference – This field is filled in for you when an employee is selected as outlined above. 

• Check Out Date – This is a date only field and represents the date of tool checkout. 
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• Due Date – This is a date only field and represents the date you require the tool to be returned. 

• Date Returned – This is a date only field and represents the date the tool was actually returned 

to the tool room or crib. 

• Tool Condition – This alpha/numeric field can be up to 30 characters in length, and represents 

the tool’s physical condition when returned. 

• Comments – This alpha/numeric field can be up to 100 characters in length and would include 

any addition comments you want recorded. 

• Accept – Accepts the information as entered and closes the dialog. 

Tool Check Out – Check In 
To check a tool in or out of the database: 

• Locate and make current the tool record you want to work with. 

• Move to the Tool Database page in the ribbon and click on the Check In-Out option. Or 

• Move to the Details tab, and the secondary tab of Checkout Information. Click on the Check In-

Out button. 

• Follow the instructions on the Tool Check Out-In Editor found in this chapter. 

Special  
This section allows you to create and use Special Fields. Special Fields can be thought of as groups of 

User Defined Fields. Each group can have a Group Name and 8 fields with user defined titles. This 

section is found on the Special tab, located on the lower section of the Details tab. 

 

For more information about this feature please refer to the Special Fields section of the Common 

Features chapter. 

Manage Selected Special Fields 
To setup the titles for the current set of special fields: 

• Move to the Details tab, and then select the secondary tab of Special. 

• Select the Special Fields group as found within the grid. 

• Open the File menu and expand the Manage Special Fields sub menu. 

• Click on the Manage Selected Fields option. 
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For more information about this feature please refer to the Special Fields section of the Common 

Features chapter. 

Barcodes 
You can create and use barcodes and labels with this module. Being that this is a fairly common feature 

throughout the system we invite you to the Creating Barcodes and the Designer section of the Common 

Features chapter. 

The following illustration shows this feature: 

  

To access the Barcodes routines from within the Tools Database module: 

• Move to the Details tab of the tools database and then click on the Barcode tab near the 

bottom. 

Check Out History Tab 
This tab is used to store the checkout history as it applies to the selected tool record. On this tab you can 

edit records, print the log and remove records from the log. 

Note that the Check-Out History ribbon page is only available when this tab is selected. 
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To Edit a Check-Out Record 
• Move to the Check-Out History tab. 

• Select the record you want to edit from within the grid. 

• Either double click on the record or click on the Edit Entry option on the Check-Out History page 

of the ribbon. 

• Please refer to the Tool Check-Out Editor section found in this chapter on how to use the 

invoked editor.  

To Delete a Check-Out Record 
• Move to the Check-Out History tab. 

• Select the record you want to delete from within the grid. 

• Click on the Delete Entry option on the Check-Out History page of the ribbon. 

 

• When prompted about the deletion, click Yes. 
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Deleting a Date Range of Check-Out Records 

• Move to the Check-Out History tab. 

• Move to the Check-Out History page in the ribbon and click on the Delete Date Range option. 

 

• Setup the Start Date and End Date of the range of records you want to remove from the 

database. 

• To delete all record, select the Use All Dates checkbox. 

 

• When warned about the deletion, click on the Yes button. 

To Print the Check-Out History Log. 

 

• Move to the Check-Out History tab. 

• Move to the Check-Out History page in the ribbon and click on the Print History Log option. 



Maintenance Coordinator – Professional Features 

 

Simplicity Software Technologies Inc. | Tool Inspection Editor 71 

 

Tool Inspection Editor 
The Tool Inspection Editor is used to both create and edit tool inspection records. The following 

illustrates the elements of this editor. 

 

• Inspection Date – This date only field would indicate the date an inspection was completed. 

• Inspected By– This alpha/numeric field can contain up to 40 characters. You can set this field by 

typing in it or use the Select button adjacent to this field. To use the Select button: 

o Move to the Employee Information group and click on the Select button. 

o Select the Employee you want to assign from the grid of the invoked Lookup dialog. 

o Click on the Select button. 

• Comments – There’s no size limitation to this field, and it can be used to record the outcome of 

the inspection. 

• Accept – Click the button to accept changes and close the dialog. 

Inspections Tab 
This tab is used to store the inspection history as it applies to the selected tool record. On this tab you 

can create records, edit records, print the log and remove records from the log. 

Note that the Tool Inspections ribbon page is only available when this tab is selected. 
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To Create a New Inspection Record 

• Move to the Inspections tab. 

• Move to the Tool Inspection page in the ribbon and click on the Add Inspection option. 

• Please refer to the Tool Inspection Editor section found in this chapter on how to use the 

invoked editor 

 

To Edit an Inspection Record 
• Move to the Inspections tab. 

• Select the record you want to edit from within the grid. 

• Either double click on the record or click on the Edit Inspection option on the Tool Inspections 

page of the ribbon. 

• Please refer to the Tool Inspection Editor section found in this chapter on how to use the 

invoked editor.  

To Delete a Check-Out Record 
• Move to the Tool Inspections tab. 

• Select the record you want to delete from within the grid. 

• Click on the Delete Inspection Entry option on the Tool Inspections page of the ribbon. 



Maintenance Coordinator – Professional Features 

 

Simplicity Software Technologies Inc. | Inspections Tab 73 

 

 

• When prompted about the deletion, click Yes. 

Deleting a Date Range of Inspection Records 

• Move to the Inspections tab. 

• Move to the Tool Inspections page in the ribbon and click on the Delete Date Range option. 

 

• Setup the Start Date and End Date of the range of records you want to remove from the 

database. 

• To delete all record, select the Use All Dates checkbox. 

 

• When warned about the deletion, click on the Yes button. 
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To Print the Inspections Log 

• Move to the Inspections tab. 

• Move to the Tool Inspection page in the ribbon and click on the Print Inspection Log option. 

Add a New Tool Record 
To add a new tool record: 

• Move to the Tool Database tab in the ribbon and click on the Add New option. 

• Move through the various tabs and edit the new record. 

Save Changes 
To save changes to the main record, click on the Post (✓ check) button in the Data Control located 

within the ribbon’s Quick Access toolbar. 

To save changes to the main record and all the underlying records (links, attachments, etc.), click on the 

Save Changes button found on the Home tab of the ribbon control. 

Print Options 
To print the current record: 

• Locate and select the record you want to print. 

• Open the File menu and expand the Print Options menu by clicking on it. 

• Click on the Print Option of your choice: 

o Print Record - Allows printer selection and other options before printing. 

o Quick Print - Sends the document directly to the default printer 

o Print Preview - Provides a print preview of the current document 

Tool’s Notes 
You can keep detailed notes on each tool in the database. These notes use our built in rich text editor 

that is used throughout the system. To find how to use the features of this rich text editor please refer 

to the Rich Text Editor chapter. 

To access the Notes option: 

• Locate and make active the record you want to maintain notes on. 

• Move to the Tools Database tab in the ribbon and click on the Tool’s Notes option. 

Filter Options 
On the Tool Database page of the ribbon, you have the following database filter options: 
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• All Checked Out – Filters the database to show only those records that are currently checked 

out. 

• All Past Due – Filters the database to show all records that are overdue for returning. 

• View All – This is the default filter and shows all records in the database. 

To filter the database by one of the above options: 

• Move to the Tools Database tab in the ribbon. 

• Click on the filter option of your choice. 

Search 
To perform a search on the Tools Database: 

• Move to the Tools Database tab in the ribbon. 

• Click on the Search option.  

• Refer to the Search section of the Common Features chapter for more information. 

General Reports 
On the Reports tab of the ribbon are the following general types of reports: 

• All Checked Out – Provides a listing of all tools currently checked out. 

• All Past Due – Provides a listing of all tools overdue for return. 

• All Tools Available – Provides a listing of all tools available for checkout. 

• All Tools – Provide a listing of all tool records. 

  

To create one of the general reports: 

• Move to the Reports tab in the ribbon. 

• Click on the report options of your choice, and as just explained. 

Upcoming Inspections Report 
This report returns the schedule for upcoming tool inspections. 
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To create the Upcoming Inspection Report 

• Move to the Report tab in the ribbon. 

• Click on the Upcoming Inspections option. 

 

• Setup the Start Date and End Date of the range of records you want to report on. 

• Click on the Accept button. 

 

Print Barcodes 
You can print barcode labels with this module. To print barcodes: 

• Select and make current the tool record you want create the report on. 

• Move to and click on the Reports tab in the ribbon. 

• Click on the Barcode Labels option. 

• Follow the instructions as outlined in the Printing Barcode Labels section of the Common 

Features chapter.  
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Procedures Database 

One thing I'm sure any maintenance department could use is a database full of Troubleshooting 

procedures and other training related materials. Well, with the Procedures and Solutions module we 

allow you to build just this. With this module you can begin building a complete database full of useful 

procedures. In this way as team members learn new techniques, they go to this module and enter this 

information. As other team members need information for a similar problem, they return to this module 

and look up these procedures for their own personal use. 

 

The more information that can be shared between team members the better. If someone has solved a 

complex problem before, and that problem arises again with a different person, wouldn't it be nice to 

know what the other person did when they fixed it? Of course it would. Knowing what the other person 

did could save a lot of down time by already knowing a couple of possible fixes. 

This module can also be used as a Training Database we you can record a countless number of 

procedures or training materials. These procedures can be store within the database as rich text 

documents or as links to external documents. These external documents can be specified as either 

general type of documents or as image files. 

Links to files can be almost any file type, and supports the same features as the Run command of 

Windows itself. In the most part, if you have a file that is has an associated program assigned to it, it 

should be useable.  Examples: A documents with an extension of docx assigned to it, and Word is 

installed on your computer, opening a link to this document would open the document in Word. 
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Ribbon Control 
The functionality of the Procedures Database module is provided via a set of Ribbon tabbed pages. 

Ribbon pages are structurally and visually split into logical groups. Each of these groups includes 

commands that perform specific functions. 

VIEW DOCUMENTS TAB 

 

The following are the elements on the View Documents ribbon tab, reading left to right: 

• View Documents – This option will attempt to open the selected document. 

• Search – This option invokes the document search routine. 

• Close Procedures – Exits this module. 

EDIT DOCUMENTS TAB 

 

The following are the elements on the Edit Documents ribbon tab, reading left to right: 

• View Documents – This option will attempt to open the selected document. 

• Search – This option invokes the document search routine. 

• Add Document – Invokes the Add New Procedure dialog. 

• Edit Document – Depending of the document type, this option: 

o RTF Editor Type – Opens the document with the built in rich text editor. 

o Link Type – Opens the Attachments dialog and allows editing the link properties. 

• Move to Folder – Invoke the Move Document dialog which allows assigning the document to a 

different folder. 

• Delete Document – Allows removing the selected document from the database. 

• Rename Document – Allows renaming a document’s title. 

• Add Top Folder – Allows adding a new top or root folder to the documents tree. 

• Add Sub Folder – Allows adding a sub or child folder to the selected folder. 

• Remove Folder – Allowing removing or the deletion of the selected folder. 

• Rename Folder – Allows you rename the selected folder.  

• Close Procedures – Exits this module. 
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Pop-up or Context Menus 
Most of the options in the Ribbon are duplicated with context menus. Context menus availability is 

dependent of the feature that is selected. That is to say the Document tree has a different menu 

assigned to it, as if clicking on a Document. 

Context menu are activated by placing your mouse cursor over a control and right mouse click the 

feature. The options available are activated by clicking on the option. 

DOCUMENTS TREE CONTEXT MENU 

  

The following are the elements on the Documents Tree context menu: 

• Add Top Folder – Allows adding a new top or root folder to the documents tree. 

• Add Sub Folder – Allows adding a sub or child folder to the selected folder. 

• Add Document – Allows adding a new document to the selected folder. 

• Remove Folder – Allowing removing or the deletion of the selected folder. 

• Reload Tree – Rereads and re-populates the Documents Tree (refresh) 

• Rename Folder – Allows you rename the selected folder.  

• Move Folder to Root (Top Levels) - Reassigns the selected folder as a top or root folder. 

 DOCUMENTS CONTEXT MENU 

 

The following are the elements on the Documents context menu: 

• View Document – Opens the document for viewing. 

• Edit Document – Depending of the document type, this option: 

o RTF Editor Type – Opens the document with the built in rich text editor. 

o Link Type – Opens the Attachments dialog and allows editing the link properties. 
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• Move to Folder – Invoke the Move Document dialog which allow assigning the document to a 

different folder. 

• Delete Document – Allows removing the selected document from the database. 

Navigating Procedure Documents 
Procedure Documents are stored in folders. Once a folder that has documents assigned to them is 

selected, the document can be opened by double clicking on the button that contains its description. 

 

To navigate the stored procedures: 

• Move to the Documents Tree found on the left side of the screen. 

• Expand the folders by clicking on them until the folder that contains the document you want to 

access is located. 

• Move to the right side of the screen where the documents are stored. 

• Do one of the following: 

o Double click on the document to view it. 

o Right click on the document and select either the View Document or Edit Document 

options. 

o Click on the document to select it. Then select an option as found in the ribbon. 
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Understanding and Using the Documents Tree 

 

The Documents Tree allows for the organization of your documents in Folders or nodes. Basically you 

are not limited to the number of folders you can create and use. You can also create as many levels of 

these folders as maybe needed (parent – child folders). The supplied illustration shows the elements of a 

typical tree control. 

IMPORTANT NOTE: Most of the procedures outlined in this section refer to the use of pop-up menus, 

however many of these procedures can also be duplicated and be found in the ribbon control as well. 

Create a Document Folder 

Each document in the system will be assigned to a folder or tree node in the Documents Tree. Once a 

folder is created documents can be added to it. 

To create a new Document “Root” or “Top Level” folder: 

 

• Right mouse clicking within a Documents Tree section will invoke a popup menu. 

• Click on the Add Top Folder option. 

• From the invoked dialog enter the name you want to use for this folder and click OK. 

To create a new “Sub Folder” or “Child Node”: 

• Move to the Documents Tree and click and select the folder that you want to add a new sub 

folder to. 

• Right mouse click within the Documents Tree section to invoke a popup menu. 

• Click on the Add Sub Folder option. 
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• From the invoked dialog enter the name you want to use for this folder and click OK. 

To Remove a Folder: 

• Move to the Documents Tree and click on the folder you want to remove. 

• Ensure there are no child folders or documents assigned to this folder. If there are items then 

either move and reassign these items or delete them. You cannot remove a folder if anything is 

assigned to it. 

• Right mouse click on the folder you want to remove to invoke a popup menu. 

• Click on the Remove Folder option. 

To Rename a Folder: 

• Move to the Documents Tree and click on the folder you want to rename. 

• Right mouse click on the folder you want to remove to invoke a popup menu. 

• Click on the Rename Folder option. 

• From the invoked dialog edit the folder name to the way you want it and then click OK. 

To move a Folder to the Top Level or Root position: 

• Move to the Documents Tree and click on the folder you want to move. 

• Right mouse click on the folder you want to move to invoke a popup menu. 

• Click on the Move Folder to Root (Top Level) option. 

To move a Folder and Reassign its position in the tree: 

• Move to the Documents Tree and click on the folder you want to move. 

• Left mouse click and hold on the folder you want to move. 

• Drag the folder over the folder you want to move it to. 

• Release the mouse button to drop the folder in to its new location. 
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To create a New Rich-Text document 

  
• Move to the Documents Tree and select the folder that you want to assign the new document 

to. 

• Click on the Add Document option in the ribbon control 

• From the invoked Create New Procedure dialog, move to the Document Name text box and 

enter a name for your new document. This title can contain up to 30 characters. 

• Move to the Document Type section and select the RTF Document option. 

• Click on the Accept button and the Rich-Text editor will open with your new document ready for 

editing. 

To create a New Picture/Image Document 
• Move to the Documents Tree and select the folder that you want to assign the new document 

to. 

• Click on the Add Document option in the ribbon control 

• From the invoked Create New Document dialog, move to the Document Name text box and 

enter a name for your new document. This title can contain up to 30 characters. 

• Move to the Document Type section and select the Picture/Image Document option 

• Click the Accept Button to invoke a file open dialog box. 

• Browse to where the images file is store and select the image by clicking on it. 

• Click on the Open button to assign the image. 

To create a New Link Document 
• Move to the Documents Tree and select the folder that you want to assign the new document 

to. 
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• Click on the Add Document option in the ribbon control. 

• From the invoked Create New Document dialog, move to the Document Name text box and 

enter a name for your new document. 

• Move to the Document Type section and select the Attachment/Link Document option 

• Click the Accept Button to invoke the Link Setup dialog. 

 

• Move to the Attachment Path section and click on the Browse button. 

• Navigate to where the file you want to use is stored. Select the file and click Open. 

• The program will ask if you want to replace the current description with one based on the file’s 

name. To accept the new description reply by clicking on the OK button. 

• You can edit the document’s description by editing the text in the Description section. 

• You can test the link by clicking on the Test/Open button. 

• When everything is set to your liking, click on the Accept button. 

 To open or view a document: 

• Move to and click on the folder that contains your document from within the Documents Tree 

to display the documents assigned to that folder. 

• To open the document: 

o Right click on the document to invoke a pop up menu. Select the View Document 

option. Or… 

o Double click on the document to open it.  



Maintenance Coordinator – Professional Features 

 

Simplicity Software Technologies Inc. | To Edit a Document 85 

 

 

To Edit a Document 
• Move to and click on the folder that contains your document from within the Documents Tree 

to display the documents assigned to that folder. 

• Right click on the document to invoke a pop up menu. Select the Edit Document option. 

• For the Rich-Text type documents the document will be displayed in the Editor. For the other 

two document types you will edit a document’s properties in the same manner it was created. 

To Move or Reassign a Document to different parent Folder 
• Move to and click on the folder that contains your document from within the Documents Tree 

to display the documents assigned to that folder. 

• Right click on the document to invoke a pop up menu. Select the Move to Folder option. 

 
• From the Move Document dialog move and select the folder you want to move the document 

to from the displayed tree. 

• Once the Folder is selected click on the Move to Folder button. 

To Rename a Document 
• Move to and click on the folder that contains your document from within the Documents Tree 

to display the documents assigned to that folder. 

• Right click on the document to invoke a pop up menu. Select the Rename Document option. 

• From the Rename Document dialog edit or rename the document’s title in the space provided. 

• Click OK to apply the changes. 



Maintenance Coordinator – Professional Features 

 

Simplicity Software Technologies Inc. | To Delete a Document 86 

 

To Delete a Document 
• Move to and click on the folder that contains your document from within the Documents Tree 

to display the documents assigned to that folder. 

• Right click on the document to invoke a pop up menu. Select the Delete Document option. 

• When prompted about deleting the document, click the Yes button. 

Procedures Search 
Once you start populating the Procedure Database, finding documents may become more of a 

challenge. For this reason we have included a document search routine. This search allows you to 

include up to 20 key words to search for, and then searches the main document for matches. 

 

  To perform a Procedure Search: 

• Move to the ribbon and click on the Search option. 

• Move to the Type in the words to search for text box, and do just that. 

• Click on the List Documents button. If matches are found, the list box under this button will be 

populated with the search results. 

• To preview one of the matching documents, click on it from within the list  

• To open one of the matching documents, first click on it from within the list. Then click one the 

Open Document button. 
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Reports and Graphics Module 

This module could actually be considered as three modules in one. The first component would be the 

Spreadsheet Report Writer. This feature allows you to connect to a database, select one or two tables 

from that database, select fields from these tables, setup sorting and selection criteria, and then 

generates a report. This report can then be even further customized with fonts, colors and more. The 

generated report is created in a spreadsheet format. 

 

The second component of this module is called Snap Reports - the next generation reporting module 
intended for embedding dynamic data in your rich text documents. Use Snap for the quick creation of 
standard reports with the capabilities of data shaping (grouping, sorting), hierarchical data 
representation (master-detail reports) and so much more. 

The third or final component is the Charts and Graphics suite that provides over 60 different 2D and 3D 

chart types, ranging from simple bar and pie charts, to complex financial charts such as stock and candle 

stick charts. With the built-in Charts Wizard, you can configure a chart of any complexity quickly and 

easily.   
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Navigating the Reports and Graphics Module 
The following outlines the possible options that can be used in the navigation between the components 

of this module. 

The navigation bar is located on the left side of the screen, and can be used 

to navigate through the components of this module. 

• Click on a group within the Navigation Options Bar to branch to that 
component. The groups are the larger of the available items shown, with 
larger text and icons. 

• Once a group is expanded, you can click on one of the available 

options to active that option or feature  

To open components simply click on its name. Options include: 

• Spreadsheet Reports 

• Snap Reports 

• Charts and Graphics 
 

 
Spreadsheet Reports 

This option allows you to quickly create reports based on a spreadsheet format. You can join up to 2 

tables from within a single database, and the report is exportable to the following formats: rxml, xml, 

xls, and html. 

Ribbon Control 
The comprehensive functionality of the Spreadsheet Reports component is provided via a set of Ribbon 

tabbed pages. Ribbon pages are structurally and visually split into logical groups. Each of these groups 

includes commands that perform specific functions. 

HOME TAB 

 

The following are the elements on the Reports ribbon tab, reading left to right: 
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Create Group 

• New Report – Invokes the Reports Generation Wizard that steps you through the creation of a 
new report. 

Report Setups Group 

• Save Report Setup – This options saves a report configuration to file. This is based on the 
information that was setup with the wizard. 

• Load Report Setup – Loads a saved report setup and loads the information into the Report 
Generation Wizard. 

Created Reports Group 

• Save as Report – This option allows you to save the report to file. 

• Load Saved Report – This option allows you to open a saved report. 

Print and Export Group 

• Print Report – Allows you to select a printer and other options prior to printing the report. 

• Print Preview – Provide a print preview of the selected report. 

• Report Page Setup – Invokes the Page Setup dialog that allows various options such as headers, 
scale to printing, and more. 

• Export – Allow to directly export the report to: 
o Export to Excel 
o Export to HTML 
o Export to PDF 

Zoom Group 

• Zoom In – Zooms in on the report. 

• Zoom Out – Zooms out on the report. 

Chart Group 

• Create – Allows for the creation of a chart based on the selection. 

FORMAT TAB 
Because there are so many options available on the ribbon’s Format tab, we have broken the illustration 

into two halves, the left and right halves so you can better view the available options. 

 

The following are the elements on the Format ribbon tab, reading left to right, top to bottom: 

(LEFT HALF) 
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Clipboard 

• Paste – Paste content that was previously stored in the clipboard into the selected cell or cells. 

• Cut – Cuts the selection from the documents and places it in the clipboard. 

• Copy – Copies the selection and places in in the clipboard. 

Font Group 

• Font Style – Allows you to specify the font style of selected text or cells. 

• Font Size – Allows you to specify the font point size of selected text or cells. 

• Grow Font – Increase the font size in selected cells. 

• Shrink Font – Decrease the font size in selected cells. 

• Bold – Allows you to toggle the font bold attributes of selected text or cells. 

• Italic - Allows you to toggle the font italic attributes of selected text or cells. 

• Underline - Allows you to toggle the font underline attributes of selected text or cells. 

• Strikethrough - Draws a line through selected text. 

• Cell Borders – Drop down options include cell border styles, colors and thickness. 

• Fill or Highlight Color – Allows you to specify the highlight color to be used for the selection. 

• Font or Text Color – Allows you to specify the text color to be used for the selection. 

Alignment Group 

• Align Top - Aligns cell contents to the top of the cell. 

• Middle Align – Aligns text so that it is centered between the top and bottom of a cell. 

• Align Bottom - Aligns cell contents to the bottom of the cell. 

• Word Wrap – Allows text to wrap within the selected cells. 

• Align Left – Aligns text in the selected cells to be left justified. 

• Align Center – Aligns text in the selected cells to be centered. 

• Align Right – Aligns text in the selected cells to be right justified. 

• Decrease Indent – Decrease the margin between the border and the text in the cell. 

• Increase Indent – Increase the margin between the border and the text in the cell. 
• Merge Cells – Allows the merging and splitting of table cells. 

o Merge & Center - Merge the selected cells and center the text in a merged cell.  
o Merge Across - Merge each row of the selected cell range into larger cells.  
o Merge Cells - Merge the selected cells into a single cell.  
o Unmerge Cells – Splits or unmerge selected cells. 

 
 
(RIGHT HALF) 
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Number Group 

• Format Drop Down – Allows you to format select text by an item selected in the list. 

• Accounting Number Format - Choose an alternate currency format for the selected cell. For 

instance, choose Euros instead of Dollars. 

• Percent Style - Display the value of the cell as a percentage.  

• Comma Style - Display the value of the cell with a thousands separator. This will change the 

format of the cell to Accounting without a currency symbol. 

• Increase Decimal -Show more precise values by showing more decimal places. 

• Decrease Decimal - Show less precise values by showing fewer decimal places. 

Cells Group 

• Format As Table - Quickly convert a range of cells to a table with its own style. 

• Insert – Allows the insertion of columns and rows. Options include: 
o Insert Rows - Add new rows to document. 
o Insert Columns - Add new columns to worksheet. 

• Delete – Allows for the removal of columns and rows. Options include: 
o Delete Rows - Delete rows from the document. 
o Delete Sheet Columns -Delete columns from the document. 

• Format – Provides various formatting options as it applies to the entire report, or selected cells. 

 

o Row Height... - Row height. 
o AutoFit Row Height- AutoFit row height. 
o Column Width... - Column width. 
o AutoFit Column Width - AutoFit column width. 
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o Default Width... - Standard column width. 
o Hide & Unhide - Hide & Unhide. 

▪ Hide Rows – Hide Selected Rows. 
▪ Hide Columns – Hide Selected Columns. 
▪ Unhide Rows – Unhide Rows 
▪ Unhide Columns – Unhide Columns 

o Protect Sheet - Prevent unwanted changes to the data in a document by specifying what 
information can be edited. For example, you can prevent people from editing locked 
cells or changing the formatting of the document. You can specify a password that can 
be entered to unprotect the sheet and allow these changes. 

o Lock Cell - Lock the selected cells to keep people from making changes to them. You 
must turn on Protect Sheet in order for this feature to work. 

o Format Cells... - Show the Format Cells dialog box. 

Editing Group 

• AutoSum - Click here to display the result of a simple calculation, such as Average or Maximum 

Value, after the selected cells. 

o Sum - Provides a sum for selected cells. 

o Average – Provides an average for selected cells. 

o Count Numbers – Provides the number of cells containing numbers. 

o Max – Returns the highest value in the selected cells. 

o Min – Returns the lowest value in the selected cells. 

• Fill - Continue a pattern into one or more adjacent cells.  You can fill cells in any direction and 

into any range of adjacent cells. 

o Fill Down - Continue a pattern into one or more adjacent cells. 

o Fill Right - Continue a pattern into one or more adjacent cells. 

o Fill Up - Continue a pattern into one or more adjacent cells. 

o Fill Left - Continue a pattern into one or more adjacent cells. 

• Clear - Delete everything from the cell, or selectively remove the formatting, the contents, or 

the comments. 

o Clear All -Clear everything from the selected cells. All contents, formatting, and 

comments are cleared from the selected cells. 

o Clear Formats - Clear only the formatting that is applied to the selected cells. 

o Clear Contents (Delete) - Clear only the contents in the selected cells. The formatting is 

not cleared. 

• Sort & Filter - Arrange data so that it is easier to analyze. You can sort the selected data in 

ascending or descending order. 

o Sort A to Z - Sort the selection so that the lowest values are at the top of the column. 

o Sort Z to A - Sort the selection so that the highest values are at the top of the column. 

• Find & Select - Find and select specific text, formatting, or type of information within the 

document. You can also replace the information with new text or formatting. 

o Find - Find and select specific text, formatting, or type of information within the 

document. 
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o Replace - Find and select specific text, formatting, or type of information within the 

document. You can also replace the information with new text or formatting. 

PAGE LAYOUT TAB 

 

The following are the elements on the Page Layout ribbon tab, reading left to right: 

Page Setup Group 

• Margins - Select the margin sizes for the document. 

• Orientation - Switch the pages between portrait and landscape layouts. 

• Size - Choose a paper size for the current sheet. 

• Print Area - Mark a specific area of the sheet for printing. 

o Set Print Area - Mark a specific area of the sheet for printing. 

o Clear Print Area- Clear print area. 

Show Group 

• Gridlines - Show the lines between rows and columns in the sheet to make editing and reading 

easier. 

• Headings - Show row and column headings. Row headings are the row numbers to the side of 

the sheet. Column headings are the letters or numbers that appear above the columns on a 

sheet. 

Print Group 

• Gridlines - Print the lines between rows and columns in the sheet to make reading easier. 

• Headings - Print row and column headings. Row headings are the row numbers to the size of the 

sheet. Column headings are the letters or numbers that appear above the columns on a sheet. 

Creating a New Report (Report Wizard) 
To create a new report: 

• Click on the Spreadsheet Reports option in the Navigation bar. 
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• Click on the New Report option in the ribbon. This should launch the Report Wizard. 

 

To Use an Existing Connection 
• From the Database tab, click on the Connect to Database button. This will invoke the Set or 

Select Database Connection dialog screen as shown in the following illustration: 

 
• Move to drop down list adjacent to the Existing Application Database Connections and select 

the database connection you want to use. These connections are the same ones that currently 
setup for main program use. 

• Ensure that the Use Custom Connection checkmark is not checked. 

• Click on the Accept button. 
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To Use a Custom Connection 

• Move to and check the Use Custom Connection checkbox. 

• Click on the Set Connection button. This will invoke the SQL Connection dialog screen as shown 
in the following illustration: 

 
• Move to the Sever name drop down box and select the name of your instance of the SQL server 

you’re using. If the server is not listed, try clicking on the Refresh button. 

• Move to the Log on to the server group and setup your log on authentication information.  
o Using SQL Express - If you are using the Express database engines as supplied by us, 

you’ll probability want to check the Use Windows Authentication option.  
o SQL Server - If you are connecting to full blown SQL Server then complete the SQL 

Server Authentication information. 
▪ Check the Use SQL Server Authentication option. 
▪ Fill in the User Name and Password fields. 

• Next move to the Connect to a database group to connect to the actual database. 
o SQL Server: 

▪ Check the Select or enter a database name option. 
▪ Move to the drop down found here and either select or enter the name of the 

database you are connecting to. 
o SQL Express: (Attached database file) 

▪ Check the Attach a database file option. 
▪ Either use the Browse button here to select the database file, or type in the full path 

to the database (mdf) file in the space provided. 

• Test Connection – Move to and click on the Test Connection button to ensure you have a good 
connect. If it fails, you may want to click on the Advanced button to further define you connection 
properties. 
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• Click on the OK button to accept and apply the connection. 

 
• Click either Next or the Select Table tab. 

• The drop down list here will contain all tables found within the selected database. Move to the 
Choose the Table the report’s data will come from list and select the table you want to base your 
report on by clicking on it. 

 
• To join a second table to the first table selected: 
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o Check the Select and join a second table checkbox. 
o Move to the Choose the second table to be joined to the first drop down and select the 

second table to be joined with the first. 
o Next you need to setup the criteria as to how these tables interact with one another. This is 

normally accomplished by fields that point to one another and would share the same values 
(parent/child relationship). 

o Move to the Where drop down and select the field or column name for the parent table. 
o Move to the = drop down and select the field or column name of the child table. 

• Once you are done setting up your table or tables, either click on the Next button or click on the 
Select Fields tab. 

 
• All the database fields from the selected table or tables will be displayed on the Available Fields or 

Columns list box. You now need to select the fields to include in your report. 
o To select one field at a time, move to the Available Fields or Columns list and click on the 

field title of your choice. Next click on > button to move the field to the Selected Fields or 
Columns list. Double clicking on a field will also move it to the right list. 

o To move all the available fields from the Available Fields or Columns list to the Selected 
Fields or Columns list, click on the >> button. 

• All database fields or column that will be included in your report will be displayed in the Selected 
Fields or Columns list box. To remove some of these selected fields: 

o To remove one field at a time, move to the Selected Fields or Columns list and click on the 
field title of your choice. Next click on < button to remove the field from the list. Double 
clicking on a field will also remove it. 

o To remove all the fields in the Selected Fields or Columns list, click on the << button. 
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• Once you are done setting up the fields or columns to include in your report, click on the Next 
button or Report Criteria tab. 

 
• Setup on this tab is optional. If no criteria is setup, the report will return all available records. 

• To setup filtering criteria for your report: 
o Move to the top most Database Fields drop down and select a field to be used as a selection 

filter. 
o Move to the Operator drop down and select an operator to use with the selection criteria 

you are setting up. 
o Move to the Matching Data field and setup the filtering criteria. Sample data is included in 

the drop down list.  
o If you want, you can repeat the above 3 steps for the remaining 3 criteria setups. 

• When done setting up your report criteria, , click on the Next button or Sorting tab 
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• Move to the top most drop down and select a field in which to sort your report by. If you want 
the report to be sorted in descending order, place a checkmark in the Descending Order 
checkbox. No checkmark, ascending is assumed. 

• You can repeat the above step for up to three fields to sort your report by. 

• Click on the Save and Close button and the basic report will be created.  

Saving a Report Setup 
You can save a report setup to file, thereby eliminating the need to recreate everything from scratch. 

Once re-opened, you will only need to change some of the report criteria to your new specifications. 

To save a report setup: 

• Create the report using the Report Wizard and as explained in the Creating a New Report section. 

• Click on the Save Report Setup option on the Reports tab of the ribbon. 

• From the invoked Save Setup browse to and select folder you wish to save the file in. 

• Move to the File name text box and type in a name for the file. 

• Click on the Save button. 

Loading a Saved Report Setup 
To open a saved report setup: 

• Click on the Load Report Setup option on the Reports tab of the ribbon. 
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• From the invoked Open Setup dialog, browse to and open the folder you have the saved file 
stored in. 

• Click on the file to select it, or type its name in the File Name text box. 

• Click the Open button. 

• The Report Wizard should now load with the basic report settings and criteria as previously 
saved.  

• Modify your report settings as outlined in the Creating a New Report section. 

Saving a Report to File 
 You can save a finished report to file for viewing later or for sharing with others.  

To save a report: 

• Click on the Save As Report option on the Reports tab of the ribbon. 

• From the invoked Save Report dialog, browse to and select folder you wish to save the file in. 

• Move to the Save as type drop down and select the file type you want to save the file as. 

• Move to the File name text box and type in a name for the file. 

• Click on the Save button. 

Loading a Save Report 
To open a saved report file: 

• Click on the Load Saved Report option on the Reports tab of the ribbon. 

• From the invoked Open Report dialog, browse to and open the folder you have the saved file 
stored in. 

• Click on the file to select it, or type its name in the File Name text box. 

• Click the Open button. 

Printing a Report 
To print a report: 

• Click on the Print Report option on the Reports tab of the ribbon. 

Print Preview a Report 
To print preview a report: 

• Click on the Print Preview option on the Reports tab of the ribbon. 

Report Page Setup 
The Report Page Setup allows you to specify various options that affect the printed document, it also 

allows you to preview your document. To use the Page Setup: 
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• Click on the Report Page Setup option on the Reports tab of the ribbon. 

Page Setup Dialog 
The following are the elements of the Print Setup dialog: 

 

Page Orientation 

This section allows you to setup the print orientation of the printed document. To specify this value, just 

check the appropriate checkbox. Options include: 

• Portrait 

• Landscape 

Page Scaling 

This section allows you to scale your document to fit X pages tall by X pages wide.  To set this option: 

• Move to and check the Use Fit to page checkbox. 

• Move to the Page Height spin box, and set how many page high you want to scale to. 

• Repeat for the Pages Wide spin box. 

Other Print Options 

You have other print options that you can turn on or off by placing or removing a checkmark. These 

options include: 

• Print in Black and White 

• Print Grid Lines 

• Print Headers (grid) 
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Print Preview 

To preview you document from this dialog, click on the Print Preview button. 

Close 

 Clicking the Close button will apply the options you have set. 

Export Options 
The available export options work in the same basic way as Saving a Report File. To export a report: 

• Click on the Export option on the Reports tab of the ribbon. 

• Now, from the expanded drop down, click on the export option of your choice. Choices include: 
o Export to Excel 
o Export to HTML 
o Export to PDF 

• From the invoked Save Report dialog, browse to and select the folder you wish to save the file 
in. 

• Move to the File name text box and type in a name for the file. 

• Click on the Save button. 

Document Display Zooming 
You can change the viewing size of your document by zooming in and out on it. To zooming in or out of 

the loaded document: 

• Move to the Report tab in the ribbon.  

• Click on either the Zoom In or Zoom Out options. 

Creating a Chart from Report Data 
You can create charts and graphs directly from report data, to use this feature: 

• Create your report as outlined previously in this chapter. Try to select you report fields so that 
one column will hold the labels for your chart, and the next adjacent field(s) contain report 
numeric data. 

 

• Select the rows and columns that you want to create a chart on from within the report grid. 

• Move to the Design tab in the ribbon and locate the Chart group, click on the Create option. 
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Format Cells  
Cell formatting can be done from within the Format tab of the ribbon, and many options are provided 

from the Format Cells Dialog screen. Both methods require the selection of cells to be formatted. 

Selecting Cells in the Document 
To select cells in the document, use the following mouse actions and keyboard shortcuts.  

• To select a single cell, click the cell or press the arrow keys to move to the required cell.  

• To select a range of cells, do one of the following. 

o Click the first cell in the range and drag it to the last cell. 

o Hold down the SHIFT key, and then press the arrow keys to extend the selection. 

o Click the first cell in the range, hold down the SHIFT key, and then click the last cell in 

the range.  

• To select the entire worksheet, click the Select All button at the intersection of the column and 

row headings, or press CTRL+A. 

 
• To select nonadjacent cells, hold down the CTRL key, and then select other cells.  

• To select an entire row or column, click the row or column heading.  

 
• To select multiple columns or rows, drag across the row or column headings. 

 
• To select several nonadjacent rows or columns, click the heading of the first row or column in 

the selection, hold down CTRL, and then click the headings of other rows or columns you wish to 

select. 

 

The following table lists the default keyboard shortcuts used for selecting cells in the Designer. 
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CTRL+RIGHT ARROW Selects the last cell in a row. 

CTRL+LEFT ARROW Selects the first cell in a row. 

CTRL+DOWN ARROW Selects the last cell in a column. 

CTRL+UP ARROW Selects the first cell in a column. 

CTRL+HOME Selects the first cell on a worksheet.  

CTRL+END  Selects the last cell that contains data or formatting on a worksheet. 

CTRL+A Selects the entire worksheet.  

CTRL+SHIFT+END  Extends the selection to the last used cell on a worksheet. 

CTRL+SHIFT+HOME Extends the selection to the beginning of the document. 

Number Formatting  
The Designer allows you to format numbers in cells to make them easier to read and understand. For 

example, you can display numbers as monetary values or dates. The default format for cell content is 

the General style. Notice that number formatting does not change the value you enter, it only influences 

the way the number is displayed in a cell. Number formatting options are available in the Number group 

within the Format tab.  

 

Depending on the format you wish to apply, click one of the buttons in the Number group, such as 

Accounting Number Format, Percent Style or Comma Style. 
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If you wish to set more formatting parameters, click the Number dialog box launcher to invoke the 

Format Cells dialog box. Select the desired number format, and then specify formatting options in the 

right pane of the dialog box. 

Alignment Formatting  
To position text within a cell so that it is centered, aligned to the left or aligned to the right, select the 

appropriate alignment options in the Alignment group within the Format tab. 

 

To specify additional alignment options, click the arrow in the bottom right corner of the Alignment 

group. The dialog box launcher invokes the Format Cells dialog. In the Alignment tab, specify all required 

parameters and click OK to apply them to the selected cells. 
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Font or Text Formatting 
The Designer provides the capability to set font style, size, color and text alignment in a cell. 

To format cell content, follow the steps below. 

• Select a cell or a cell range that you wish to format. 

• To change the font, use the Font group within the Home tab to specify the font family, size, 

style, color, etc. 

 
You can also modify cell font using the Font tab of the Format Cells dialog box. To invoke this 

dialog, click the arrow in the bottom right corner of the Font group. In the Font tab, you can 
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specify the required font characteristics and apply them to the selected cells. 

 

Applying Specific Formatting 
To specify your own formatting options: 

• Select the cell or cells you want the formatting to effect. 

• Click on the Design tab in the ribbon. 

Borders 

• To add borders to the selected cells, do one of the following. 
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• In the Font group within the Format tab, click the Borders button's drop-down menu and select 

the border type. This menu also allows you to select the line style and line color of borders. 

 
• Click the Font dialog box launcher to invoke the Format Cells dialog box. Click the Border tab 

and specify all required parameters. Then click OK. 
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Background Color 
To set the background color of the selected cells, do one of the following. 

• In the Font group within the Format tab, click the Fill Color button's drop-down menu and select 

the desired color. 

 
• Click the Font dialog box launcher, and in the invoked Format Cells dialog box, open the Fill tab. 

Specify all required parameters and click OK. 
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Clear Cell Formatting   
To remove all formatting from cells, do one of the following. 

• In the Editing group within the Format tab, click the Clear button, and select Clear Formats from 

the drop-down menu. 

Merging Cells 
To merge cells, follow the instructions below. 

• Select the cells that you wish to merge. 

Note: Make sure that the data you wish to display in the merged cell is contained in the upper-

left cell of the selected range, because only the contents of this cell will remain in the merged 

cell. The data in the other cells will be deleted. 

• In the Alignment group within the Format tab, click the Merge Cells button's drop-down arrow 

and select one of the following items. 

o Merge & Center - merge the selected cells and center the text in a merged cell. 

o Merge Across - merge each row of the selected cell range into larger cells. 

o Merge Cells - merge the selected cells into a single cell. 

 
• If you change your mind and wish to split a merged cell, select this cell and click the Unmerge 

Cells item in the Merge Cells button's drop-down menu. The data of the merged cell appears in 

the upper-left cell of the range of split cells 

Wrapping Text in a Cell 
To wrap text in a cell, do the following: 

• Select a cell or a range of cells containing the text you wish to wrap.  

• In the Alignment group within the Format tab, click the Wrap Text button. The text is displayed 

on multiple lines within the cell.  

• To unwrap the text, click the Wrap Text button again. The text is displayed in the same way as it 

was before the wrap option was applied. 
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Format as a Table 
To format a range of cells as a table: 

• Select the range of cells that you want to apply the formatting to. 

• Move to the Format tab in the ribbon and select the Format As Table option. 

 
• Select the desired style from the gallery. 

Insert a New Blank Column into your Report 
To insert a new blank column into your report document: 

• Select a column in the document just after the insertion point of the new column. 

• Move to the Format tab in the ribbon and click on the Insert option. 

• From the drop down, select the Insert Sheet Columns option. 

Insert a New Blank Row into your Report 
To insert a new blank row into your report document: 

• Select a row in the document just below the insertion point of the new row. 

• Move to the Format tab in the ribbon and click on the Insert option. 

• From the drop down, select the Insert Sheet Row option. 

Delete Rows(s) and Column(s) in your Report 
To remove columns or rows from your report: 

• Select the column(s) or row(s) you wish to delete by clicking its heading.  

• Do one of the following: 

o In the Cells group within the Format tab, click the Delete button and select the Delete 

Sheet Rows or Delete Sheet Columns item from the drop-down list.  
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o Right-click a cell within the selected column(s) or row(s), and then click the Delete item 

in the invoked menu. The specified column(s) or row(s) will be deleted. 

Setting the Column Width  
In the Designer, the column width can vary from zero to 255 characters of the default font specified by 

the predefined Normal style. If you set the column width to zero, the column will be hidden.  

To change the column width, do one of the following: 

• Drag the right boundary of the column heading to resize the column width. To set the width of 

multiple columns, select these columns, and then drag the right boundary of any selected 

column. 

• To change the column width to automatically fit the contents, select the column and do one of 

the following. 

o On the Format tab, in the Cells group, click the Format button and select the AutoFit 

Column Width item from the drop-down list. 

 
o Double-click the right boundary of the selected column. 

Set the Row Height  
In the Designer the row height should be between zero and 409 points. If you set the row height to zero, 

the row is hidden.  

To change the row height, do one of the following: 

• Drag the lower boundary of the row heading until the row is the height you want. To set the 

height of multiple rows, select them, and then drag the lower boundary of any selected row. 

• To change the row height to automatically fit the contents, select the row and do one of the 

following: 

o On the Format tab, in the Cells group, click the Format button and select the AutoFit 

Row Height item from the drop-down list. 

o Double-click the lower boundary of the selected rows. 
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Hide and Unhide Columns 
Select the column to be hidden. 

• Do one of the following: 

o Set the column width to zero. To do this, drag the boundary of the column heading until 

the column is hidden. 

o On the Format tab, in the Cells group, click the Format button and select Hide & Unhide 

| Hide Columns; 

 
o Right-click the selected column and select the Hide item from the context menu. 

To show the column you hid, select the columns adjoining to either side of the hidden column, and then 

do one of the following: 

• On the Format tab, in the Cells group, click the Format button, and then select Hide & Unhide | 

Unhide Columns; 

• Right-click the selected columns and select the Unhide item from the context menu. 

 

Hide and Unhide Rows 
Select the row to be hidden. 
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• Do one of the following: 

o Set the row height to zero. To do this, drag the boundary of the row heading until the 

row is not displayed; 

o On the Format tab, in the Cells group, click the Format button and select Hide & Unhide 

| Hide Rows; 

 
o Right-click the selected row and select the Hide item from the context menu. 

To display the row you hid, select the rows that are above and below the hidden row, and then do one 

of the following: 

• On the Format tab, in the Cells group, click the Format button, and then select Hide & Unhide | 

Unhide Rows; 

• Right-click the selected rows and select the Unhide item from the context menu; 

 

Display all hidden columns and rows 
Click the Select all button at the intersection of the column and row headings, or press CTRL+A. 

• Do one of the following:  
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o On the Format tab, in the Cells group, click the Format button, and then select Hide & 

Unhide | Unhide Rows or Unhide Columns; 

o Right-click the selection and select the Unhide item from the context menu. 

Fill Data Automatically 
The Designer provides the capability to fill adjacent cells with data automatically. 

To fill a selected cell or a range of cells with the data contained in adjacent cells, do the following. 

• Select the cell (or range of cells) adjacent to the cell (or range of cells) of the data you wish to 

repeat. 

• In the Editing group within the Format tab, click the Fill button and select one of the following 

items from the drop-down list. 

 
o Fill Down (or press CTRL+D) - pastes the contents of the cell that is above the selected 

cell, or pastes the contents of the topmost cell in the selected range to the cells below. 

o Fill Up - pastes the contents of the cell below the selected cell, or pastes the contents of 

the lowermost cell in the selected range to the cells above. 

o Fill Right (or press CTRL+R) - pastes the contents of the cell or cell range to the left of 

the selected cell(s). 

o Fill Left - pastes the contents of the cell or cell range to the right of the selected cell(s). 

Auto Sum Cells 
If you have numeric information within your report, and you would like to add this information together 

and provide a total, please follow these steps. 

• Select all the cells in the report that you want to add together, either by row or column. 

• Continue the cells selection stopping at an empty cell just beyond the ones you want added 
together. 

• Move to the Format tab in the ribbon and click on the AutoSum option. 

• From the drop down, select the Auto Sum Cells option. 

• The total of the selected cells with be inserted into the last cell of the selection range. 
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Find and Replace   
The Designer allows you to search for specific data in the current document.  
 

• To perform a search, on the Format tab, in the Editing group, click the Find & Select button. The 
button's drop-down menu will be displayed. 

• Next, do one of the following. 
o Click Find in the Find & Select drop-down menu (or press CTRL+F) to perform a search in 

the active document. The Find and Replace dialog (with the Find tab activated) will be 
invoked. 

 
o In the Find what field, enter the text or number you wish to find, and click the Find Next 

button to start the search. To define the direction of the search, in the Search field, 
select the By Rows or By Columns drop-down item. In the Look in field, select Values (to 
search cell values only). To perform a case-sensitive search, select the Match Case check 
box. To restrict the search to the entire cell content, select the Match entire cell 
contents check box. 

 

• Click Replace in the Find & Select drop-down menu (or press CTRL+H) to search for a text string 
and optionally replace it with another value. The Find and Replace dialog (with the Replace tab 
activated) will be invoked. 
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• To replace a value, enter the search term in the Find what field and the replacement text for 
this search term in the Replace with field, and then click the Find Next button to find the first 
occurrence of the search term. Next, click the Replace button to replace only the value of the 
selected matching cell, or Replace All to replace all occurrences of the search term. Note that 
the Replace tab provides the same search options as the Find tab. 

Hide Gridlines and Headings 
The Designer allows you to hide gridlines and headings that are displayed on a document by default. 

In the Show group within the Page Layout tab, uncheck the Gridlines check box to hide gridlines on a 

worksheet. 

 

To hide the column and row headers, uncheck the Headings check box. 

To display gridlines and headers, select the Gridlines and Headings check boxes, respectively. 

Adjust Page Settings 
Before you print a report, you can change page layout settings such as page margins, page orientation 

and paper size.  

Set Page Margins  
• In the Page Setup group within the Page Layout tab, click the Margins button and select the 

margin sizes to be set for the current worksheet. 
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Set Page Orientation  

• In the Page Setup group within the Page Layout tab, click the Orientation button and select 

Portrait or Landscape from the invoked drop-down list. 

 

Change Paper Size  

• In the Page Setup group within the Page Layout tab, click the Size button and select one of the 

predefined paper sizes from the invoked drop-down list. 

 

Print Gridlines and Headings 
The Designer allows you to hide gridlines and headings that are printed on a document by default. 

In the Print group within the Page Layout tab, uncheck the Gridlines check box to hide gridlines on a 

worksheet. 

To hide the column and row headers, uncheck the Headings check box. 

To display gridlines and headers, select the Gridlines and Headings check boxes, respectively. 
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Snap Reporting Engine 

This section provides information on the basic principles of creating reports with Snap. 

Snap is a WYSIWYG reporting engine that provides a user interface that allows for a quick creation of 

standard reports with the capabilities of data shaping (grouping, sorting and filtering), hierarchical data 

representation (master-detail reports), mail merge and much more. 

 

Graphical User Interface 

The topics in this section describe various aspects of the Snap graphical user interface (GUI). 

• Snap Application Elements  
• Main Toolbar  

Snap Application Elements 

The topics in this section describe the main elements that make up the user interface of a Snap 

application. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17318.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17328.aspx
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This section consists of the following topics. 

• Snap User Interface Overview  
• Main Toolbar  
• Design Surface  
• Data Explorer  
• Report Explorer  
• Print Preview  

Snap User Interface Overview 

This document lists the essential elements of the Snap user interface, and provides links to specific 

topics that describe these elements in more detail. 

The main elements of the Snap user interface are as follows. 

• Main Toolbar 

The Main Toolbar in a Snap application provides quick access to the available document editing 

tools. Tools are provided via the Ribbon Control interface. 

Tools are organized in various sections, contained in different tabs. 

 

• Design Surface 

The body of a report in the designer. In this region, you can design your report layout and 

immediately view the result. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17310.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17312.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17311.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17315.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17314.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17313.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17312.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17311.aspx
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• Data Explorer 

Reflects the structure of available data, allowing you to manage a report's data sources. You can add 

the data shown in this pane to your report via drag-and-drop. 

 

• Report Explorer 

Reflects the hierarchy of the elements of a Snap document. 

 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17315.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17314.aspx
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Main Toolbar 

The topics in this section describe all ribbon tabs available in the toolbar of a Snap application. 

After executing a command in a Snap application, the corresponding field codes are automatically 

added to the document markup. 

Data Tools: Field 

This toolbar is context sensitive, and becomes active after selecting a Snap field in the document. 

 

The commands available in the Field toolbar of the Data Tools category are divided into the following 

sections. 

Data Shaping Group 

• Group By Field - Groups a Snap list by the selected field. 
All groupings added to a Snap report are displayed as nodes in the Report Explorer.  

• Sort Ascending - Sorts a Snap list by the selected column in ascending order. To manage the sort 
levels in a mail merge document, use the Sort command of the Data Tools: Mail Merge toolbar. 

• Sort Descending -Sorts a Snap list by the selected column in descending order. To manage the 
sort levels in a mail merge document, use the Sort command of the Data Tools: Mail Merge 
toolbar. 

• Summary - Calculates a summary for a selected field. Summary results are shown in the list 
footer. The following summary functions are available. 

o  Count 
o  Sum 
o  Average 
o Max. 
o Min.  

• Quick Filter - Allows you to select which values of a selected field to show. This command is not 
applicable to nested lists of a master-detail report. To apply complex filtering criteria to a Snap 
list, use the Filter command of the Data Tools: List or Data Tools: Mail Merge toolbar. 

Element Group 
• Properties - Shows the list of properties for a selected field. The set of available properties 

depends on the element type. 

Data Tools: Group 

This toolbar is context sensitive, and becomes active after placing the text cursor in a group header or 

footer. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17312.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17314.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17345.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17345.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17340.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17345.aspx
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To create a new group, use the Group By Field command of the Data Tools: Field toolbar. 

Layout Group 

• Header -Adds or removes a group header. Removing both the group header and group footer 
removes grouping from the Snap List. 

• Footer - Adds or removes the group footer. Removing both the group header and group footer 
removes grouping from the Snap List. 

• Group Fields - Invokes a dialog allowing you to add or remove grouping criteria for the selected 
group. 

 

• Arrange Groups - Invokes the Groups Order Editor, which allows you to set the order in which 
groupings are applied to a Snap list. 

 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17338.aspx
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• Separator - Inserts the selected separator between groups in a Snap list. The following 
separators are available. 

o Page Break 
o Section (Next Page) 
o Section (Even Page) 
o Section (Odd Page) 
o Empty Paragraph 
o Empty Row 
o None 

Data Tools: List 

This toolbar is context sensitive, and becomes active after selecting a Snap list in the document. 

 

The commands available in the List toolbar of the Data Tools category are divided into the following 

sections. 

Layout Group 

• Header - Adds or removes the header of a selected Snap list. 

• Footer - Adds or removes the footer of a selected Snap list. 

Commands Group 

• Filter - Invokes the FilterString Editor, which allows you to define complex filtering criteria for a 
selected Snap list. 
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To select which data records to display for a specific field, use the Quick Filter command from 

the Data Tools: Field toolbar. 

• Convert to Paragraphs - Removes the table layout of a Snap list. The content of the removed 
table columns is presented as separate paragraphs. There is no reverse action to convert 
paragraphs back to a tabular representation. 

• Delete List - Removes the selected list from a document. 

Edit Row Limit Group 

• Edit Row Limit - Allows you to define the maximum number of rows to be shown in a selected 
Snap list. 
The Editor Row Limit setting does not affect the number of records shown in the Print Preview, 
which shows the final presentation of the document with all Snap fields replaced with actual 
data. 

Data Tools: Mail Merge 

 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17338.aspx
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Data Group 

• Data Source - Enables mail merge for a connected data source. After enabling this mode, the 
data source icon is displayed in green in the Data Explorer. 

 

There is no functionality for disabling mail merge once it has been implemented. 

• Filter - Invokes the FilterString Editor to filter data in a mail merge document. 

 

• Sort - Invokes the Sort dialog to sort data in a mail merge document 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17315.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17325.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17322.aspx


Maintenance Coordinator – Professional Features 

 

Simplicity Software Technologies Inc. | Main Toolbar 127 

 

 

Current Record Group 

• Current Record (Data Control) - Allows you to navigate through records in a mail merge 
document. You can navigate to the Next Page, the Previous Page, the First Page or the Last 
Page. 

Publish Group 

• Finish and Merge - Finalizes a mail merge document by supplying actual values to data elements 
added to a document template. This command invokes a drop-down menu to select the 
publishing format of a document. The following options are available. 

o Export - exports the created document to a selected third-party format 
o Print - invokes the print dialog to adjust the page options of the document before 

sending it to a printer 
o Print Preview - displays the created document in a print preview window that provides 

options to navigate, print and/or export the document. 

After selecting the document's output format, the Export Range dialog is invoked to specify the range of 

data records that the document should include. 

 

In this dialog, you can choose from the following separators to isolate different data records. 
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• None 

• Page Break 

• Section (Next Page) 

• Section (Even Page) 

• Section (Odd Page) 

• Paragraph 

Data Tools: Appearance 

This toolbar is context sensitive, and becomes active after placing the text cursor in a document table. 

 

Additional Reporting Commands 

General Tools: Report 

The File toolbar contains the basic file management and printing commands. 

 

Common Group 

• New - Creates a new Snap document. 

• Open - Opens an existing document. A Snap document template can be created based on the 
following third-party file formats. 

o DOC (Microsoft® Word® 97 – 2003 document) 
o DOCX (Office® Open XML document) 
o EPUB (Electronic Publication) 
o HTML (HyperText Markup Language) 
o MHTML / MHT (Web archive, single file) 
o PDF (Portable Document Format) 
o RTF (Rich Text Format) 
o TXT (Plain text) 
o ODT (OpenDocument text document) 
o XML (Microsoft® Word® XML document) 
o Image (BMP, EMF, WMF, GIF, JPEG, PNG or TIFF format)  
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The SNX format stores a Snap report without the document field data.  

Saving a document in any other format retrieves the required data values and excludes any 

information about the data connections defined by Snap.  

To apply the uniform layout and style settings of a specific document to multiple reports, open 

this document as a template.  

In this mode, the Save command is disabled to prevent open templates from being overwritten. 

• Save - Saves a document template to an SNX file. When saving a document for the first time, the 
Save As dialog will appear. 

• Save As - Saves a document template to a new SNX file. This command invokes the Save As 
dialog, allowing you to specify a name and location for the new file. 

• Export - Exports a document into one of the supported third-party formats. A Snap report can 
be exported to one of the following third-party formats. 
DOC (Microsoft® Word® 97 – 2003 document) 

o DOCX (Office® Open XML document) 
o EPUB (Electronic Publication) 
o HTML (HyperText Markup Language) 
o MHTML / MHT (Web archive, single file) 
o PDF (Portable Document Format) 
o RTF (Rich Text Format) 
o TXT (Plain text) 
o ODT (OpenDocument text document) 
o XML (Microsoft® Word® XML document) 

• Quick Print - Sends a document to the default printer with default printing options. 

• Print - Invokes the Print dialog, allowing you to select a printer and specify the printing options. 

• Print Preview - Retrieves all data required to populate the report fields to assemble and 
preview a document before publishing, ignoring the current Editor Row Limit setting. 
Calling this command for a mail-merge document renders only one page of the document. 

To render a mail-merge document for a specified range of data records, use the Finish & Merge 

option in the Data Tools: Mail Merge tab. 

• Undo - Cancels the last change made to the document. 

• Redo - Reverses the results of the last undo. 

Data Group 

• Add New Data Source - Invokes the Create Data Source wizard, allowing you to connect the 
document to a new data source and specify its data connection options (e.g., data provider, 
login information and connection name). 

A data table selected with the wizard is included in the data source. To add more tables and 

specify their data relations, use the Query Designer. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17340.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17345.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument16042.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument16042.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17319.aspx
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General Tools: Insert 

 

Pages Group 

• Page Break - Inserts a page break at the carriage position. A page break cannot occur within 
tables, lists, or document headers and footers. 

Table Group 

• Table - Inserts a table with a specified number of rows and columns at the carriage position.  
To customize the table layout, use the commands available in the Table Tools: Design and Table 
Tools: Layout tabs. 

Illustrations Group 

• Inline Picture - Inserts an inline picture at the carriage position. In a document, the inline picture 
behaves like an ordinary text symbol. 

• Picture - Inserts a picture into a document. You can adjust the picture's outline, wrap text, 
position, and order using commands from the Picture Tools: Format tab. 

Toolbox Group 

• Barcode - Inserts a bar code at the carriage position.  
After adding a bar code, specify its symbology, data binding and other options using the 
Properties command in the Data Tools: Field tab. 

• Checkbox - Inserts a check box at the carriage position (e.g., to display Boolean values from a 
data source).  
To customize the check box state or bind it to external data, use the Properties command in the 
Data Tools: Field tab. 

• Chart - Inserts a chart at the carriage position. 

Links Group 

• Bookmark - Invokes the Bookmark dialog to add a new bookmark at the carriage position, or 
navigate to an existing bookmark. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17333.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17334.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17334.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17343.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17338.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17338.aspx
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• Hyperlink - Invokes the Insert Hyperlink dialog to create a hyperlink and specify its text, screen 
tip and destination.  
A hyperlink's destination may be a web page, file, or specific position within a document.  

 

• Header - Allows editing the page header. In a published document, the content added to the 
header will appear at the top of each page.  
To quickly switch to this mode, double-click the page header area.  

To quit page header editing, press ESC, double click the document area, or click Close Header 

and Footer on the Header & Footer tab.  

To make the first page header display unique content, or make odd- and even-numbered pages 

carry different headers, use the options available on the Header and Footer Tools: Design tab. 

• Footer - Activates the page footer edit mode. In a published document, the content added to 
the footer will appear at the bottom of each page.  
To quickly switch to this mode, double-click the page footer area.  

To quit page footer editing, press ESC, double click the document area, or click Close Header 

and Footer on the Header & Footer tab.  

https://documentation.devexpress.com/#InterfaceElementsWin/CustomDocument17336/HeaderAndFooter
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17330.aspx
https://documentation.devexpress.com/#InterfaceElementsWin/CustomDocument17336/HeaderAndFooter
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To make the first page footer display unique content, or make odd- and even-numbered pages 

carry different footers, use the options available on the Header and Footer Tools: Design tab. 

• Page Number - Inserts the number of the current page at the carriage position. The page 
statistics can only be added to a page header or footer. 

• Page Count - Inserts the total page count at the carriage position. The page statistics can only be 
added to a page header or footer. 

Text Group 

• Text Box - Inserts a text box into a document. A text box is a floating container that is capable of 
displaying virtually any kind of content (including the most elaborate lists), posing no 
restrictions on its size and location within a document. 

Symbols Group 

• Symbol - Invokes the Symbol dialog, to insert characters that are not available on the keyboard. 

 

General Tools: View 

The View toolbar contains commands that control the presentation of document elements on the 

Design Surface. 

 

Document View Group 

• Simple View - Shows a document without the page layout. 

• Draft View - Shows a document in a draft view that ignores certain document elements such as 
page breaks, and headers and footers. 

• Print Layout - Shows a document as it will appear on the printed page. 

Show Group 

• Horizontal Ruler - Shows or hides the horizontal ruler at the top of the Design Surface. 

• Vertical Ruler - Shows or hides the vertical ruler to the left of the Design Surface. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17330.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17311.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17311.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17311.aspx


Maintenance Coordinator – Professional Features 

 

Simplicity Software Technologies Inc. | Additional Reporting Commands 133 

 

Zoom Group 

• Zoom Out - Zooms the document out. 

• Zoom In - Zooms the document in. 

View Group 

• Windows - Shows or hides the Snap application windows (i.e., Data Explorer and Report 
Explorer). 

• Highlight - Highlights the boundaries of a list element after it receives input focus.  
The invoked frame displays the type of element that is highlighted. 

Mail Merge Group 

• Show All Field Codes - Toggles to show the field codes of all elements that provide dynamic 
content in a document. 

• Show All Field Results - Switches back to the default mode, which displays the actual values 
fetched by Snap fields supplying dynamic content to a document.  

To effectively handle incoming data, only a portion of data is shown during real-time editing of a 

document. This restriction does not apply to a document created for print preview, and the 

report requests all data after it is set for publishing.  

When a document is being edited, only the first 20 rows from each data column are shown by 

default. To modify or disable this limit, use the Editor Row Limit option in the Data Tools: List 

tab. 

• Highlight Fields - Highlights the data fields that have been added to a document from an 
external data source to distinguish these fields from the rest of the document content. 

General Tools: References 

The References toolbar contains commands that provide different kinds of references to a document, 

such as a table of contents and table captions. 

 

Table of Contents Group 

• Table of Contents - Inserts a table of contents at the carriage position. 

• Update Table - Updates the table of contents to ensure that all entries in it refer to the correct 
page numbers. 

• Add Text - Adds the current paragraph as an entry to the specified level of the table of contents.  
If a data field is added to the table of contents, a separate table of contents entry is created for 
each data row in the Snap list. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17315.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17314.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17314.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17340.aspx
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Captions Group 

• Insert Caption - Inserts sequentially numbered captions for different types of objects at the 
carriage position. The following caption types are available:  

o Figures Caption (automatically referenced by the table of figures) 
o Tables Caption (automatically referenced by the table of captions) 
o Equations Caption (automatically referenced by the table of equations). 

• Insert Table of Figures - Creates a table of figures, table of tables, or table of equations, 
containing page numbers for objects of the corresponding types. 

• Update Table - Updates the table of figures so that all entries refer to the correct page numbers. 

Table Tools: Design 
This toolbar is context sensitive, and becomes active after placing the text cursor in a document table. 

 

Table Styles Group 

• Header Row - Enables formatting of the first row in a table. 

• First Column - Enables special formatting for the last row in a table. 

• Total Row - Enables special formatting for the first column in a table. 

• Last Column - Enables special formatting for the last column in a table. 

• Banded Rows - Enables special formatting for odd and even rows in a table. 

• Banded Columns - Enables special formatting for odd and even columns in a table. 

Table Styles Group 

• Table Styles - Sets a table style for the selected table. Clicking the arrow button invokes the 
drop-down menu containing the following commands for managing table styles. 

o New Table Style... 
o Modify Table Style... 
o Delete Table Style... 

Creating a new table style or modifying an existing one invokes the Modify Style dialog, allowing 

you to specify a style name and adjust table formatting options (including special formatting 

options for different table parts). 

You can enable special formatting using commands from the Table Style Options section within 

this toolbar category. 

Cell Styles Group 

• Cell Styles - Sets a cell style for the selected table cell. Clicking the arrow button invokes the 
drop-down menu, containing the following commands for managing table cell styles. 

o  New Cell Style... 
o Modify Cell Style... 
o Delete Cell Style... 

Creating a new table cell style or modifying an existing one invokes the Modify Style dialog, 

allowing you to specify a style name and adjust cell formatting options. 

https://documentation.devexpress.com/#InterfaceElementsWin/CustomDocument17333/TableStyleOptions
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Borders and Shadings Group 

• Line Style - Sets the style of a line that is used to draw borders. 

• Line Weight - Sets the width of the line that is used to draw borders. 

• Pen Color - Sets the color that is used to draw borders. 

• Borders - Draws the specified borders for selected cells. 

• Shading - Specifies the background color for the selected cells. 

Table Tools: Layout 

The commands available in the Layout toolbar of the Table Tools category are divided into the following 

sections. 

 

Table Group 

• Select - Allows you to select a cell, row, column or table.  

• View Gridlines - Shows or hides table gridlines. This command is useful when working with 
tables that contain invisible borders. These lines are only displayed in the Design Surface - they 
do not appear in a published document. 

• Properties - Invokes the Table Properties dialog for the selected table. 

 

This dialog allows you to adjust the size and alignment properties of the current table cell, row, 

column or table. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17311.aspx
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Rows and Columns Group 

• Delete - Deletes the specified cells or the currently selected row, column or table. To delete a 
single table cell, the Delete Cells dialog is invoked that allows you to select the "shift" mode for 
replacing the deleted cell. 

  

To remove individual rows from a Snap List, use the Quick Filter command of the Data Tools: 

Field toolbar. 

• Insert Above - Inserts a new row above the selected row. 

• Insert Below - Inserts a new row below the selected row. 

• Insert Left - Inserts a new column to the left of the selected column. 

• Insert Right - Inserts a new column to the right of the selected column. 

Merge Group 

• Merge Cells - Merges selected cells. The content of merged cells is converted to paragraphs of 
an output cell. 

• Split Cells - Splits the selected cell into a specified number of rows and columns. The content of 
the source cell is placed in the top-left output cell. 

• Split Table - Splits the table into two tables. The selected row becomes the first row of the new 
table. 

Cell Size Group 

• Auto Fit - Sets the auto fit mode of the selected table. The following auto fit modes are 
available: 

o AutoFit Contents - table cells occupy the minimum width possible to fit content. 
o AutoFit Window - the table occupies the entire width of the page. Table cells are resized 

to fit their content. 
o Fixed Column Width - column width is fixed and can only be changed manually. 

Alignment Group 

• Alignment - Sets the text alignment for selected cells. 

• Cell Margins - Invokes the Table Options dialog, allowing you to set the default cell margins for 
the selected table cells. 
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Word-Processing Commands 

General Tools: Home 

The Home toolbar contains text formatting and alignment commands. 

 

Clipboard Group 

• Paste - Pastes the content of the clipboard into a carriage position. 

• Cut - Cuts the selected content and places it in the clipboard. 

• Copy - Copies the selected content and places it in the clipboard. 

• Paste Special - Invokes the Paste Special dialog, allowing you to paste the content of the 
clipboard with a specified formatting. 

 

Font Group 

• Font - Specifies a font for the selected text. 

• Font Size - Specifies a font size for the selected text. 

• Grow Font - Increases the font size of the selected text. 

• Shrink Font - Decreases the font size of the selected text. 

• Change Case - Changes the case of the selected text to uppercase or lowercase. 

• Bold - Makes the selected text bold. 

• Italic - Italicizes the selected text. 

• Underline - Draws a line under the selected text. 

• Double Underline - Draws a double line under the selected text. 

• Strikethrough - Draws a line through the middle of the selected text. 

• Double Strikethrough - Draws a double line through the middle of the selected text. 

• Superscript - Makes the selected text smaller and places it above the line of the text. 

• Subscript - Makes the selected text smaller and places it below the line of the text. 

• Font Color - Specifies a color for the selected text. 

• Text Highlight Color - Specifies a highlight color for the selected text. 

• Clear Formatting - Removes all formatting from the selection, leaving only plain text. 
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• Font  - Invokes the Font dialog, allowing you to adjust different font options for the selected 
text. 

 

Paragraph Group 

• Bullets - Converts the selected paragraphs into a bulleted list, or inserts a new bulleted list at 
the carriage position. 

• Numbering - Converts the selected paragraphs into a numbered list, or inserts a new numbered 
list at the carriage position. 

• Multilevel List - Converts the selected paragraphs into a multilevel list, or inserts a new 
multilevel list at the carriage position. 

• Decrease Indent - Decreases the indent level of the paragraph or the hierarchical level of the 
multilevel list's items. 

• Increase Indent - Increases the indent level of the paragraph or the hierarchical level of the 
multilevel list's items. 

• Show/Hide - Shows or hides paragraph marks and other non-printable characters. 

• Align Text Left - Aligns the current paragraph to the left. 

• Center - Centers the selected paragraphs. 

• Align Text Right - Aligns the selected paragraphs to the right. 

• Justify - Aligns the text of the selected paragraphs to both the left and right margins, adding 
extra space between words as necessary. 

• Line Spacing - Changes the spacing between the lines of the selected paragraphs. 
The amount of space added before and after the paragraphs can also be specified. 

• Shading - Specifies a background color for the selected paragraphs. 
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• Paragraph  - Invokes the Paragraph dialog, allowing you to adjust different layout options for 
the selected paragraphs. 

 

Styles Group 

• Quick Styles - Applies a style to the selected text. A style is a group of formatting options. All 
options are applied to text or a paragraph at once when you apply a style. 
Styles allow you to change text and paragraph appearance quicker than setting each formatting 
option individually. 

• Modify Style  - Invokes the Modify Style dialog, allowing you to change the formatting options 
of the selected style. 
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Editing Group  

• Find - Invokes the Find and Replace dialog that allows you to find the specified text in a 
document. 

 

• Replace - Invokes the Find and Replace dialog that allows you to find the specified text in a 
document and replace it with other text. 

 

General Tools: Page Layout 

The Page Layout toolbar contains page layout options that include paper kind, margins and orientation. 

 

Page Setup Group 

• Margins - Sets the size of page margins for the current document section.  

You can select from a list of predefined margins, or invoke the Page Setup dialog and adjust the 

margin size manually. 
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• Orientation - Sets the page orientation for the current document section. 

• Size - Sets the page size for the current document section.  
You can select one of the predefined page sizes from the list, or specify a custom page size in the 

Page Setup dialog. 

 

• Columns - Sets the number of columns for all pages in the current document section.  

You can also invoke the Columns dialog for more customization options. 
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• Breaks - Inserts one of the available breaks (e.g., page break, column break or section break) at 
the carriage position. 

• Line Numbers - Displays line numbers in the current document section. You can select one of 
the predefined line numbering types from the list, or invoke the Line Numbers dialog to define 
custom line numbering. 

 

Background Group 

• Page Color - Sets a page color for the entire document. 

General Tools: Review 

The Review toolbar contains tools related to proofreading. 
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Proofing Group 

• Spelling - Checks the spelling of the document text. On detecting misspelled words, the spell 
checker invokes the Spelling dialog to type in the correct version, or select the correctly spelled 
word from the list of suggestions. 

 

 

Chart Tools: Design 

This toolbar is context sensitive, and becomes active after selecting a chart in the document. 

 

Chart Type  

• Column - Changes the type of the selected chart to one of the available column chart types. 
Column charts are used to compare values across categories.  

• Line - Changes the type of the selected chart to one of the available line chart types. 
Line charts are used to display trends over time.  

• Pie - Changes the type of the selected chart to one of the available pie chart types. 
Pie charts display the contribution of each value to a total.  

• Bar - Changes the type of the selected chart to one of the available bar chart types. 
Bar charts summarize and display categories of data, allowing you to compare the contribution 
of each value to the total across categories. 

• Area - Changes the type of the selected chart to one of the available area chart types. 
Area charts are used to display trends over time.  
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• Other Charts - Changes the type of the selected chart to a point, funnel, financial, radar, polar, 
range, or Gantt chart. 

Appearance Group 

• Palette - Specifies the color palette for the selected chart. 

• Appearance - Applies a specified appearance to the selected chart. 
The collection of style presets available for a chart depends on the chart's palette. 

Wizard Group 

• Run Chart Wizard - Invokes the Chart wizard, which allows you to adjust the main chart settings 
in a single user interface. 

Header and Footer Tools: Design 

This toolbar is context sensitive, and becomes active after double-clicking the page header or footer in a 

document. 

 

To add a page header or footer, use the appropriate commands of the General Tools: Insert toolbar. 

Navigation Group 

• Go to Header - Allows you to switch to the page header of the current document section when 
editing a page footer. 

• Go to Footer - Allows you to switch to the page footer of the current document section when 
editing a page header. 

• Show Next - Allows you to navigate to the header or footer of the next document section. 

• Show Previous - Allows you to navigate to the header or footer of the previous document 
section. 

• Link to Previous - Makes the header or footer display the content of the header or footer of the 
previous document section. 

Options Group 

• Different First Page - Creates a unique header and footer for the first page. 

• Different Odd & Even Pages - Allows you to specify different headers and footers for odd-
numbered and even-numbered pages. 

Close Group 

• Close Header and Footer - Exits the header and footer edit mode. You can also do this by 
double-clicking the document area, or by pressing ESC. 

Picture Tools: Format 

This toolbar is context sensitive, and becomes active after selecting a picture in a document. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument4157.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument4166.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17336.aspx
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Shape Styles Group 

• Shape Fill - Fills the selected shape with a specified color. 

• Shape Outline - Applies the specified color to the outline of the selected shape. 

• Shape Outline Weight - Specifies a width for the outline of the selected shape. 

Arrange Group 

• Wrap Text - Specifies the way in which text wraps around a selected object. The text wrap 
modes are as follows: 

o Square 
o Tight 
o Through 
o Top and Bottom 
o Behind Text 
o In Front of Text. 

• Position - Specifies the position of the selected object on a page.  

• Bring to Front - Moves the selected object forward. This command invokes a drop-down menu 
that contains the following actions: 

o Bring Forward (moves the selected object one layer forward) 
o Bring to Front (moves the selected object to the front of all other objects in a 

document) 
o Bring in Front of Text (places the selected object in front of the text) 

• Send to Back - Moves the selected object backward. This command invokes a drop-down menu 
that contains the following actions: 

o Send Backward (moves the selected object one layer backward) 
o Send to Back (moves the selected object behind all other objects in a document) 
o Send Behind Text (moves the selected object behind the text).    

Connect to Data 

The topics in this section describe the various aspects of providing data to a Snap document. 

Connect a Document to a Data Source 

This tutorial describes the steps required to connect a Snap document to data by using the Create Data 

Source wizard and Query Designer. 

1. Click Data | Add New Data Source on the Snap application's ribbon toolbar. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17319.aspx
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To Use an Existing Connection 

• From the Database tab, click on the Connect to Database button. This will invoke the Set or 
Select Database Connection dialog screen as shown in the following illustration: 

 
• Move to drop down list adjacent to the Existing Application Database Connections and 

select the database connection you want to use. These connections are the same ones that 
currently setup for main program use. 

• Ensure that the Use Custom Connection checkmark is not checked.. 

To Use a Custom Connection 

• Move to and check the Use Custom Connection checkbox. 
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• Click on the Set Connection button. This will invoke the SQL Connection dialog screen as 
shown in the following illustration: 

 
• Move to the Sever name drop down box and select the name of your instance of the SQL 

server you’re using. If the server is not listed, try clicking on the Refresh button. 

• Move to the Log on to the server group and setup your log on authentication information.  
o Using SQL Express - If you are using the Express database engines as supplied by us, 

you’ll probability want to check the Use Windows Authentication option.  
o SQL Server - If you are connecting to full blown SQL Server then complete the SQL 

Server Authentication information. 
▪ Check the Use SQL Server Authentication option. 
▪ Fill in the User Name and Password fields. 

• Next move to the Connect to a database group to connect to the actual database. 
o SQL Server: 

▪ Check the Select or enter a database name option. 
▪ Move to the drop down found here and either select or enter the name of the 

database you are connecting to. 
o SQL Express: (Attached database file) 

▪ Check the Attach a database file option. 
▪ Either use the Browse button here to select the database file, or type in the full 

path to the database (mdf) file in the space provided. 

• Test Connection – Move to and click on the Test Connection button to ensure you have a good 
connect. If it fails, you may want to click on the Advanced button to further define you 
connection properties. 

2. Click on the OK button to accept and apply the connection.On the first page of the invoked 
Create Data Source wizard, specify the name for the new data source and click Next. 
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2. Once the connection is setup, click on the Data Objects tab to move to that tab. 

3. Select a data table(s) to include in the data source. 

4. Click Finish when done. 

5. After the data source has been added to the report, the hierarchy of its data members is 
reflected in the Data Explorer. 

 

The Snap report is now connected to data. Drag-and-drop the CategoryName and Description data 

fields from the Data Explorer onto the document's body to create a simple data-aware report. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17315.aspx
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Create a Master-Detail Data Source 

This tutorial describes how to add a master-detail relation to the document's data source.  

1. Connect a Snap document to data as shown in the Connect a Document to a Data Source 
tutorial. 

2. Right-click the added data source node in the Data Explorer window and select Edit Data 
Source... in the invoked context menu. 

 

3. In the invoked Query Designer window, drag the Products item from the list of available tables 
on the left and drop it onto the list of data tables to be used. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument16042.aspx
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Enable the check box for the Products table, to include all of its fields in the view. 

4. By default, the tables that are added to the query are joined. To create a master-detail relation 
between the Categories and Products tables, click the ellipsis for the Join/Relation Condition in 
the Products table. 

 

In the invoked Condition Editor dialog, set the Action type to Master-detail relation and click 

OK to exit the dialog. 
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Next, click OK in the Query Designer to apply all changes to the document data source and exit. 

The content of the Data Explorer will be updated to reflect the new structure of the 

document data source. 

 

Filter Data 

This document describes how to filter dynamic data within a Snap document. 

Filter Data on the Design Surface  

To improve performance, the Snap Design Surface displays only the first 20 data rows while the 

document layout is being designed. To change the number of data rows displayed, specify the Editor 

Row Limit option, which is located in the List tab of the main toolbar. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17311.aspx
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This setting does not affect the final document. 

Filter Data at the Data Source Level  

Filtering data at the data source level is useful when dealing with large data sources because it reduces 

data retrieval time, and thus speeds up document generation. 

To filter data at the data source level, use the Query Designer. 

 

Filter Snap List Data  

To select which data records to include in the document, click the Quick Filter command in the Field tab 

of the contextual Data Tools toolbar category. In the invoked drop-down menu, select the required 

records and click OK to apply the filtering. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17319.aspx
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To specify the filtering criteria for Snap list data, do the following. 

1. Place the text cursor inside the Snap list that you wish to filter and click the Filter command in 
the List tab of the contextual Data Tools toolbar category. 
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2. In the invoked FilterString Editor, construct the required filter expression and click OK to apply 
the filtering. 

 

Filter Mail Merge Document Data  

Filtering a mail merge document defines which data entries will appear as pages of the final document.  

To filter a mail merge document, do the following. 

1. Switch to the Mail Merge tab of the contextual Data Tools toolbar category, and click the Filter 
command. 
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2. In the invoked FilterString Editor, construct the required expression and click OK to apply the 
filtering. 

 

3. To view the result, click the Finish & Merge button in the Mail Merge tab of the contextual Data 
Tools toolbar category, and select Print Preview... in the drop-down menu. In the invoked 
Export Range dialog, select All records and click OK. 

 

The following image illustrates a print preview for a filtered mail merge document. 
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Format Data 

This document describes how to format dynamic textual data in a Snap document. 

To format report data, do the following. 

1. Select the Snap field that you wish to format. It must be a field displaying textual information 
(e.g., a Text field or a Row Index field). This will activate the Field tab in the contextual Data 
Tools toolbar category. 

2. In the Field tab, click the Properties button. 

3. In the invoked drop-down menu, click the ellipsis button for the Format String property. 

4. Specify the required formatting in the invoked FormatString Editor, and click OK to exit the 
dialog. 
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Snap supports both standard and custom .NET format strings. 

Group Data 

This document describes how to group data in a Snap document. 

To group dynamic data within a Snap list, select the field that you wish to group. This automatically 

activates the contextual Data Tools: Field tab in the main toolbar. In this tab, click the Group By Field 

button. 

http://msdn.microsoft.com/en-us/library/ee372286.aspx
http://msdn.microsoft.com/en-us/library/ee372287.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17338.aspx
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The Snap list will be updated to reflect the applied grouping. 

A group header and a group footer are automatically created for the new grouping. By default, the 

group header displays the value of the field by which to group, and the group footer displays the total 

count of entries in the group (evaluated by the Count summary function).  

To add or remove group headers and footers, use the corresponding commands in the Group tab of the 

main toolbar. 

 

The following image illustrates a Snap list with grouping applied. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17339.aspx
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All groupings added to a report are displayed in the Report Explorer as child nodes of the Snap list to 

which they are applied. 

 

Sort Data 

This document describes how to sort dynamic data within a Snap document. 

Sort Snap List Data  

To apply sorting to a Snap list, do the following. 

1. Select the Snap field that you wish to use as filter criteria. The field must be located inside a 
Snap list. This automatically activates the contextual Field tab in the main toolbar. 

2. In the Field tab, click the Sort Ascending or Sort Descending button, depending on the required 
sort order. The Snap list will automatically be updated to reflect the sorting applied. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17314.aspx
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Sort commands are also available in the context menu. 

 

You can specify multiple sort criteria for a Snap list. In this case, sort levels are applied in the order that 

they are added. 

Sort Mail Merge Document Data  

Sorting a mail merge document defines the order in which data entries will appear as pages of the final 

document. 

To sort a mail merge document, do the following. 

1. Switch to the Mail Merge tab of the main toolbar and click the Sort command. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17345.aspx
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2. Click the Add Level button in the invoked Sort dialog. Specify the sort criteria and sort order for 
the additional sort level.  

 

To change the order in which sort levels are applied to the document, use the arrow buttons. 
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Click OK to exit the dialog. 

3. To view the result, click the Finish & Merge button in the Mail Merge tab of the main toolbar, 
and select Print Preview... in the invoked drop-down menu. In the invoked Export Range dialog, 
select All records and click OK. 

 

The following image demonstrates a print preview for a sorted mail merge document. 
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Pass Parameter Values 

This document describes the main concepts for using parameters in Snap, and provides examples of 

their use in various tasks. 

Create Parameters  

You can manage the report parameters available for a Snap document using the Parameters dialog. 

To invoke the Parameters dialog, right-click the Parameters node (or any of its sub-nodes) in the Data 

Explorer and select EditParameters in the invoked drop-down menu.  

 

To invoke the Parameters dialog for a data source being edited with the Query Designer, click the 

Parameters button. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17315.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17315.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17319.aspx
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The Parameters dialog allows you to add and remove parameters using the corresponding buttons. 

Alternatively, you can add or remove a parameter by right-clicking the parameter in the Data Explorer 

and selecting the required action in the invoked drop-down menu. 

Select the newly added parameter and specify its properties in the properties grid. Be sure to specify the 

proper parameter type based on the parameter's intended use. 

 

Pass Parameter Values  

After a parameter is created, it can be used in different ways during report generation. Below is a list of 

tasks that can be accomplished using parameters. 
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• Data Binding 

To display a parameter's value in a report, drag the parameter from the Field List and drop it 

onto the Design Surface. 

 

• Filtering 

You can use a report parameter as part of a filtering expression to filter the Snap document data 

at either the report level or the data source level. 

To filter the Snap document data at the data source level, do the following. 

1. Invoke the Query Designer for the data source that you wish to filter. 

2. In the Query Designer, click the Filter button to invoke the Filter Editor. 

 

3. In the Filter Editor, construct an expression where the parameter's value is used as a 
filtering criterion. To access the parameter, click the icon on the right. It will turn into a 
question mark. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17311.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17325.aspx
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Click OK to exit the dialog. 

The SQL query generated by the query designer will be updated to reflect the specified 

filtering. 

 

In a similar way, you can use the Filter Editor to filter the Snap document data at the report 

level. In this case, to invoke the Filter Editor, click the Filter button that resides on the List tab of 

the contextual Data Tools toolbar category. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17340.aspx
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• Calculated Fields 

In addition to standard data fields, parameters can be used in expressions for calculated fields. 

The only difference is that the data field is inserted into the expression's text using its name in 

[square brackets], while a parameter is inserted using the "Parameters." prefix before its name. 

 

Use Calculated Fields 

This document describes how to use calculated fields to evaluate custom expressions based on external 

data, and embed the results into a Snap document. 

Use calculated fields to perform additional calculations on dynamic data and embed the results into a 

published document. 

To create a calculated field and access its collection, invoke the context menu in the Data Explorer. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17320.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17315.aspx
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A calculated field's expression can include conditional, date-time, mathematical and other formulas. It 

can also evaluate the values of other calculated fields, data source fields and parameters. 

 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17321.aspx
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The Expression Editor is invoked by right-clicking a calculated field and choosing the Edit Expression… 

item in the invoked popup menu. 

 

After a calculated field is inserted into a document, its value is evaluated each time the document is set 

to be published. 

Use the Query Designer 

This topic describes how to use the Query Designer to manage data tables and their relations in a Snap 

data model (e.g., to create master-detail data sources), filter incoming data and specify a custom SQL 

string. 

The Query Designer displays the structure of a connected data source along with its associated Snap 

data model. When designing a report, this data model is reflected in the Data Explorer. 

Run the Query Designer  

An option to invoke the Query Designer is provided on the last page of the Create Data Source wizard. 

The Create Data Source wizard is invoked at connecting a Snap document to a Data Source. Select the 

"Open Query Designer after closing the wizard" option before clicking Finish. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17315.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument16042.aspx
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Alternatively, you can run the Query Designer by right-clicking a data source in the Data Explorer and 

clicking Edit Data Source in the invoked menu. 

 

Manage Data Tables and their Relations  

To modify a relation assigned to a specific table, click its corresponding ellipsis button in the Snap data 

source editor. 

This invokes the Condition Editor, which allows you to include other tables in the new data relation and 

select the relation type (Inner join, Left outer join or Master-detail relation). 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17315.aspx
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The Condition Editor is automatically invoked after adding a new table to a Snap data model. 

The Query Designer highlights the tables of an external data source that is related to the tables of a Snap 

data model by one or more primary keys. 

To maintain the visibility of data columns in the Data Explorer, use the corresponding check boxes in a 

specific table's column list. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17315.aspx
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In this list, the primary key columns display a 'plus' button, which invokes a list of related tables. Clicking 

a table in this list adds it to the Snap data source. 

 

A Snap data source corresponds to an SQL query that is executed each time external data is supplied 

from a database. 

To manually customize an SQL string, enable the Allow SQL Editing option. Switching to this mode 

disables the visual features of the Query Designer in favor of the specified SQL string value. 
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Shape Data  

To assign a custom name to the selected data column, specify its Alias in the column list displayed under 

the Snap data source editor. 

 

To specify the filter criteria that is applied to incoming data, click the Filter button, which invokes the 

FilterString Editor. 
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Create a Report Layout 

Topics in this section provide information on creating reports with different layouts in Snap. 

Create a Mail-Merge Report 

This tutorial illustrates the steps required to create and publish a mail merge report with Snap. 

The tutorial contains following sections. 

• Add Dynamic Content  
• Preview and Publish the Document  

Add Dynamic Content  

To create a Snap report using a document template, do the following. 

1. Add a new Snap document and provide it with a master-detail data connection. 

2. Next, specify which data source will be used for mail merge. To do this, click the Data Source 
button on the Data Tools: Mail Merge tab and select the required data source in the invoked 
drop-down list. 

 

Alternatively, right-click the required data source in the Data Explorer and select Use For Mail 

Merge in the invoked drop-down menu. 

https://documentation.devexpress.com/#InterfaceElementsWin/CustomDocument15538/AddDynamicContent
https://documentation.devexpress.com/#InterfaceElementsWin/CustomDocument15538/Result
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument12299.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17345.aspx
https://documentation.devexpress.com/WindowsForms/CustomDocument14796.aspx
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3. To insert data bound fields into the document, drag-and-drop data fields from the Data Explorer 
onto the Design Surface. 

 

Activate the Highlight Fields option from the View tab of the main toolbar to highlight all mail 

merge fields in a document. This allows you to easily distinguish between dynamic and static 

content. 

 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17315.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17311.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17337.aspx
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4. To insert a detail report section, drag-and-drop fields from a subordinate node of the data 
source. Fields of a nested level of a mail-merge data source are inserted into a template as 
columns of a table. 
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Preview and Publish the Document  

The Snap mail merge document is now ready. To view the result, click the Finish & Merge button in the 

Mail Merge tab, and select Print Preview... in the invoked drop-down menu. In the invoked Export 

Range dialog, select All records and click OK. 

 

The following image illustrates a print preview for the final document. 

 



Maintenance Coordinator – Professional Features 

 

Simplicity Software Technologies Inc. | Create a Report Layout 178 

 

Create a Master-Detail Report 

This document will guide you through the process of creating a master-detail report. Reports of this type 

are built upon hierarchical data sources, so to be able to create a master-detail report, you need to 

provide a report data source with a master-detail relation. 

To get started with this tutorial, create a new Snap document and add a master-detail relation to it. 

Perform the following steps to create a master-detail report. 

1. Create a master report. To do this, drag-and-drop data fields of the master data table from the 
Data Explorer to the design surface. You can use any type of layout. 

 

2. To create a detail report, drag-and-drop data fields of the detail data table from the Data 
Explorer onto the lower border of the master report's data row, as shown in the image below. 

 

3. The master-detail report is now ready. Click the Print Preview button in the General Tools: File 
tab of the main toolbar to view the preview. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument12299.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17315.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17329.aspx
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Create a Table Report 

This tutorial will guide you through the process of creating a Table Report, and printing and saving it to 

your hard drive. 

The table report is a data-aware Snap report with a tabular master-detail layout.  

To get started with this tutorial, create a new Snap document and provide a hierarchical data source for 

it, as described in the Create a Master-Detail Data Source topic.  

To create a master-detail Snap document layout, do the following. 

1. Create a simple tabular report by selecting the data fields that you wish to include in the report 
in the Data Explorer and dragging them to the Design Surface. When you drop data fields onto 
the empty space in the document body, they are added as columns of a table. You can select 
multiple data fields by pressing CTRL or SHIFT. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument12299.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17315.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17311.aspx
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To improve performance, Snap shows only the first 20 data rows of a Snap list by default. To 

change this setting, use the Editor Row Limit option, which is located on the List tab of the main 

toolbar. 

 

2. To convert the layout of a Snap list to a paragraph presentation, select the Snap list you wish to 
convert and click the Convert to Paragraphs command in the List tab of the contextual Data 
Tools toolbar category. Note that there is no reverse action allowing you to convert a Snap list 
back to the tabbed form. 

 

The report should now appear as shown in the following image. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17340.aspx
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To remove a list header, select the Snap list, click the Header command in the List tab of the 

main toolbar, and select Remove Header in the invoked drop-down menu. 

 

3. To create a detail report, drag data fields from the child data table in the Data Explorer onto the 
lower border of the master report's data row, as shown in the image below. 
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The added detail part will have a tabular form by default. 

 

4. To preview your Snap document click the Print Preview button in the General Tools: File tab of 
the main toolbar. 

 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17329.aspx
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Create a Multi-Column Report 

This tutorial guides you through the creation of a Multi-Column Report. A multi-column report is a 

report which represents its data in multiple columns or rows (depending upon the current multi-column 

settings). 

To create a multi-column report, do the following. 

1. In a new Snap document, create a simple table report, as described in the Create a Table Report 
topic.  

2. In the main toolbar, switch to the General Tools: Page Layout tab, click Columns, and select the 
required number of columns in the drop-down menu. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument12455.aspx
https://documentation.devexpress.com/WindowsForms/CustomDocument15572.aspx
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To define more than three columns, click More Columns. In the invoked Columns dialog, 

customize the report layout to meet your requirements. 

 

The following image illustrates the result. 
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Create a Side-by-Side Report 

This tutorial describes the steps used to create a side-by-side report to compare different items within 

the report. 

Follow these steps to create a side-by-side report. 

1. Create a new Snap document and bind it to the required table as described in the Connect a 
Document to a Data Source topic. 

2. To add a new table to the report, switch to the Insert tab in the main toolbar and click Table. 
Then, move the cursor over the grid to select the required number of rows and columns. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument16042.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument16042.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17336.aspx
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You can set table borders by clicking the Borders button on the Design tab. 

 

3. Then, drop the fields that will be compared from the Data Explorer on the table's corresponding 
columns. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17333.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17315.aspx
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4. To filter each table column so that it shows only a single record, select a field on the left column 
and in the activated Field tab in the main toolbar, click Quick Filter. In the invoked menu, select 
the required field and click OK. 

 

Finally, repeat the same procedure for the right column, so that it displays a different 

field to compare it with. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17338.aspx


Maintenance Coordinator – Professional Features 

 

Simplicity Software Technologies Inc. | Create a Report Layout 188 

 

 

 

Create a Parameterized Report 

This tutorial illustrates the steps required to create a parameterized report. In this tutorial, we will 

create a parameter and pass it to the report's filtering expression. You are not limited by the number of 

parameters you can create, or the data type (e.g., string, date-time, Boolean, integer and double). 

Parameters can be used in other ways such as data binding and calculated fields. Tasks that can be 

solved using parameters are described in the Pass Parameter Values topic. 

Follow these steps to create a report with parameters. 

1. Create a new Snap document and bind it to the required table. 

2. To create a layout for your report, drop the required data fields from the Data Explorer to the 
Design Surface. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17321.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument16042.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17315.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17311.aspx
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3. To create a parameter, switch to the Data Explorer window, right-click the Parameters section 
and choose Add Parameter. 

 

Alternatively, you can create report parameters when editing a data source using the Query 

Designer. 

4. Right-click the created parameter and select the Edit Parameters... action in the invoked popup 
menu. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17319.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17319.aspx
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5. In the invoked editor, define the parameter name and assign an appropriate type to it. This type 
corresponds to the value that a parameter can receive (e.g., you cannot assign a string value to a 
numeric parameter). 

Next, assign a default static value to the parameter. 

 

If required, you can easily modify the parameter value in the same way described in steps 4 and 

5. 

6. Now, switch to the List tab in the main toolbar and click the Filter button. 

In the invoked FilterString editor, define a filtering expression (e.g., UnitPrice data field is 

greater than or equal to the Starting Price parameter). 

To access the parameter, click the icon on the right until it turns into a question mark, and then 

select your parameter from the drop-down list. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17340.aspx
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The parameterized report is now ready, and its data is filtered based on the specified expression that 

uses the parameter value to shape the report's data. 

To view how your report will look on paper, switch to the File tab in the main toolbar and click the Print 

Preview button. 

 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17329.aspx
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Create a Chart-Based Report  

This tutorial describes the steps used to add a chart to your Snap report. Snap supports many 

chart types, as well as multiple visual appearance settings and chart palettes. 

Snap also provides the Chart Wizard, which allows you to quickly create and customize complex charts. 

However, when advanced charting functionality is not required, Snap provides an even easier way to 

create and customize your charts. 

Do the following steps to create a chart-based report. 

1. Create a new Snap document and bind it to the required table. 

2. Click the Chart command in the Insert tab of the main toolbar. 

 

3. In the created chart, the blue circles correspond to the values and arguments of the chart. Drop 
one field from the Data Explorer onto the "values" region in the chart... 

 

...and the other onto the "arguments" region. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument4166.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument16042.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17336.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17315.aspx
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4. You can change the default chart type to one that best meets your requirements by selecting 
the chart and switching to the Design tab of the main toolbar. 

 

In the same tab, you can also run Chart Wizard and select the chart's palette and visual 

appearance. 

5. The Snap report with a chart is now ready. To view the result, switch to the File menu of the 
main toolbar and click the Print Preview button. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17341.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17329.aspx
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Create a Combined Report Layout 

Snap allows you to create a single combined report, incorporating features of different report layout 

types. There is no limits on how many reports you can combine. 

In this tutorial, we will create a combined report that uses the features of mail-merge and chart-based 

reports. 

The tutorial consists of the following sections. 

• Add Mail-Merge Report Functionality  
• Add Chart-Based Report Functionality  

https://documentation.devexpress.com/#InterfaceElementsWin/CustomDocument14332/MailMerge
https://documentation.devexpress.com/#InterfaceElementsWin/CustomDocument14332/Chart
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• View the Result  

Add Mail-Merge Report Functionality  

In this section, we will create a simple Mail-Merge Report. 

1. Create a new Snap document and provide it with a master-detail data connection. 

2. Specify which data source will be used for mail merge by right-clicking the required data source 
in the Data Explorer and select Use For Mail Merge in the invoked drop-down menu. 

 

3. Insert a master report part. To do this, drag-and-drop data fields from the Data Explorer onto 
the Design Surface. 

 

4. To insert a detail report part, drag-and-drop fields from a subordinate node of the data source. 

https://documentation.devexpress.com/#InterfaceElementsWin/CustomDocument14332/Result
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument12299.aspx
https://documentation.devexpress.com/WindowsForms/CustomDocument14796.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17315.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17311.aspx
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The added detail part will have a tabular form by default. 

 

For more information on the creation mail-merge report, see the tutorial Create a Mail-Merge Report. 

Add Chart-Based Report Functionality  

In this section we will add a Chart to the Snap document. 

1. Click the Chart command in the Insert tab of the main toolbar. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument15538.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17336.aspx
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2. In the created chart, the blue circles correspond to the values and arguments of the chart. Drop 
one field from a subordinate node of the data source onto the "values" region in the chart... 

 

...and the other onto the "arguments" region. 

 

For more information on the creation of a chart-based report, see the tutorial Create a Chart-Based 

Report. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument12452.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument12452.aspx
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View the Result  

The Snap mail merge document is now ready. To view the result, click the Finish & Merge button in the 

Mail Merge tab, and select Print Preview... in the invoked drop-down menu. In the invoked Export 

Range dialog, select All records and click OK. 

 

The following image illustrates a print preview for the final document. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument17345.aspx
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Manage Documents and Files  

The tutorials in this section will assist you in solving the most elementary and essential tasks that relate 

to managing and storing Snap documents. 

Create a New Report 

To create a new Snap report, click the New button in the File tab of the Snap application's ribbon 

toolbar. 
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A new Snap report will be created and opened in the editor.  

 

Save a Report 

To save a report to a file, click the Save button in the File tab of the Snap application's ribbon toolbar. 

 

If you are saving a new report, the Save As dialog will be invoked. In the invoked dialog, specify the 

name and directory for the new report file and click Save. 
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To save a changed copy of an existing report to a separate file, click the Save As button in the File tab of 

the ribbon toolbar. 

 

 

Storing Reports 

This document explains the basic principles of storing report documents. 

Snap provides the capability to store a report to a file and restore it. You can store the report in the 

following formats (.epub, .snx, .doc, .docx, .xml, .odt, .mht, .htm, .html, .txt, .rtf, .pdf). For more 

information about the methods that you can use for saving, loading, and exporting reports, see How to: 

Save, Load, or Export a Report. 

Open an Existing Report 

To open an existing report, click the Open button in the File tab of the Snap application's ribbon toolbar. 

 

In the invoked Open dialog, select a file and click Open. 

https://documentation.devexpress.com/WindowsForms/CustomDocument13756.aspx
https://documentation.devexpress.com/WindowsForms/CustomDocument13756.aspx
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Export a Report 

In addition to native .snx file format, Snap allows you to export reports into the one of the wide variety 

of third-party formats, (e.g., PDF, HTML or DOCX). 

To export a Snap report in a third-party format, do the following. 

1. Click the Export Document button in the File tab of the Snap application's ribbon toolbar. 

 

2. In the invoked Save As dialog, select a directory in which you want to save, specify the name 
and format of the exported file, and click Save to export the report and exit the dialog. 
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Chart Designer 

The Charts and Graphs Designer is used throughout the program to help you present graphical data. 

This designer was purchased by us as an add-on control and is very feature rich. This designer employs a 

Chart Wizard that helps with the chart creation, data, chart appearance and more. 

Ribbon Control 
The functionality of the Charts and Graphs Designer is provided via a set of Ribbon tabbed pages. 

Ribbon pages are structurally and visually split into logical groups. Each of these groups includes 

commands that perform specific functions. 

CHART TAB 

 

The following are the elements on the Chart ribbon tab, reading left to right: 

Wizard Group 

• Run Chart Wizard – Invokes the Chart Wizard. Please see the Chart Wizard section to see more 
information on this very powerful tool. 

Chart Layout Group 

• Save Chart Layout – This option allows you to save the current chart layout to file. 

• Load Chart Layout – This option allows you to load a chart layout that’s been saved to file. 

Templates Group 

• Save as Template – This is used when binding the Chart to a database source and is not fully 
implemented in this release. 

• Load Template – This is used when binding the Chart to a database source and is not fully 
implemented in this release. 

Print and Export Group 

• Print Preview – Provides a Print Preview of the current chart. 

• Print – Allows you to select a printer and other options prior to print the chart. 

• Export – Allows you to export the chart to various formats. 

Exit Group 

• Close Charts – Closes this screen 
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DESIGN TAB 

 

The following are the elements on the Design ribbon tab, reading left to right: 

Chart Type  

• Column - Changes the type of the selected chart to one of the available column chart types. 
Column charts are used to compare values across categories.  

• Line - Changes the type of the selected chart to one of the available line chart types. 
Line charts are used to display trends over time.  

• Pie - Changes the type of the selected chart to one of the available pie chart types. 
Pie charts display the contribution of each value to a total.  

• Bar - Changes the type of the selected chart to one of the available bar chart types. 
Bar charts summarize and display categories of data, allowing you to compare the contribution 
of each value to the total across categories. 

• Area - Changes the type of the selected chart to one of the available area chart types. 
Area charts are used to display trends over time.  

• Other Charts - Changes the type of the selected chart to a point, funnel, financial, radar, polar, 
range, or Gantt chart. 

Appearance Group 

• Palette - Specifies the color palette for the selected chart. 

• Appearance - Applies a specified appearance to the selected chart. 
The collection of style presets available for a chart depends on the chart's palette. 

Charting 

This section describes the capabilities provided by Charts.  

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument4157.aspx
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 Topics in this section:  

• Chart Wizard 
• Highlighting and Selection Chart Elements 
• Zoom a Chart 
• Scroll a Chart 
• Rotate a Chart 

Chart Wizard 

Use the chart wizard dialog to quickly and easily create a new chart, or modify an 

existing one. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument4166.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument4152.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument4153.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument4154.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument4155.aspx
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The Chart Wizard contains the following pages. 

Construction group 

• Chart Type Page 
• Appearance Page 
• Series Page 
• Data Page 

Presentation group 

• Chart Page 
• Diagram Page 
• Panes Page 
• Axes Page 
• Series Views Page 
• Point Labels Page 
• Chart Titles Page 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument4156.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument4157.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument4158.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument4159.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument4639.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument4160.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument4734.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument4161.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument4162.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument4163.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument4164.aspx
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• Legend Page 
• Annotations Page 

To navigate through the Chart Wizard's pages, use the navigation bar or the and 

buttons. 

To complete the chart, use the button, or the button, to cancel all changes. 

Use the "Display a wizard every time a new chart is added" option to specify whether or not a chart 
wizard should appear when you add a new chart to the windows form. 

Chart Type Page 

Tasks  

• Choose a chart type. 

Page Elements  

 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument4165.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument8455.aspx
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Chart type selector 
Contains icons representing chart types. Click an icon to choose the appropriate chart type. 

Chart type filter 
Filters chart types available in the Chart type selector. The following chart filters are available: 

• All Chart Types. 
• Bar Series (Bar, Stacked Bar, 100% Stacked Bar, Side-By-Side Stacked Bar, 100% Side-By-Side 

Stacked Bar, 3D Bar, 3D Stacked Bar, 3D 100% Stacked Bar, 3D Side-By-Side Stacked Bar, 3D 
100% Side-By-Side Stacked Bar and Manhattan Bar). 

• Point and Line Series (Point, Bubble, Line, Stacked Line, 100% Stacked Line, Step Line, Spline, 
Scatter Line, Swift Plot, 3D Line, 3D Stacked Line, 3D 100% Stacked Line, 3D Step Line and 3D 
Spline). 

• Pie Series (Pie, Doughnut, 3D Pie and 3D Doughnut). 
• Funnel Series (Funnel and 3D Funnel). 
• Area Series (Area, Stacked Area, 100% Stacked Area, Step Area, Spline Area, Spline Area 

Stacked, 100% Stacked Spline Area, 3D Area, 3D Stacked Area, 3D 100% Stacked Area, 3D Step 
Area, 3D Spline Area, 3D Spline Stacked Area and 3D 100% Stacked Spline Area). 

• Range Series (Range Bar, Side-By-Side Range Bar, Range Area, 3D Range Area). 
• Radar and Polar Series (Radar Point, Radar Line, Radar Area, Polar Point, Polar Line and Polar 

Area). 
• Advanced Series (Stock, Candle Stick, Gantt, Side-By-Side Gantt). 

Appearance Page 

Tasks  

• Choose a palette to color a series. 
• Choose the style specifying the chart's appearance. 
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Page Elements  

 

Chart preview area 
Previews a chart's layout. 

Palette Editor 
Specifies a palette to color a series. 
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Style Editor 
Specifies the style determining the chart's appearance, depending on the selected palette. 

 

Series Page 

Tasks  

• Create or remove a series of points. 
• Define the series name, visibility and view type. 
• Customize additional series options and legend point options. 
• Enable and customize the Top N Values feature. 
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Page Elements  

 

Series list  
This list displays all available series. You can click list entries to access properties of the corresponding 
series. To switch between series, use the ∧ and ∨ buttons. 

Series management buttons  
Use the Add, Copy and Remove buttons to manage the series collection. 

Main series properties  
Choose whether the selected series should be visible, define its name, and select a view type. 

Options tabs  
The following tabs are available on this page: 

• Series Options  
Specifies argument and value scale types, point sort order, visibility in legend and legend text.  



Maintenance Coordinator – Professional Features 

 

Simplicity Software Technologies Inc. | Data Page 213 

 

• Top N Options  
Specifies whether the Top N Values feature is enabled, and allows you to control this feature's 
options.  

• Legend Point Options 
Specifies the format of values displayed in the chart legend.  

Data Page 

Tasks  

• Provide data for a chart; 
• Bind a chart or individual series to a data source; 
• Customize an argument and a value scale type; 
• Customize the view type of auto-generated series; 
• Apply data filtering and sorting; 
• Adjust the Pivot Chart settings. 

Page Elements  

 

You can provide data for a chart using the following tabs. 

• Points tab 
• Series Binding tab 
• Auto-created Series tab 

Points Tab  

Use it to manually enter data points for series. 

https://documentation.devexpress.com/#InterfaceElementsWin/CustomDocument4159/PointsTab
https://documentation.devexpress.com/#InterfaceElementsWin/CustomDocument4159/SeriesBindingTab
https://documentation.devexpress.com/#InterfaceElementsWin/CustomDocument4159/AutoCreatedSeriesTab
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Note that valid Argument and Value entries must correspond to the Argument scale type and the Value 
scale type selected for the appropriate series on the Series Page. Otherwise, an error message will be 
invoked. 

Series Binding Tab  

Use it to provide specific data binding options for each series. 

 

The following illustration demonstrates how it works. 

https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument4158.aspx
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Auto-created Series Tab  

Use it to specify data columns used to generate series, as well as the series view type and other options 
like sorting, filtering and name template. 

 

The following illustration demonstrates how it works. 
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For familiar data sources (such as Pivot Grid), you can choose to automatically adjust the binding and 
layout settings of your Chart. 

And when you set a Pivot Grid as a Chart's data source, the Pivot Grid Data Source tab becomes 
available. 

 

On this tab you can adjust various Pivot Chart options. 
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Chart Page 

Tasks  

• Define a chart's background color and background image. 

Page Elements  

 

Chart preview area 
Previews a chart's layout. 

Options tabs 
The following tabs are available on this page. 

• Appearance 
Specifies a chart's background color, fill style and background image.  
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• Border 
Specifies a border's color, thickness and visibility.  

• Padding 
Specifies the diagram's inner indents.  

• Empty Chart Text 
Specifies the message displayed in the chart when there's no data to display.  

• Small Chart Text 
Specifies the message displayed in the chart, when the chart size is too small to fit the diagram.  

Diagram Page 

Tasks  

• Rotate a diagram; 
• Define a diagram's padding; 
• Add or remove secondary axes; 
• Add or remove panes; 
• Define panes' layout direction; 
• Enable or disable a diagram's scrolling and zooming. 

Page Elements  
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Chart preview area 
Previews a chart's layout. 

Options tabs 
The following tabs are available on this page. 

• General 
Choose whether a diagram should be rotated, set its padding values, and (if it contains several 
panes) define the panes' layout direction.  

• Elements 
Add or remove secondary axes and panes.  

• Scroll & Zoom 
Enable or disable a diagram's scrolling and zooming, and specify the scrolling and zooming 
options.  

Panes Page 

Tasks  

• Customize panes properties.  

Page Elements  
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Chart preview area 
Previews a chart's layout. 

Pane selector 
Specifies a pane to be customized. 

Options tabs 
The following tabs are available on this page. 

• General 
Determines whether the selected pane should be visible, specifies its name, size mode and size 
value.  

• Appearance 
Specifies a pane's background color and fill style, and its background image.  

• Border 
Determines whether a pane's border should be visible, and defines its color.  

• Shadow 
Determines whether a pane's shadow should be visible, and defines its color and size.  

• Scroll & Zoom 
Enable or disable a pane's scrolling and zooming for specific axes.  

• Scroll Bars 
If scrolling and/or zooming is enabled for an axis, adjust the scroll bars visibility, position and 
appearance.  

Axes Page 

Tasks  

• Customize axes properties; 
• Customize the appearance of axis labels; 
• Add a constant line and a strip to an axis; 
• Enable automatic and manual scale breaks. 
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Page Elements  

 

Chart preview area 
Previews a chart's layout. 

Note that you can select an axis to be modified on the chart preview area directly. 
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Axis selector 
Specifies an axis to be customized. 

Options tabs 
The following tabs are available on this page. 

• General 
Specifies visibility, position, range and format properties.  

• Appearance 
Defines color, thickness and interlacing options.  

• Elements 
Customizes title, tick marks and grid line properties.  

• Labels 
Specifies position and text for automatically created labels, or allows custom labels to be 
defined.  

• Strips 
Allows you to create strips, define their visibility, name, limits, appearance, etc.  

• Constant Lines 
Allows you to create constant lines, define their visibility, name, value, legend text, appearance, 
title, etc.  

• Scale Breaks 
Allows you to enable automatic and / or create custom scale breaks, and define their 
appearance.  

Series Views Page 

Tasks  

• Customize the view-type-specific properties of series; 
• Customize the appearance and border settings of series; 
• Add or remove financial indicators (Fibonacci indicators, trend lines and regression lines). 
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Page Elements  

 

Chart preview area 
Previews a chart's layout. 

Note that you can select a series to be modified directly in the chart preview area. 
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Series selector 
Specifies a series to be customized. 

Options tabs 
The following tabs are available on this page. 

• General 
Specifies a series bar's width, distance, color, transparency, etc.  

• Appearance 
Specifies a series color, transparency and fill style. Additionally, determines whether series 
points should be painted individually.  

• Border 
Determines whether a series border should be visible, and defines its color and thickness.  

• Shadow 
Specifies whether a series' shadow should be visible, determines its color and size.  

• Indicators 
Allows you to add or remove indicators of a required kind (Regression Line, Trend Line, 
Fibonacci Arcs, Fibonacci Fans, Fibonacci Retracement and many others).  

Point Labels Page 

Tasks  

• Resolve overlapping of point labels; 
• Customize the appearance of point labels. 
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Page Elements  

 

Chart preview area 
Previews a chart's layout. 

Note that you can select point labels to be modified directly in the chart preview area. 
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Series selector 
Specifies a series to be customized. 

Options tabs 
The following tabs are available on this page. 

• General 
Specifies whether labels should be visible and shown for zero values, determines their text and 
resolves overlapping settings.  

• Point Options 
Specifies point view, pattern and value format.  

• Line 
Determines whether label lines should be visible, and specifies their appearance.  

• Appearance 
Specifies the background color and fill style of labels.  

• Border 
Determines whether label borders should be visible, and defines their color and thickness.  

• Shadow 
Specifies whether a label's shadow should be visible, and defines its color and size.  

Chart Titles Page 

Tasks  

• Create chart titles; 
• Enable the word-wrapping for lengthy chart titles; 
• Customize the appearance and position of chart titles. 
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Page Elements  

 

Chart preview area 
Previews a chart's layout. 

Note that you can select chart titles to be modified in the chart preview area directly. 
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Titles management section 
Allows you to add or remove titles from the titles list, and choose a title to be customized. 

Options tabs 
The following tabs are available on this page. 

• Text 
Sets a text for the selected chart title. Note that the basic HTML formatting is supported for 
chart titles.  

• General 
Specifies a title's visibility, alignment and font options, and determines whether the word-
wrapping is enabled for a title.  

Legend Page 

Tasks  

• Customize chart legend's properties. 

Page Elements  
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Chart preview area 
Previews a chart's layout. 

Note that you can select the legend directly on the chart preview area. 
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Options tabs 
The following tabs are available on this page. 

• General 
Specifies legend visibility, direction, alignment, spacing, limits and margins.  

• Appearance 
Specifies legend background color and background image.  

• Marker 
Specifies visibility and dimensions of legend markers.  

• Text 
Specifies legend text antialiasing, color and font.  

• Border 
Specifies visibility, color and thickness of legend borders.  

• Shadow 
Specifies visibility, color and size of the legend shadow.  

Annotations Page 

Tasks  

• Create and customize image and text annotations. 
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Page Elements  

 

Chart preview area 
Previews a chart's layout. 

Annotation selector 
Specifies an annotation to be created and/or customized. 

Note that you can select an annotation directly on the chart preview area. 
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Options tabs 
The following tabs are available on this page. 

• General 
Specify an annotation's name, adjust its visibility, z-order and layout.  

• Anchor Point 
Choose an element to anchor to (chart, pane, or series point), and adjust the corresponding 
options.  

• Shape Position 
Choose an annotation's shape position type (free or relative), and adjust the corresponding 
options.  

• Content 
Depending on an annotation's type (text or image), specify its content.  

• Padding 
Specify an annotation's inner indents.  

• Appearance 
Adjust an annotation's background color, fill style, shape and connector options.  

• Border 
Specify visibility, color and thickness of an annotation's borders.  

• Shadow 
Specifies visibility, color and size of an annotation's shadow.  

Highlighting and Selection Chart Elements 

If you are working with 2D charts, you can highlight and select different chart elements via the mouse or 
using different gestures on your touchscreen device. 

Highlighting  

Any chart element that can be selected supports highlighting.  

An end user can highlight a chart's area using either the drag gesture on your touchscreen device or via 
the mouse pointer by hovering over a particular chart element, as shown in the image below. 
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Note  

Chart element highlighting and selection is available only for 2D Chart Types. 

Selection  

To select a particular chart element, an end user should tap it on a device supporting touchscreen or 
click this element using the left mouse button. The following image demonstrates how a constant line 
and a single series are painted if selected by an end user with the mouse pointer. 

 

https://documentation.devexpress.com/WindowsForms/CustomDocument2960.aspx
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Selectable Elements  

Chart elements which can be highlighted or selected are shown in the following illustration. 

 

 

Zoom a Chart 

If you are working with 2D XY-charts (Bar, Line, Point, etc.) or 3D charts, you can zoom in or out of a 
chart. This allows you to see some of the chart's data in greater detail, or get a more general picture of 
your data. 

Note that zooming is unavailable for 2D Pie, 2D Doughnut, Radar, and Polar charts. 

Zoom In a Chart  

To zoom in a chart, do one of the following. 

• Hold down SHIFT and click. 

After you press SHIFT, the mouse pointer is changed to . Then, move the mouse pointer to 
the chart region to be zoomed into, and click (while holding SHIFT). The magnification factor is 
300%. 

• Press SHIFT and select a region on a diagram. 
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After you press SHIFT, the mouse pointer is changed to . Then, select a zoomed region by 
dragging the mouse pointer. 

 

After releasing the left mouse button, a chart is zoomed into the bounds of the selected region 
on a diagram. 

Note  

This feature is available for 2D charts only.  

if you press SHIFT and can't zoom in anymore (the mouse pointer is changed to ), then a chart 
is already zoomed in by 100 times (10000%). This is the maximum possible zoom factor allowed. 

• Use CTRL+PLUS SIGN. 

In this case, the magnification factor is 120%. 

• Use the spread gestures on a touchscreen device. 

An end-user can zoom in a chart's diagram performing spread gestures on any device supporting 
touchscreen. 

 

• Use the mouse wheel. 

In this case, the magnification factor is 120%. 

Zoom Out of a Chart  

To zoom out of a chart, do one of the following. 

• Hold down ALT and click. 

After you press ALT, the mouse pointer is changed to . Then, move the mouse pointer to the 
region to be zoomed out, and click (while holding ALT). The magnification factor is 300%. 
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• Use CTRL+MINUS SIGN. 

In this case, the magnification factor is 120%. 

• Use the pinch gestures on a touchscreen device. 

A chart's diagram can be zoomed out by performing pinch gestures on any device supporting 
touchscreen. 

 

• Use the mouse wheel. 

In this case, the magnification factor is 120%. 

Undo Zooming  

Press CTRL+Z to return to the state before the first zoom operation in a series. 

Scroll a Chart 

You can scroll a chart if either the axis visible range is reduced or a chart is already zoomed in (its zoom 
factor is more than 100%). Since the entire chart is not visible at one time, it's possible to scroll a chart. 

Scroll a 2D Chart  

To scroll a 2D chart, do one of the following: 

• Hold down the left mouse button, and drag it. 

After you hold down the left mouse button, the mouse pointer is changed from to . Then 
drag the mouse pointer to scroll the diagram. 

• Use scrollbars. 

An end-user is able to click a scrollbar arrow, click the scrollbar near the thumb, or drag the 
thumb and move it.  

https://documentation.devexpress.com/WindowsForms/CustomDocument5803.aspx
https://documentation.devexpress.com/InterfaceElementsWin/CustomDocument4153.aspx
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In this instance, a chart's diagram is scrolled in the same way as controls in used Windows 
applications. 

• Use flick gestures on a touchscreen device. 

An end-user can scroll a diagram using flick gestures on a touchscreen device. 

 

• Use CTRL+ARROW combinations. 

When an end-user presses CTRL + LEFT, a chart's diagram is moved to the left. 
When an end-user presses CTRL + UP, a chart's diagram is moved to the top. 
When an end-user presses CTRL + RIGHT, a chart's diagram is moved to the right. 
When an end-user presses CTRL + DOWN, a chart's diagram is moved to the bottom.  

Scroll a 3D Chart  

An end-user can perform chart scrolling doing one of the following: 

• Hold down the mouse wheel button on a chart and drag it. 

After you hold down the mouse wheel, the mouse pointer is changed from to . Then drag 
the mouse pointer to scroll a chart's diagram. 

• Use CTRL+ARROW combinations. 

• Use flick gestures on a touchscreen device. 

An end-user can scroll a diagram using flick gestures.  
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Rotate a Chart 

If you are working with 3D charts, you can rotate a chart's diagram. This may be required if a chart 
displays multiple series or data points, and it's required to change the current rotation angle to view the 
chart data in detail. 

To rotate a chart control, do one of the following: 

• Hold down the left mouse button on the diagram and drag the mouse pointer. 

After holding down the left mouse button, the mouse pointer is changed from to . Then, 
drag the mouse pointer to rotate the chart. 

• Use rotation gestures on a touchscreen device. 

Touch a 3D chart's area with two fingers and move them in a clockwise or counterclockwise 
direction. 
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Forms and Permits Designer 

We are aware that many organizations require certain Forms and Permits to be used in their day-to-day 

operations. We have included what we would consider the most popular of these documents with this 

module. We also know that many of you may have other requirements, and for this reason we give you 

the ability to create your own Forms and Permits. 

 

The forms included with this module were created using this module, and should give you a pretty good 

idea of what can be done. This module uses a spreadsheet type control as its base. The cells of this 

control can be setup to use different cell types, which makes it ideal for creating forms. Cells can be set 

as normal text or edit cells, date cells with popup calendars, combo box cells where you can setup 

choices, and picture cells where you can use various image formats. 

Besides the ability of setting up and using different cell types, you also have many formatting options at 

the cell level. You can specify the fonts, fore and back ground colors, text overflow, and more. So if your 

organization can use a form tool, we are happy to be able to supply this to you with this simple to use, 

yet powerful tool. 

Ribbon Control 
The comprehensive functionality of the Forms and Permits module is provided via a set of Ribbon 

tabbed pages. Ribbon pages are structurally and visually split into logical groups. Each of these groups 

includes commands that perform specific functions. 
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HOME TAB 

 

The following are the elements on the Home ribbon tab, reading left to right: 

Clipboard Group 

• Paste - Pastes the content of the clipboard into a carriage position. 

• Cut - Cuts the selected content and places it in the clipboard. 

• Copy - Copies the selected content and places it in the clipboard. 

• Clear – Clears the contents of the selected cells. Options include: 
o Clear Data Only – Clear the cells data or text 
o Clear All – Clears both data and formatting 

Font Group 

• Font - Specifies a font for the selected text. 

• Font Size - Specifies a font size for the selected text. 

• Bold - Makes the selected text bold. 

• Italic - Italicizes the selected text. 

• Underline - Draws a line under the selected text. 

• Borders – Allows drawing borders and other attributes around selected cells. 

• Text Highlight Color - Specifies a highlight color for the selected text. 

• Font Color - Specifies a color for the selected text. 
• Font  - Invokes the Font dialog, allowing you to adjust different font options for the selected 

text. 

 

Alignment Group 

• Top – Aligns text in the selected cell at the top of the cell. 
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• Center – Vertically aligns text in the selected cells at the center of the cell. 

• Bottom – Vertically aligns text in the selected cells at the bottom of the cell. 

• Angle – Set the rotation or angle of select cells. Options include: 

o Angle Counterclockwise 

o Angle Clockwise 

o Rotate Text Up 

o Rotate Text Down 

• Left – Horizontally aligns select cell contents to the left side of the cell. 

• Horizontal Center - Horizontally aligns select cell contents to the center of the cell. 

• Right - Horizontally aligns select cell contents to the right side of the cell. 

• Word Wrap – Allows the contents of selected cell to word wrap. 

• Merge Cells – Allows cells to overflow in to adjacent cells, or merge the cells together. Options 

include: 

o Merge Across – Allows cells to overflow into adjacent cells. 

o Merge Cells – Merge selected cells, where the merge cells will act as a single cell. 

o Unmerge Cells – Unmerges the cells in the selection. 

Types Group 

• General Cell – Converts the selected cells in to the general cell type. 

• Edit Cell - Converts the selected cells in to the text or edit cell type. 

• Date Cell - Converts the selected cells in to the date cell type and allows using the built in 

calendar. 

• Picture Cell – Converts the selected cell in to a picture type and invokes a File open dialog that 

allows the cell’s image. Supported formats include: png, bmp, jpg and gif formats. 

It sometimes best to merge cells that contain picture for better results. 

• Combo Box – Set the selected cell as a combo box cell type. Also invokes the Combo box Items 

dialog that allows you to edit the contents of the combo box. 

• Numbers Cells - Converts the selected cells in to the numbers type. 

• Sum – Allows you to add the contents of selected cells, and put the sum in the last cell of the 

selected range. 

Cells Group 

• Insert – Allows the insertion of columns and rows. Options include: 
o Insert Column to the left – Inserts a column to the left of the selection. 
o Insert Row Above – Insert a row above the selection 

• Delete – Allows for the removal of columns and rows. Options include: 
o Remove Column – Removes the selected column. 
o Remove Row – Removes the selected row. 

• Format – Provides various formatting options as it applies to the entire document, or selected 
cells. 
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o Row Height – Allows you to specify the row height of selected cells. 
o Column Width – Allows you to specify the column width of selected cells. 
o Lock Cells – Allows you to lock selected cells to prevent editing. 
o Protect Documents – Protects the entire document from editing. 
o Format Cells – Invokes the Format Cells dialog screen that allows various cells selection 

formatting options. 
o Format Font – Invokes the Font dialog screen that allows formatting the font 

characteristics of the selected text or cells.  

Document Zoom Group 

• Zoom In – Zooms in on the document. 

• Zoom Out – Zooms out on the document. 

Exit Group 

• Exit Form Designer – Close and exit this module. 

PAGE LAYOUT TAB 

 

The following are the elements on the Home ribbon tab, reading left to right: 

Page Margins Group 

• Top – Allows you specify the top margin for the document. 

• Left – Allows you specify the left margin for the document. 

• Bottom – Allows you specify the bottom margin for the document. 

• Right – Allows you specify the bottom margin for the document. 

Page Setup Group 

• Orientation – Allows you to specify the print orientation of the document. Options include: 
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o Portrait 

o  Landscape 

• Page Breaks - Inserts and clears document page breaks. Options include: 

o Insert a Row Break – Inserts a page break in the currently selected row. 

o Insert a Column Break – Inserts a page break in the currently selected column. 

o Clear Selected page Break – Clears the currently selected page break. 

View Zooming 

• Zoom Factor – Selecting a value in the drop down will change the zoom factor of the current 

document. Clicking on 100% will change the view factor to 100 percent. 

Document Options 

• Gridlines View – Checking this option will show the gridlines in the current document. 

Unchecking will hide them. 

• Gridlines Print – Checking this option will print gridline from the current document. Unchecking 

will prevent the printing of gridlines. 

• Gridlines 

• Headings View – Checking this option will show the row and column headers in the current 

document. Unchecking will hide them. 

• Heading Print – Checking this option will print row and column headers from the current 

document. Unchecking will prevent the printing of headers. 

Maximum Cells 

• Columns – This value will set the maximum number of columns for the current document. 

• Rows – This value will set the maximum number of rows for the current document. 

Print Options 

• Print Center Page – Checking this option will center the document on the printed page. 

• Print Outside Border – Checking this option will include an outside border on the printed 

document. 

FORMS TAB 

 

This tab contains all the predefined forms we have included with this module. To open one of these 

forms the user just needs to click on it from within the ribbon. 

Saving a Document to File 
 You can save a finished document file for viewing later or for sharing with others.  
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• Click on the File menu. 

• Select the Save As option to expand the pop out me. 

• From the pop out menu, select the option of your choice. Options include: 

o Save as Form – Saves the current document in the native format. 

o Save as Excel – Saves the current document in the format. 

o Save as HTML Table – Saves the current in the HTML document format. 

o Save as PDF File – Saves and exports the document to the PDF format. 

• From the invoked Save Report dialog, browse to and select folder you wish to save the file in. 

• Move to the Save as type drop down and select the file type you want to save the file as. 
Supported format include: frml (native format), xls , xml and html  

• Move to the File name text box and type in a name for the file. 

• Click on the Save button. 

Opening a Saved Document 
• Click on the File menu. 

• Select the Open option. 

• From the invoked Open Setup dialog, browse to and open the folder you have the saved file 

stored in. 

• Click on the file to select it, or type its name in the File Name text box. Supported formats: frml 

(native), xls, xml and our older format of ss. 

• Click on the Open button. 

Printing the Form Document 

 

To print the document: 

• Open the File menu and click on the Print option to expand the pop out menu. 
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• Click on the print option of your choice. 

o Print Document – Select a printer, number of copies, and other options prior to printing. 

o Print Preview – Allows you to preview the document prior to printing. 

Creating a New Blank Document 
To create a new blank form: 

• Open the File menu. 

• Click the Add New option. 

Copy Cells 
This application does not copy cells into the clipboard, but rather marks cells to be copied. When a paste 

operation is used, a copy of the marked cells is copied into the new cells. 

 

To copy cells: 

• Select the cells that will be affected or copied. 

• Click on the Copy option in the ribbon. These cells will then be set for a paste operation, and 

will remain set until a new range has been selected 

Pasting Cells 
To paste cells that has been marked as copy. 

• Select the cell or cells you want to paste to. 

• Click on the Paste option in the ribbon. 

Clearing Cells 
To clear a cell or range of cells of all contents and formatting: 

• Select the cell or cells to be affected. 

• Click on the Clear option in the ribbon. 

• Next click on: 
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o Clear Data Only – Clear all data within the selected cells. 

o Clear All – Clear all data and formatting of the selected cells. 

Font Characteristics  
To setup the Font characteristics: 

• Select the cell or cells you want the formatting to effect. 

• Click on the Home tab in the ribbon. 

• Move to the Font group in the ribbon and select the formatting options of your choice. 

Format Font Dialog 
There is a Font Dialog screen that can be used to format fonts or selected text. To use this option: 

 

• Select the cell or cells you want the formatting to effect. 

• Click on the Home tab in the ribbon. 

• Move to the Font group in the ribbon and click on the down arrow button  in the group’s title 
section, or. 

• Click on the Format button in the ribbon to invoke the drop down. 

• Click on the Format Font option. 

• Move through the various option of the Font dialog, and set up the characteristics you want to 
apply. 

• Click on the OK button when done. 

Cells Alignment 
You can set the alignment of a cell’s contents by: 
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• Select the cell or cells you want the formatting to effect. 

• Click on the Home tab in the ribbon. 

• Move to the Alignment group in the ribbon and select the alignment options of your choice. 
o Top – Aligns text in the selected cell at the top of the cell.  

o Center – Vertically aligns text in the selected cells at the center of the cell. 

o Bottom – Vertically aligns text in the selected cells at the bottom of the cell. 

o Angle – Set the rotation or angle of select cells. Options include: 

▪ Angle Counterclockwise 

▪ Angle Clockwise 

▪ Rotate Text Up 

▪ Rotate Text Down 

o Left – Horizontally aligns select cell contents to the left side of the cell. 

o Horizontal Center - Horizontally aligns select cell contents to the center of the cell. 

o Right - Horizontally aligns select cell contents to the right side of the cell. 

o Word Wrap – Allows the contents of selected cell to word wrap. 

o Merge Cells – Allows cells to overflow in to adjacent cells, or merge the cells together. 

Options include: 

▪ Merge Across – Allows cells to overflow into adjacent cells. 

▪ Merge Cells – Merge selected cells, where the merge cells will act as a single 

cell. 

▪ Unmerge Cells – Unmerges the cells in the selection. 

Insert a New Blank Column into your Document 
To insert a new blank column into your document: 

• Select a column in the document just after the insertion point of the new column. 

• Move to the Home tab in the ribbon and click on the Insert option. 

• From the drop down, select the Insert Column to the Left option. 

Insert a New Blank Row into your Document 
To insert a new blank row into your document: 

• Select a row in the document just below the insertion point of the new row. 

• Move to the Home tab in the ribbon and click on the Insert option. 

• From the drop down, select the Insert Row Above option. 

Delete a Column in your Document 
To remove a column in your document: 

• Select or click within the column you want to remove. 

• Move to the Home tab in the ribbon and click on the Delete option. 
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• From the drop down, select the Remove Column option. 

Delete a Row in your Document 
To remove a row in your document: 

• Select or click within the row you want to remove. 

• Move to the Home tab in the ribbon and click on the Delete option. 

• From the drop down, select the Remove Row option. 

Assigning Cells as General Type 
General Type cells can contain normal, general type of information such as numbers or text. To assign 

cells of this type: 

• Select the cell or cells you want the assignment to effect. 

• Click on the Home tab of the ribbon, locate the Types group. 

• Click on the General Type option.  

Assigning Cells as the Edit (text) Type 
Edit cells are used to display and accept text. To assign cells of this type: 

• Select the cell or cells you want the assignment to effect. 

• Click on the Home tab of the ribbon, locate the Types group. 

• Click on the Edit Type option.  

Edit Cell Editor 

 

When assigning a cell as a Edit Cell, it will invoke a Text Cell Editor dialog. This editor can also be called 

up by: 

• Clicking in a cell that has been assigned as an Edit Cell. 

• Click on the Home tab of the ribbon, locate the Types group. 
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• Click on the Edit Type option.  

You can also use the shortcut key assignment of Ctrl+Shift+T to both invoke the editor and 

assign the cell as the Edit Type. 

With the Editor you can: 

• Move to the text box located here and type in or edit your text. 

• Click on the Accept button when done. 

Assigning Cells as the Date Type 
Date cells are used to display date values and also have an attached calendar. To assign cells of this type: 

 

• Select the cell or cells you want the assignment to effect. 

• Click on the Home tab of the ribbon, locate the Types group. 

• Click on the Date Type option.  
You can invoke the build-in calendar by double mouse clicking the date cell. 

 

Assigning Cells as the Picture Type 
Picture cells are used to display images. To assign cells of this type: 

• Select the cell or cells you want the assignment to effect. 

• Click on the Home tab of the ribbon, locate the Types group. 

• Click on the Picture Type option.  
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• From the invoked Open Setup dialog, browse to and open the folder you have the saved file 

stored in. 

• Click on the file to select it, or type its name in the File Name text box. Supported formats 

include: png, bmp, jpg and gif formats. 

It sometimes best to merge cells that contain pictures to obtain better results. 

• Click on the Open button. 

Assigning Cells as the Combo Box Type 
Combo Box cells are used to assign lists of data in which a user can select from. To assign cells of this 

type: 

• Select the cell or cells you want the assignment to effect. 

• Click on the Home tab of the ribbon, locate the Types group. 

• Click on the Combo Box Type option.  

 
• At the time a cell is assigned as a combo box type, the Combo Box Items dialog box will be 

invoked allowing you to add items to the list. 

Adding Items to a Combo Box Cell 
Once setup, you can add list item to the combo box by: 
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• Click on the Combo Box type cell in the document. 

• Move to the Home tab in the ribbon and click on the Combo Box Type option. 

ADD ITEMS 

• From the invoked Combo box Items dialog box, click on the Add New. 

• From the invoked Add Item Type in the new item in the space provided and click OK. 

• Repeat the above two steps for each item you want to add. 

REMOVE ITEMS 

• To remove items from the list, click on the item from within the list to select it. 

• Move to and click on the Remove button. 

WHEN DONE 

• When you’re done editing the items list, click on the Accept button. 

Assigning Cells as the Number Type 
Number cells are used to hold numeric data. To assign cells of this type: 

• Select the cell or cells you want the assignment to effect. 

• Click on the Home tab of the ribbon, locate the Types group. 

• Click on the Number Type option.  

Auto Sum Cells  
If you have numeric information within your document, and you would like to add this information 

together and provide a total, please follow these steps. 

• Select all the cells in the document that you want to add together, either by row or column. 
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• Continue the cells selection stopping at an empty cell just beyond the ones you want added 
together. 

• Move to the Home tab and locate the Types ribbon group. 

• Click on the Auto Sum option.  

• The total of the selected cells with be inserted into the last cell of the selection range. 

Setting Row Height 
You can set the height of multiple rows at once by: 

• Select the rows that you want to adjust the height on. 

• Move to the Home tab in the ribbon and click on the Format option. 

• Click on the Row Height option. 

• From the invoked input screen, enter the new value in the space provided and click OK. 

Setting Column Width 
You can set the width of multiple columns at once by: 

• Select the columns that you want to adjust the width on. 

• Move to the Home tab in the ribbon and click on the Format option. 

• Click on the Column Width option. 

• From the invoked input screen, enter the new value in the space provided and click OK. 

Lock Cells from Editing 
You can lock selected cells from being edited. To lock cells: 

• Select the cells you want to lock. 

• Move to the Home tab in the ribbon and click on the Format option. 

• Click on the Lock Cells option. 

Protect Document from Editing 
You can lock form document from being edited. To lock the document: 

• Move to the Home tab in the ribbon and click on the Format option. 

• Click on the Lock Cells option. 

Format Cells 
There is a Format Cells Dialog screen that can be used to format properties of selected cells. To use this 

option: 
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• Select the cell or cells you want the formatting to effect. 

• Click on the Design tab in the ribbon. 

• Move to the Cells group in the ribbon and click on the down arrow button  in the group’s title 
section, or. 

• Click on the Format button in the ribbon to invoke the drop down. 

• Click on the Format Cells option. 

Cell Borders 
The options in this group allow you to setup the border to be applied to the select cells. You can set the 

borders to be applied by clicking on the icons that surround the center illustration. You can also click in 

the center illustration to set or remove cell borders. 

Line Style 
To set the Line Style to be applied by the cell borders, click on an option from the Line Style combo box. 

Line Thickness 
To set the Border Thickness to be applied by the cell borders, click on an option from the Thickness 

combo box. 

Border Color 
To set the color to be applied to the cells borders: 
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• Click on the Set Color button found in the Cell Borders group. 

• Click on the color you want to apply from those shown. 

• Click on the OK button. 

Cell Colors 
Options found in this group allow you to specify the Text and Fill Colors for the selected cells. To set 

these values: 

• Click on the Set Color button found near the color you want to set. 

• Click on the color you want to apply from those shown. 

• Click on the OK button. 

Applying Your Settings 
To have the settings you’ve made with dialog applied to the selected cell or cells: 

• To use your border settings, check the Use Defined Border check box. 

• To use your cell color settings, check the Use Defined Colors check box. 

• To lock the cells to prevent cell editing, check the Lock (Protect) Cells checkbox. 

• Click on the Accept button. 

Setting Up Your Printed Page Margins 
You can define the page margins of your document by: 

• Move to the Page Layout page in the ribbon and locate the Margins group. 

• Move to the various text boxes in the group and type in the values you want to assign.  Options 

include: 
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o Top – Allows you specify the top margin for the document. 

o Left – Allows you specify the left margin for the document. 

o Bottom – Allows you specify the bottom margin for the document. 

o Right – Allows you specify the bottom margin for the document. 

Print Orientation 
You can specify the page print orientation of your document by: 

• Move to the Page Layout page in the ribbon and locate the Page Setup group. 

• Click on the Orientation option to expand the drop down. Click one of the following options: 

o Portrait 

o  Landscape 

Insert Page Breaks 
Page breaks can be used to force the start of a new page in the printed document to set a page break: 

• Select an area in your document where your want the page break to be applied at. 

• Move to the Page Layout page in the ribbon and locate the Page Setup group 

• Click on the Page Breaks option to expand the drop down. Click on the option of your choice: 

o Insert a Row Break – Inserts a page break in the currently selected row. 

o Insert a Column Break – Inserts a page break in the currently selected column. 

Clearing a Page Break 
To remove a manually applied page break: 

• Select the area in your document that contains a manual page break. 

• Move to the Page Layout page in the ribbon and locate the Page Setup group. 

• Click on the Page Breaks option to expand the drop down. 

• Click on the Clear Selected page Break option. 

Printing and Viewing Grid Lines 
You have the ability to toggle the display and printing of grid lines in your document. To either hide or 

display this element in your document: 

• Move to the Page Layout page in the ribbon and locate the Document Options group. 

• Under the Gridlines heading you have two options: 

o View – When checked gridlines are visible on the current document. 

o Print – When checked gridlines are printed. 
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Printing and Viewing Headings 
You have the ability to toggle the display and printing of row and column headers in your document. To 

either hide or display this element in your document: 

• Move to the Page Layout page in the ribbon and locate the Document Options group. 

• Under the Headings  title you have two options: 

o View – When checked headers are visible on the current document. 

o Print – When checked headers are printed. 

Maximum Cells 
You can adjust the document size or design surface by specifying the number of columns and rows to 

include in your document. To specify these values: 

• Move to the Page Layout page in the ribbon and locate the Maximum Cells group. 

• Type in the values you want to assign by typing in the available fields. Options include: 

o Columns – Adjusts the number of columns in your document. 

o Rows – Adjusts the number of rows in your document. 

Center Your Printed Document 
You can specify that your printed document be centered on the printed page. To set this value: 

• Move to the Page Layout page in the ribbon and locate the Print Options group. 

• Check the Print Center Page checkbox. 

Include an Outside Border on the Printed Document 
If you would like to include an Outside Border around your printed document: 

• Move to the Page Layout page in the ribbon and locate the Print Options group. 

• Check the Print Outside Border checkbox. 

Accessing the Built-in Forms 
To access and open the included built-in forms: 

• Move to the Forms tab in the ribbon. 

• Click on the option that best describes the form you want to open. 
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Project Planner 

The Project Planner module was included with the Maintenance Coordinator program to provide you 

manager types out there with a means of managing your occasional projects. If your normal duties 

require a great deal of project administration, this module will more than likely be too limited for your 

use. But if you only have occasional projects to manage, such as those a maintenance supervisor might 

encounter, you may find this module of value, and save you from having to purchase a more costly and 

more complicated system. 

 

With this module you can create a single day, divided by half-hour intervals projects, or ones lasting 

months. An example of a single day project could be something like laying out duties for a single day 

plant shutdown. Allowing you to assign tasks to different individuals and making start and end time 

assignments. Where the other maybe to planning a new production line, where you would plan when 

each phase would commence and end. 

Ribbon Control 
The functionality of the Forms and Permits module is provided the Ribbon control. Ribbon pages are 

structurally and visually split into logical groups. Each of these groups includes commands that perform 

specific functions. 
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The following are the elements on the Home ribbon tab, reading left to right: 

• New Project – Creates a new project and invokes the Project Properties dialog where you can 

specify the setup for the new project. 

• Project Setting – Invokes the Project Properties where you modify the settings used by the 

current project. 

• Project Report – Creates a report based on the current project. 

• Print Document – Allows you to print the current project. 

• Print Preview – Provides a Print Preview of the current project. 

• Add-Edit Task – Invokes the Task Editor where you can specify the specifics of a task.  

• Delete Task – Allows you to remove a task. 

• Insert Task – Allows you to insert a task between existing tasks. 

• Move Up – Moves the selected task up one position per click. 

• Move Down – Moves the selected task down one position per click. 

• Day Project – Toggles the Display of task scheduling. 

• Zoom In – Zooms in on the current document. 

• Zoom Out – Zooms out on the current document. 

Quick Access Toolbar 

 

The following are the elements of the Quick Access Toolbar located above the ribbon. 

• File Open – Invokes the file open routines. 

• Save As – Invokes the Save routines. 

• Exit – Allows you to close and exit the Project Planner. 

Main Designer Elements 
The following illustration shows the main elements of the Project Planner’s main design surface. 
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The following illustration shows the added items displayed when using the View Date/Assignment 

(Days Project) option. 

 

Project Planner File Menu 
The following is an outline of the elements of the Project Planner’s File menu: 

 

• Open – Opens a project saved to file. 

• Save – Saves the project with the current file attributes. 

• Save As – Allows you to specify different fil name, path and export options. Options include: 

o Save as Project File 

o Save as Excel File 

o Save as HTML 

o Save as PDF File. 

• Print Options – Provides the following print options: 

o Print Document 

o Print Preview 

• Exit Planner – Close and exit the Project Planner 
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Creating a New Project 
The first task you'll be required to perform in the use of this module will be the process of creating a 

new project. The steps to perform this task will be outlined next. 

• Click on the New Project option in the ribbon. 

 

• Move to the Project Title text box and type a brief description of the project you are planning. 

• Move to the Project Type area and select the project type option that best fits the project you 

are creating. The following options are available: 

o Single Day / Timed Project – This option allows for a project that will be completed in a 

single day, and broken into half-hour intervals. 

o Multiple Days Project – This option allows for the creation of a multiple days or even a 

project lasting months. The project intervals are broken into days. 

o Multiple Days / Hide Weekends – This option is the same as the above option, except 

weekends are hidden. 
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Single Day / Timed Project 

• If you choose a Single Day type project, move to the Single Day – Time Span group and setup 

the Start Time and End Time of the project. Setup these times by clicking on them from within 

the drop down list boxes. 

Multiple Days Project 
• If you choose one of the Multiple Days projects you need to move to the Multiple Days – Day 

Span group and setup the Start Date and End Date of your project. Select these dates by using 

the attached drop down calendars. 

Finish the Setup 

• Project Notes - Move to the Project Notes section and record any notes you wish to record 

about the current project. 

• Accept - Once everything is setup on this dialog to your preferences, click on the Accept button 

to create your new blank project. 

Edit Project Settings 
Once a project has been setup you are limited as to how much of this setup you can change. For Single 

Day projects, all you're allowed to change is the Project Title and the Project Notes. For either of the 

Multiple Days Projects, you can also edit the Day Span (date range) of the project. 
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To edit a project’s settings please follow these steps: 

• Click on the Project Settings option in the ribbon. 

• Move to the Project Title and Project Notes sections and edit these fields to your preference. 

• If this is a Multiple Days Projects, you can also edit the Start Date and End Date fields. 

Note: Changing either date in the range will required the project to reload. 

• Click on the Accept button to accept and apply your changes. 

Sorry, but the time range settings or project type settings cannot be changed for pre-existing projects. 

Entering and Editing Tasks 
Once a project has been created, you can then add or edit the tasks within that project. To edit tasks 

please follow these steps: 

 

• Move to the row in the designer’s grid that you want to add or edit a task, and double mouse 

click in the left most column of that row. You can also choose the Add-Edit Task option in the 

ribbon. This action will bring up the Task Editor screen. 

• Move to the Task Description field and type in a brief description of the task. You can enter a 

somewhat more descriptive description in the Notes section on the Resources / Notes tab. 

• Move to the Schedule Start and End Dates or Schedule Start and End Times sections, 

depending on your project type, and setup the appropriate criteria for the current task. 

• Either click on the Next button, or click on the Resources/Notes tab. 
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• Move to the Resource Assignments section and type in the names that you are assigning to the 

task. You can do this for up to three assignments. 

• Move to the Task Notes section and type whatever information here you wish to record about 

the current task. 

• Either click on the Next button, or click on the Completion tab. 
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• Move to the Completion Tracking group, and using the spin type editor here, record how much 

you estimate the task has been completed. 

• Move to the Completion Notes group, and record any completion notes you want to maintain. 

• Either click on the Next button, or click on the Time Line tab. 

 

• Move the Fill Color, and use the color picker control to assign the fill color of the task. This is 

accessible by clicking on the down arrow attached to it.   

• Move to the Fill Anchor Graphics list box. 

• Scroll through the available images and click on the image you want to assign as the task anchor. 

• Click on the Accept button when done. 

• The task should now show up on the main design screen filling the time slot range that you have 

just setup. 

Inserting a New Task between Existing Tasks 
To insert a New Task just above an existing task: 

• Move to the row in the designer’s grid just below where you want to insert the new task. 

• Move to the ribbon and click on the Insert Task option to expand its drop down. 

• Click on the Insert Task Above option. This action will bring up the Task Editor screen as 

previously outlined. 
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Delete a Task 
To remove an existing task in your project: 

• Click in the row that contains the task you want to delete. 

• Click on the Delete Task option in the ribbon. 

• When prompted about the deletion, click the Yes button 

Change a Tasks Position in the Designer 
You can change a tasks position as it is displayed in the Project Planner Designer. You have the ability to 

either move the task up one position at a time or move it down one position at a time. 

 

To move a task: 

• Move to the Tasks Designer and click in the row that contains the task you want to move. 

• Move to the ribbon and select either the Move Up or Move Down options. 

Viewing Date/Assignment Information in the Designer 
For multiple day types of projects, you can view assignment information within the designer. This 

includes the first resource assignment and scheduled start and end dates. 

 

To display the assignment information in the designer: 

• Click on the Days Project option in the ribbon to expand the dropdown. 

• Click on the View Date/Assignment option 

To hide the assignment information in the designer: 

• Click on the Days Project option in the ribbon to expand the dropdown. 

• Click on the View Date/Assignment option 
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Tracking a Task Completion 
To track the completion of a given task: 

 

• Move to the row in the grid that contains the task you want to work with and double mouse 

click in the left most column of that row. This action will bring up the Task Editor dialog screen. 

• Move to and click on the Completion tab.  

• Move to the Completion Tracking group, and using the spin type editor here, record how much 

you estimate the task has been completed. 

• Click on the Accept button when done. 

Project Report 
The Project Report will supply you with a summary of the project’s setup, along with a summary of each 

of its tasks. 
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 To generate a Project Report: 

• Click on the Project Report option in the ribbon. 

Print Preview 
To receive a print preview of your project: 

• Click on the File menu. 

• Expand the Print Options menu and select the Print Preview option. 
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Printing Your Project 
To send a copy of your project to your printer: 

• Click on the File menu. 

• Expand the Print Options menu and select the Print Document option. 

Saving a Project File 
You can save a finished document file for viewing later or for sharing with others.  

• Click on the File menu. 

• Select the Save As option to expand the pop out menu. 

• From the pop out menu, select the option of your choice. Options include: 

o Save as Project File – Saves the current document in the native format. 

o Save as Excel – Saves the current document in the Excel format. 

o Save as HTML Table – Saves the current document in the HTML document format. 

o Save as PDF File – Saves and exports the document to the PDF format. 

• From the invoked Save Project dialog, browse to and select the folder you wish to save the file 
in. 

• Move to the Save as type drop down and select the file type you want to save the file as. 
Supported format include: ppr (native format), xls , xml and html  

• Move to the File name text box and type in a name for the file. 

• Click on the Save button. 

Opening a Saved Document 
• Click on the File menu. 

• Select the Open option. 

• From the invoked Open Setup dialog, browse to and open the folder you have the saved file 

stored in. 

• Click on the file to select it, or type its name in the File Name text box. Supported formats: ppr 

(native format). 

• Click on the Open button. 

View Zooming 
You can change the zoom of the currently loaded document by: 

• Move to the ribbon and click the Zoom In option to zoom in on your document. 

• Move to the ribbon and click the Zoom Out option to zoom in on your document. 
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Issue Tracking Modules 

With the Issues Tracking feature you can keep a complete record of what all your production and 

maintenance people are doing. The way this system was planned is to make a computer available for 

your employees. As they encounter issues, they come to this computer and log in whatever they may 

have encountered. In this fashion, other personnel, on perhaps other shifts, can review reports and gain 

insight on how things have been going. A person that has knowledge of what was done before they 

became involved with a specific issue will be much better prepared to resolve that issue. 

 

If used right and in a consistent manner, this module can be proven to be an outstanding maintenance 

tool. After just a few weeks of data entry, you will be able to pin point problem areas, and recurring 

issues. This will help guide you into the proper direction, allowing you to place resources where they are 

most needed, making the work that is performed return greater results. 

You may be saying to yourself right now that your employees don't have the time to be sitting in front of 

a computer all day. Well, this program doesn't require them to.  If they go and log in their issues as they 

are encountered, they should only need a couple of minutes per issue, and this time shouldn't even be 

noticed, but the benefits gained will surely be noticed. We have also made it so these employees can 

reuse the same data over and over by providing quick entry routines, decreasing the time needed for 

data entry. 

The following flow chart illustrates one way the Issues log can be used to benefit your company. 
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Differences between Maintenance and General Issues 
The procedures outlined in this chapter work equally well for both Maintenance and General Issues. In 

fact these two modules are actually the same module, just filtered differently. It would be perfectly 

acceptable to have all your employees use just one type of reporting. But many have found it useful to 

keep the two separate for a variety of reasons. The choice is totally yours and your organization. 

Ribbon Control 
The comprehensive functionality of the Issues Tracker is provided via a set of Ribbon tabbed pages. 

Ribbon pages are structurally and visually split into logical groups. Each of these groups includes 

commands that perform specific functions. 

HOME TAB 

 

The following are the elements on the Home ribbon tab, reading left to right: 

• Add New – Creates a new issue record through the use of a wizard, or directly on screen. 

• Save Changes – Saves all current changes from all elements of a record (master save). 

• Print Record – Allows you to select a printer and other options prior to printing the record. 
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• Quick Print – Sends a copy of the printed record directly to the default printer. 

• Print Preview – Allows you preview the current record prior to printing it. 

• Mail Issue – Opens the Email Composer with the current issue as an attachment. 

• Mail Work Assignmeny – Opens the Email Composer with the current issue as an attachment 

and in the form of a Work Assignment. 

• Filter Wizard – Launches the Custom Filter Wizard dialog that allows specific criteria to be setup 

to filter the database by. See the section on the Issues Wizard for more information. 

• Default Filter – Reapplies the default filtering for the issues database. 

• Urgent Issues – Filters the database by open issues, and a priority of Urgent. 

• Open Issues – Filters the database by all open issues, regardless of priority. 

• Show All – Shows all issues regardless or priority or status. 

• Search - Search – Invokes the search routine on the Lookup Grid as explained in the Common 

Features chapter 

• Exit Module – Exits and closes this module. 

REPORTS TAB 

 

The following are the elements on the Reports ribbon tab, reading left to right: 

• Master Summary – Invokes the Master Summary Report wizard that steps you through the 

reports creation. 

• Issues Wizard – Invokes the Issues Report Wizard that steps you through the creation of an 

Issues report. 

• Down Time Report - Invokes the Issues Report Wizard that steps through the creation of a 

Down Time Report. 

• Status Report – Invokes a Status Report wizard that allows the generation of a report and on a 

single issues type, or all types. 

• Parts Usage Report – Allows you to report on Issues Parts usage for a date range. 

• Top Ten Issues – Invokes the Issues Wizard that allows you to find the Top 10 issues with 

specific criteria. 

• Counts and Issues – Creates reports that show issues within a date range, along with production 

counts. Options include: 

o 7 Days 

o 14 Days 

o Month 
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• Work Assignments – Allows you to create and print work assignment, which are a lot like work 

orders. Options include: 

o Print Current Issue – Creates and print a work assignment for the currently selected 

issue. 

o Date Ranges – Creates and prints work assignments for a date range of issues. 

• Predictive Maintenance – Creates a predictive Maintenance Report based on past issues.  

Issues Module Setup 
This module has a few Settings that apply only to Issues Tracking. These settings will be outlined next: 

• To access the Issues Module Setup: Open the File menu and select the Module Settings options. 

 

• Next Issue Number - The number here specifies the next sequential number to used when a 

new issue is added. You can reset this number by typing in a new value in the space provided. 

• Use the Date Prefix – Checking this checkbox will have the application add a date prefix to the 

issue number. These numbers use the following format: yymm – xx. Where yy equals the year of 

the issue creation, mm equals the month of issue creation, and xx is a sequential number. 

• Use Issue Auto Email – When checked, the program will email a notice that a new issue was 

added to the database. 

• E-Mail Address – This is the email address that a new notice will be sent to. 

• Issue Status – This setting tells the program which types of issue to send notices out for. Options 

include: 

o All Open Issues 

o Urgent Issues Only 

• When done editing the settings with your preferences, move to and click on the Accept button. 
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Features of the Issue Tracking Module 
There are many features of the Issue Tracking module, with the majority of these features found on 

either the tabbed pages found here, or within the tabbed ribbon control. We are going start by 

explaining the use of these features as we move through the tabbed pages. 

Lookup Tab 
This tab helps in locating issues by grouping, filtering and sorting them. All the issues in the current filter 

are located in the grid found here. To select an issue and make it the active record, the user needs only 

to click on the issue from within the grid. Once selected the user can click on the other tabs to view or 

edit the issue itself. Also note that double clicking on an issue will move you to the Details tab showing 

the selected record. 

The following image illustrates the features available on the Lookup tab: 

 

The functions of the Lookup tabs are used through-out the system and are fairly common regardless of 

the modules that use them. Please review the chapter on Common Features to read about the 

functionality of the controls located on this tab. Give special attention to the following: 

• Using the Lookup Grids 

• Searching 

Details Tab 
The Details Tab is used to report specifics about the issue being tracked. 

Reporting Information 
This section allows you to maintain general information as it applies to the issue. This includes 

identification information, date and time of the issue, and who reported the issue. 

The following image illustrates the elements of the section: 
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Reference 
This field is generation for you by the application and is used to help identify the issue record. These 

numbers use the following format: yymm – xx. Where yy equals the year of the issue creation, mm 

equals the month of issue creation and xx is a sequential number. 

Date of Issue 
This is a date only field and is used to indicate the date the issue occurred. To set this value: 

• Click on the down arrows attached to the field. 

• Click the value you want to use from the drop down calendar. 

Time of Issue 
This is a time only field and is used to indicate the time the issue occurred. To set this value: 

• Click in the field and either type in the value, or use the attached arrows to increase or decrease 

the values displayed. 

Reported By 
This alpha/numeric field will accept up to 40 characters and represents the person reporting the issue. 

You can either type in this information or click on the adjacent Select button to invoke the Employee 

Database dialog. Once the lookup dialog is invoked, select the employee record and click Select. 

Shift or Crew 
This alpha/numeric field will accept up to 25 characters and represents the crew the person reporting 

the issue belongs to. 

Down Time Recording 
This section allows you to maintain downtime information on the current issue.  

The following image illustrates the elements of the section: 
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Down Time Hours 
This numeric only field is used to record the downtime hours as it related to the current issue. You can 

either type in this information or use the spin buttons attached to it. 

Down Time Minutes 
This numeric only field is used to record the downtime minutes as it related to the current issue. You can 

either type in this information or use the spin buttons attached to it. 

Issue Specifics 
This section is used to maintain specifics as it relates to the issue being recorded. Important note about 

this section: The Problem – Issue lists are based on the assigned asset. This is to say that as the assets 

are changed, the contents of the drop down and pop-up lists will also change. The reason for this is that 

an item like ‘Transmission leaking” does not apply when the assigned asset is a conveyor. 

Also you should reuse the same Problem – Issue assignment as often as possible. This will help in pin 

pointing problem areas when used with reporting. You will be able to record more specific details in the 

Reported Issues Details section. 

The following image illustrates the elements of the section: 

 

Line or System 
This alpha/numeric field with accept up to 40 characters and is used to specify the system this issue 

relates to. You can either type in this information or select an item from the drop down list. 

Asset 
This field can only be set by selecting an Asset or Equipment record from Equipment and Assets list. To 

set this field: 

• Click on the Select button adjacent to the field. 

• Select the asset record you want to assign from those listed, and click on the Select button. 



Maintenance Coordinator – Professional Features 

 

Simplicity Software Technologies Inc. | Contact Information 276 

 

Problem – Issue 
This field is used to specify a General type issue assignment. When assigning issues you want them to be 

rather general in nature (for reporting purposes). You'll have a chance to be more descriptive in the 

Reported Issues Details section. 

The following are examples of possible (recommended) types of issues: Transmission Problem, Chain 

Issues, Gearbox Issue, Motor Problems, and so on. 

• To set the value of this field, select the value from the drop down list. Directly typing in this field 

is not supported. 

Classification 
This field allows you to add a Classification assignment to the reported issue, and can be used much line 

the Problem – Issue field just outlined. This list does not change however with the assigned asset. 

• To set the value of this field, select the value from the drop down list. Directly typing in this field 

is not supported. 

Priority 
This field allows you to assigns a priority or importance indicator to the issue. To set this value just select 

the assignment from the drop down list. Options include: 

• Issue Resolved 

• Information Only 

• Needs Attention 

• Urgent Issue 

Contact Information 
This section allows you to record contact information as it relates to the issue. The information is 

important when you need more information about the issue, or you want to provide the contact with 

updated information. 

The following image illustrates the elements of this section: 

 

Contact Name 
This alpha/numeric field with accept up to 40 characters and represents the name of the contact. 



Maintenance Coordinator – Professional Features 

 

Simplicity Software Technologies Inc. | Reported Issue Details 277 

 

Phone 
This alpha/numeric field with accept up to 20 characters and represents the contact’s phone number. 

E-Mail 
This alpha/numeric field has no size limitation and represents the contact’s email address. 

Select Contact 
Clicking this button will invoke the Employees Database dialog, where you can select and assign an 

employee to the Contact Information area. 

Reported Issue Details 
This section allows you to record details about the issue. The following image illustrates the elements of 

the section: 

 

Edit Area 
There is no size limitation to the field and is used to provide details about the issue. This information can 

also be edited using the build text editor. This editor is invoked by clicking on the Edit Details button. 

Open Issue Tab 
This tab deals with the handling of open issues. When an issue's status has been marked as either Needs 

Attention or <<URGENT ISSUE>>, and the Completed flag has not been set, the program treats these 

issues as being open. 

Assignments – Resolved 
This section allows for the assignments of open issues, and also the recording of issue completion 

information. 

The following image illustrates the elements of the section: 
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Manager 
This field represents the Manger assigned to oversee the completion of the issue. To set this field: 

• Click on the Select button adjacent to the field. 

• Select the employee record you want to assign from those listed, and click on the Select button. 

Assigned To 
This field represent the employee or mechanic assigned to resolve the current issue. To set this field: 

• Click on the Select button adjacent to the field. 

• Select the employee record you want to assign from those listed, and click on the Select button. 

Date Resolved 
This field represent the date the issue is resolved. To set this value: 

• Click on the down arrows attached to the field. 

• Click the value you want to use from the attached calendar. 

Completed  
Placing a checkmark in this field will mark the current issue as completed. 

Completion Details 
This section allow you to record details about the completion of an issue. 

The following image illustrates the elements of the section: 
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Edit Area 
There is no size limitation to this field and is used to provide completion details about the issue. This 

information can also be edited using the build text editor. This editor is invoked by clicking on the Edit 

Completion button. 

Options 
This section provides various options as it related to open issues. 

 

Creating a New Work Order 
You can create a work order based on an issue by: 
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• Locate and make active the Issue you want to create a work order for. 

• Move to Open Issue tab. 

• Locate the Options group and click on the Create Work Order button. 

• Refer to the Common Features chapter and the Work Order Wizard section to find how to use 

this wizard. 

Create and Print Work Assignments 
Work Assignments are a lot like work orders, but they are not included in the work orders database. 

Instead they are managed in the Issues modules only. The following image shows a typical work 

assignment: 

 

Printing a Single Work Assignment 
To create and print a Work Assignment from the current issue: 

• Locate and make active the Issue you want to create a Work Assignment for. 

• Move to Open Issue tab. 

• Locate the Options group and click on the Work Assignment button. 

OR 

• Locate and make active the Issue you want to create a Work Assignment for. 

• Move to the Reports tab in the ribbon control, and select the Work Assignments option to 

expand the drop down. 
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• Click on the Print Current Issue option. 

Printing a Date Range of Work Assignments 
There is a method to print a date range of work assignments for all open issues that fall within a 

provided date range. 

To print a date range of Work Assignments: 

• Move to the Report tab in the ribbon control and select the Work Assignments option to 

expand the drop down. 

• Click on the Date Range option. 

 

• From the Date Selection dialog, move to the Start Date and End Date fields and setup the 

date range you want to print for. 

• Click on the Accept button. 

• Next a Print Preview screen will open displaying the first Work Assignment found. Either 

print this Assignment or cancel out of the screen. 

 

• Next you’ll be prompted if you want to continue the operation. Click Yes to continue, or 

click one of the other buttons to cancel out. 

• Continue the operation until no more Work Assignment are displayed. 
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Issues Parts Usage 
You can record and deduct from inventory the parts or inventory that are used in the completion of 

issues. 

WARNING: If a work orders was created from the current issue, and this work order is recording part 

usage, do not use the feature here. If used in both environments, inventory levels could be adjusted 

lower that they should be. 

To record an issue’s part usage: 

• Locate and make active the Issue you want to record part usage on. 

• Move to Open Issue tab. 

• Locate the Options group and click on the Track Parts Usage button. 

• This will invoke the Issue Parts Usage dialog. 

The following illustration shows the elements of the Issue Parts Usage dialog: 

 

• Move to and click on the Append (+) button in the data control. 

• From the invoked Parts and Inventory lookup dialog, select the item you want to add from 

those listed in the grid. 

• Click on the Select button 

• Move to the Qty Need and Qty Used fields. Both of these fields only accept numeric 

information. Enter the appropriate information for these fields. 

• Repeat the above step for each inventory item you want to add. 

• Click on the Post/Save (checkmark) button in the data control to save your changes. 
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To update inventory levels with the quantities used 

• Move to and click on the Update Inventory button. 

Save a Summary of the Issue to Asset’s History 
To save a summary of the current issue to the currently assigned asset’s history log: 

• Locate and make active the Issue you want to save to history. 

• Insure that the issue has an asset assigned to it. 

• Move to the Open Issue tab. 

• Locate the Options group and click on the Save to Asset History button. 

Edit Lines and Systems 
Both Issues recording and Production Count recording use Lines and Systems. To edit this list: 

• Open the File menu and select the Edit Lines/Systems List option. This will invoke the Line or 

System Quick Assignment dialog. 
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The procedures for using this dialog is the same as using the Data Quick Entry routines. You can learn 

more about this feature by reading about Data Quick Entry in the Common Features chapter. 

Enter Production Counts 
This module supports both Issues tracking, and to some degree, Production tracking. Many of the 

reports used by this module are based on both issues and actual production counts. For this reason we 

have provided a way of entering production numbers from within this module. 

To record production counts: 

• Open the File menu and select the Enter Production Counts option. This will invoke the 

Production Count Editor dialog. 

 

• To add or edit production counts, move to the Production Lines list and select a production line 

to work with. 

• Move to the Production Date field, and using the attached calendar, select the production date 

of the record you are adding or editing. 

• Move to the Production Count field and enter this numeric value representing the product 

count for the selected date and line. 

• Click on the Save Count button before entering or editing another production record. 

• Click on the Close button when done. 
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Printing an Issue Record 
The following example shows a printed issues record: 

 

To print an issue record: 

• Locate and make active the Issue you want to print. 

• Move to the Home tab in the ribbon and locate the Print Options group. 

• Click on one of the available options found in this group. Options include: 

o Print Record - Allows printer selection and other options before printing. 

o Quick Print - Sends the document directly to the default printer. 

o Print Preview - Provides a print preview of the current record. 

OR 

• Locate and select the item you want to print. 

• Open the File menu and expand the Print Options menu by clicking on it. 
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• Click on the Print Option of your choice: 

o Print Record - Allows printer selection and other options before printing. 

o Quick Print - Sends the document directly to the default printer. 

o Print Preview - Provides a print preview of the current record. 

Saving Changes 
Whenever you edit an issue record on either the Details or Open Issues tabs, you must save your 

changes to retain these edits. 

To Save Changes: 

• Move to the Home tab in the ribbon and click on the Save Changes option. 

OR 

• Move to the data control in the Quick Access toolbar and click on the Post/Save Changes 

button.  

Creating a New Issue 
To create a new issue record: 

• Move to the Home tab in the ribbon and click on the Add Issue button. 

• When prompted about using the wizard, click on the No button. 

• Move through the fields of the Details tab and edit the information found there. 

• Move to the Home tab in the ribbon and click on the Save Changes option. 

Creating a New Issue with the Wizard 
In this tutorial we will try to accomplish two things. The first will be to outline the steps in creating an 

issue using the Issues Creation Wizard, and while we’re at it, show the features of this wizard. 

The Issues Creation Wizard is used to create a new issue tracking record. The wizard style of this dialog 

was designed to help ease the creation process by guiding you through the steps. 

1. Move to the Home tab in the ribbon and click on the Add Issue button. 
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2. When prompted about using the wizard, click on the Yes button. This will invoke the Issues 

Creation Wizard. 

The following illustrates the element of the Reporting Tab of the wizard. 

 

3. Move to the Date of Issue field and using the attached calendar set the date in which the issue 

occurred. 

4. Move to the Time of Issue field and edit this value. 

5. Move to the Reported By field and click on the Select button adjacent to this field. This will 

invoke the Employees Database lookup dialog. 

 
6. Select the employee record you want to assign from those listed in the grid. 

7. Click on the Select button. 

8. Move the Shift or Crew field and select this information from the drop down list. 
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9. Move to the Down Time tab by either clicking on the tab or clicking the Next button. 

 
10. Move to the Hours field, and using the attached spin control, set the hours the item was down. 

11. Move to the Minutes field, and using the attached spin control, set the minutes the item was 

down. 

12. Move to the Specifics tab by either clicking on the tab or clicking the Next button. 

 
13. Move to the Line or System field and click on the Select button adjacent to this field. This will 

invoke the Quick Assignment dialog. 
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14. Move to the Items grid and select the item you want to use for this assignment. 

15. Click on the Accept button. 

16. Move to the Asset field and click on the Select button adjacent to this field. This action will 

invoke the Equipment and Assets lookup dialog. 

 
17. Select the equipment record you want to assign from those listed in the grid. 

18. Click on the Select button. 

19. Move to the Problem-Issue field and click on the Select button adjacent to this field. This will 

invoke the Quick Assignment dialog. 

20. Move to the Items grid and select the item you want to use for this assignment. 

21. Click on the Accept button. 

22. Move to the Classification field and click on the Select button adjacent to this field. This will 

invoke the Quick Assignment dialog. 

23. Move to the Items grid and select the item you want to use for this assignment. 

24. Click on the Accept button. 

25. Move to the Status drop down, and using this drop down list, select the status or priority 

indicator you want to assign to the issue. Options include: Issue Resolved, Information Only, 

Needs Attention and Urgent Issue. 
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26. Move to the Contact tab by either clicking on the tab or clicking the Next button. 

 
27. Move to the Contact Name field and type in this information. 

28. Move to the Phone Number field and type in this information. 

29. Move to the E-Mail field and type in this information. 

30. To save typing in Contact Information, you can select an employee from lookup. To do this move 

and click on the Select button found on this tab. This will invoke the Employees Database 

lookup dialog. 

31. Select the employee record you want to assign from those listed in the grid. 

32. Click on the Select button. 

33. Move to the Details tab by either clicking on the tab or clicking the Next button. 

 
34. Move to the Details Editor text box and enter the details as it related to the issue. 

35. Click on the Save and Close button to save and create the finished Issue record. 

Issues Wizard 
The Issues Wizard is used for filtering the database and for some of the built in reports.  

The following illustration shows the general or shared features of the Wizard: 
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Issues Wizard – Assignments Tab  
The following image illustrates the elements of this section: 

 

• To assign values to these fields: 

o Move to the appropriate fields and click on the Select button adjacent to them. 

o From the invoked dialogs, move to the display grid and click on the record of your 

choice. 

o Click on the Select button.  

• To clear the assignments: 

o Move to the appropriate field and click on the Use All button adjacent to them. 
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Issues Wizard – Dates Tab  
The following image illustrates the elements of this section: 

 

To assign date values: 

• Move to the Start Date field and using the drop down calendar, select the starting date of your 

filtering criteria. 

• Move to the End Date field and using the drop down calendar, select the ending date of your 

filtering criteria. 

• To ignore or use all available dates, check the Use All Dates checkbox. 

Issues Wizard – Sort By Tab  
The following image illustrates the elements of this section: 

 

• To setup the field to sort by: 

o Move to Sort By drop down list, and select one of the available fields. 

Issues Wizard – Finish 
• Click on the Accept button when done setting up the criteria. 
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Deleting an Issue Record 
To delete or remove an Issue Record from the database: 

• Locate and make active the Issue you want to remove. 

• Move to the Quick Access toolbar and click on the Delete Record option.  

 
• When prompted about the deletion, click on the Yes button. 

Reports Overview 
One of the main things that make the Issues Tracking so valuable is the reporting features. With the 

built in reports it should be an easy task for you to find problem areas and trends that can then be 

addressed. 

One suggestion on the use of these reports is to generate them the day before a PM. This will help you 

find areas that need attention, which then can be addressed while the items are down. Another 

outstanding use of some of these reports is the sharing of information with others. This feature will 

facilitates the communications of actions that were done by one team member, while another team 

member was away. Knowing what has previously been done or tried will help the next person know 

where to precede in the process of issue resolution.   

Master Summary Report 
The Master Summary Report returns information on a wide variety of a facilities operation. This report 

allow you to include information on: 

• Scheduled Maintenance. 

• Maintenance and General Issues reported. 

• Resolved Issues. 

• Part Replacement Usage. 

• Production Counts. 

The following image shows an example of a Master Summary Report: 
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To create a Master Summary Report: 

• Move the Reports tab in the ribbon and click on the Master Summary option. This action will 

invoke the Master Summary Report Wizard.  

The following illustration outlines the common features of the wizard and should assist you in navigating 

the wizard’s features. 
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• If not already there, navigate or move to the Report Elements tab as illustrated below. 

 
• This section allows you to select report elements that you want included in your report. To 

include an element place a checkmark next to the element’s name from those listed. 

• To have the program check all the elements for you, click on the Select All button. 

• Non-selected items will not be included in the report. 
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• Move to the Dates tab by either clicking on the tab or clicking the Next button. 

 
• Move to the Start Date field and using the drop down calendar, select the starting date of your 

report date range. 

• Move to the End Date field and using the drop down calendar, select the ending date of your 

report date range. 

• Move to the Sort By tab by either clicking on the tab or clicking the Next button. 

 
• Move to Sort By drop down list, and select one of the available fields. The report will be sorted 

by the selected field. 

• Click on the Accept button to generate the report with the criteria you have set. 

Issues Wizard Report 
This report returns information on all issues that equal the criteria you setup. 

The following illustrations shows a basic Issues Report: 
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To create an Issues Report: 

• Move the Reports tab in the ribbon and click on the Issues Wizard option. This action will invoke 

the Issues Wizard. Please refer to the Issues Wizard section of this chapter on how to use this 

wizard. 

Down Time Report 
The Down Time reports will report on total downtime for criteria that you setup. This information is 

taken directly from reported issues. 

The following illustrations shows a basic Down Time Report: 

 

To create a Down Time Report: 

• Move the Reports tab in the ribbon and click on the Down Time Report option. This action will 

invoke the Issues Wizard. Please refer to the Issues Wizard section of this chapter on how to 

use this wizard. 
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Status Report 
The Status Report uses a wizard to assist you in creating reports on issues status, and issues that fall 

within a specified date range. This report was designed to help you stay on top of your open issues. 

The following illustrations shows a basic Status Report: 

 

To create a Status Report: 

• Move the Reports tab in the ribbon and click on the Status Report option. This action will invoke 

the Status Report setup screen. 
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• Move to the Start Date field and using the drop down calendar, select the starting date of your 

report date range. 

• Move to the End Date field and using the drop down calendar, select the ending date of your 

report date range. 

• Move to the Status Indicator drop down and select an indicator that best describes the issue 

status you want to report on. Options include: 

o View All Issues 

o Open Issues 

o Close Issues 

• Move to the Group By drop down and select, if any, the way you want the report grouped. 

Options include: 

o No Grouping 

o Lines 

o Managers 

o Assets 

o Assignments   

• Move to the Issues to Include drop down box and select the types of issues to include in the 

report. Options include: 

o Maintenance Only 

o Production Only (General) 

o Show All Issues 

• Move to and click on the OK button to generate the report. 

Parts Usage Report 
This report will return a list of all parts that were used in the completion of issues and that fall within a 

given date range. 

 

To create a Parts Usage Report: 



Maintenance Coordinator – Professional Features 

 

Simplicity Software Technologies Inc. | Top Ten Issues Report 300 

 

• Move to the Reports tab in the ribbon and click on the Parts Usage option. This action will 

invoke the Date Range dialog screen. 

 
• Move to the Start Date field and using the drop down calendar, select the starting date of your 

report date range. 

• Move to the End Date field and using the drop down calendar, select the ending date of your 

report date range. 

• Click on the Accept button to create the report. 

Top Ten Issues Report 
This report returns the frequency of recurring issues for the entire facility, line or machine, and a date 

range you select. This report is ideal for pin pointing the number one problem areas, and then breaking 

down that issue even further. In summary, this report returns the top 10 recurring issues with actual 

counts, based on the criteria that you setup. 

To create a Top Ten Issues Report: 

• Move the Reports tab in the ribbon and click on the Top Ten Issues option. This action will 

invoke the Issues Wizard. Please refer to the Issues Wizard section of this chapter on how to 

use this wizard. The one tab that will be missing is the Sort By tab, as this type of report does 

not require sorting. 

• This report produce a chart to help represent the data returned. You are allowed to edit this 

chart before continuing with the finished report. To learn about the feature of this Designer, 

please look at the Chart Designer section of the Reports and Graphics module. 

• When done modifying the chart, close the Designer to view the final report. 

Production Counts and Issues Report 
There are 3 different Production Counts and Issues Reports available. All three of these deal with the 

same basic information; the production counts for a given date range, a specific production line, and all 

the issues reported for the provided date range and selected line. 
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These reports are ideal for summarizing exactly how a production is performing along with any reported 

issues. We highly recommend using one of these reports prior to any maintenance days, this way you 

can analyze where to assign your resources to get the best results. 

The following image shows an example of a Production Counts and Issues Report. 

 

To create a Counts and Issues Report: 

• Move the Reports tab in the ribbon and click on the Counts and Issues Report option to expand 

the drop down. 

• Next select the number of days to include in your report. Options include: 

o 7 Days 

o 14 Days 

o Month  
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• Once the date range is selected, the Production Report setup dialog will load. 

 
• Move to the Date field and select the beginning date of the date range. The number of days 

previously selected will be added to this beginning date to provide the report date range. 

• Move to the Line drop down and select line you want to base your report on. 

• Click on the OK button. 

• This report produce a chart to help represent the data returned. You are allowed to edit this 

chart before continuing with the finished report. To learn about the feature of this Designer, 

please look at the Chart Designer section of the Reports and Graphics module. 

• When done modifying the chart, close the Designer to view the final report. 

Predictive Maintenance Report 
This report provides a worksheet based on part replacement as it applies to Issues Part Usage. The 

report gives information about the replacement intervals of parts that have been replaced more than 

once. With this information the user should be able to predictive the failure rate of the reported parts, 

and schedule maintenance accordingly. 

 

To Predictive Maintenance Report: 

• Click on the Reports tab in the ribbon, and then choose the Predictive Maintenance option in 

the Predictive group. 
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Properties Database 

The Properties Database module was designed for two main audiences. One is for those that may 

manage various properties, and with these properties manage associated work orders, manage assets 

and track inventory for these locations. The others are for those that may only have one location to 

manage, but would still like to manage location inventory, contact information as it may apply to 

insurance companies, fire protection equipment, and other related items.   

 

The inventory tracked by this module differs from the Parts and Inventory module, as it relates to assets 

and furnishing of a location, or even an apartment or room. The Tree Records part of this module 

supports the contact tracking feature where you can create an almost endless grouping of items as 

found in tree controls. 

Key elements of this module include: 

• General Property information – Address, location and main contact. 

• Attached RTF Notes. 

• Property Driving Directions. 

• Unlimited Special User Defined field groups. 

• View Assigned Assets and their work orders. 

• Inventory database of items that can be grouped by classifications, rooms and more. 

• Tree Records database that groups items in in a tree view, and also supports attachments. 
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Ribbon Control 
The functionality of the Properties Database module is provided via the tabbed Ribbon control. Options 

on the page are structurally and visually split into logical groups. Each of these groups includes 

commands that perform specific functions. 

PROPERTIES TAB 

  

The following are the elements on the Properties ribbon tab, reading left to right: 

• Add New – Create a new blank record in the database. 

• Save Changes – Saves all current changes from all elements of a record (master save). 

• Properties Notes - Allows the viewing and editing of the notes assigned to the current item. 

• Print Assets - Creates a print preview of the current property and all assigned assets (Assigned 

Assets Report). 

• Inventory Items - Creates a print preview of the current property and all assigned Inventory 

Items (Assigned Inventory Report). Options in the drop down include: 

o Group by Rooms – Groups inventory items by room assignments. 

o Sort by Description – Sorts inventory items by description. 

o Selected Inventory Item – Prints only the selected inventory item. 

• Print Notes – Prints the property notes document (RFT). 

• Search - Invokes the search/find routine on the Lookup Grid. 

• Exit Module – Closes and exit the current module, 

Features of the Properties Database Module 
There are many features of the Properties Database module, with the majority of these features found 

on either the tabbed pages found there, or within the tabbed ribbon control. We are going to explain 

the use of these features as we move through the tabbed pages.  

Lookup Tab 
This tab helps in locating properties by grouping, filtering and sorting them. All the records in the 

current filter are located in the grid found here. To select a record and make it the active record, the 

user needs only to click on the item from within the grid. Once selected the user can click on the other 

tabs to view or edit the record itself. 

The following image illustrates the features available on the Lookup tab: 
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The functions of the Lookup tabs are used through-out the system and are fairly common regardless of 

the modules that use them. Please review the chapter on Common Features to read about the 

functionality of the controls located on this tab. Apply special attention to the following: 

• Using the Lookup Grids 

• Searching 

Details Tab 
Under the Details tab you can setup your address information, contact information and general 

assignments for the selected property. 

Contact Information 
This section allows you to maintain information on the primary contacts as it relates to the selected 

property. The following illustrates the elements found in this section: 

 

Description 
This alpha numeric field can accept up to 50 characters and is used to help identify the property record. 

Primary Contact 
This alpha numeric field can accept up to 30 characters and is used to record the name of the property’s 

primary contact person. 
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Contact Title 
This alpha numeric field can accept up to 30 characters and is used to record the job title of the 

property’s primary contact person. 

Phone Number 
This alpha numeric field can accept up to 30 characters and is used to record the telephone number of 

the property’s primary contact person. 

Extension 
This alpha numeric field can accept up to 5 characters and is used to record the telephone extension 

number. 

Contact Email 
There is no size limitation to this alpha numeric field and is used to store the email address of the 

primary contact. Clicking on the ellipse button (…) found here will open the default email application 

with the specified address. 

Address Information 
This section allows you to maintain address information as it relates to the selected property. The 

following illustrates the elements found in this section: 

 

Property Address 
The two address fields found in this group will accept up to 30 alpha numeric characters each. Use these 

fields to record street, PO Box and other address information. 

City 
This alpha numeric field can accept up to 30 characters and is used to specify the city the property is 

located in. 

State/Region 
This alpha numeric field can accept up to 30 characters and is used to specify the state, region or 

province the property is located in. 
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Postal Code 
This alpha numeric field can accept up to 15 characters and is used to specify the postal code used for 

this property. 

Property Country 
This alpha numeric field can accept up to 30 characters and is used to specify the country the property is 

located in. 

Special Fields 
This section allows you to create and use Special Fields. Special Fields can be thought of as groups of 

User Defined Fields. Each group can have a Group Name and 8 fields with user defined titles. 

The following illustrates the elements found in this section: 

 

For more information about this feature please refer to the Special Fields section of the Common 

Features chapter. 

Manage Selected Special Fields 
To setup the titles for the current set of special fields: 

• Select the Special Fields group as found on the Options tab and within the grid. 

• Open the File menu and expand the Manage Special Fields sub menu. 

• Click on the Manage Selected Fields option. 

For more information about this feature please refer to the Special Fields section of the Common 

Features chapter. 

Property Directions 
This section allows you to record driving directions to the current property. The following illustrates the 

elements found in this section: 
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Type in your directions in the space provided, and this alpha numeric field has no size limitation. You can 

edit this information with the built in Text Editor by clicking on the Edit button found in this section. 

Assigned Assets Tab 
Under the Assigned Assets tab you can view the assets assigned to the currently selected property 

record. 

The following illustrates the elements found on the Assigned Assets tab: 

 

Assigning Assets to Properties 
Assigning Assets to Properties is not supported in this module. These assignments are actually made 

from within the Equipment and Assets module. To assign assets to properties: 

• From the Main Menu or Start-up screen navigate to Equipment and Assets module. 

• Move to the Options tab of the assets database, and then click on the Property Assignments tab 

near the bottom. 

• Click on the Select Property button. 

• From the invoked Properties and Locations dialog move to the grid and select the property you 

want to assign. 

• Click on the Select button. 

• Exit the Equipment and Assets module when done. 

Updating an Asset’s Current Meter Value 
You are provided with the means to update an Asset’s meter value from within this module. To update 

an asset’s meter value: 

• Locate and make active the property record the asset is assign to. 

• Move to the Assigned Assets tab. 

• Move to the grid on this tab and select the asset record you want to update the meter value on. 
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• Move to the Current Meter group near the bottom and edit the meter value. 

• Move to the Data Control and click on the Post/Save (✓) changes button. 

Viewing an Asset’s Assigned Work Orders 
You can view the work orders assigned to work orders by: 

• Locate and make active the property record the asset is assign to. 

• Move to the Assigned Assets tab. 

• Move to the grid on this tab and select the asset record you want to view the work orders on. 

• Click on the Asset’s Work Orders button. 

Printing an Asset’s Work Order 
To print one or more work orders for an assigned asset: 

 

• Follow the Viewing an Asset’s Assigned Work Orders instructions previously outlined in this 

chapter. 

• Move to the grid and select the work order you want to print from those listed. 
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• Click on the Print Preview button. 

Inventory Tab 
On the Inventory tab you can assign inventory items that belong to the select property or room. The 

following illustrates the elements of this tab: 

 

Adding a New Inventory Item 
To add a new Inventory item: 

• Locate and make active the property record that you want to add an item to. 

• Move to the Inventory tab. 

• Click on the Append (+) button in the data control. 

• Move to the Inventory Details group and edit the information here detailing the new item. 

• Return to the Data Control and click on the Post/Save (✓) changes button. 

Inventory Details 
This section allows you to edit or enter the details about the selected inventory item as shown in the 

following illustration: 
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Description 
This alpha numeric field can accept up to 60 characters and is used to help identify the inventory item. 

Classification 
This alpha numeric field can accept up to 40 characters and is used to record the item’s classification 

assignment. 

Model 
This alpha numeric field can accept up to 40 characters and is used to record the item’s model number.          

Manufacturer 
This alpha numeric field can accept up to 40 characters and is used to record the item’s manufacturer. 

Serial Number 
This alpha numeric field can accept up to 40 characters and is used to record the item’s serial number. 

Supplier Name 
This alpha numeric field can accept up to 50 characters and is used to record the item’s supplier or 

Vendor assignment. 

Room/Area 
This alpha numeric field can accept up to 40 characters and is used to record the room or area the item 

is used or stored in. 

Model 
This numeric only field is used to record the quantity of the item being stored at this location. 

Tree Records Tab 
Tree Records are used to track contact records and or manage documents and links.  Records stored 

here can contain information stored within the database, and/or linked to external documents. Also 

records are grouped by a Documents Tree that by design helps to define the documents purpose. 

The following illustrates the elements of this tab: 
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Documents Trees 
The Documents Tree is used to group the documents together in logical groups. The makes finding a 

documents much easier. 

Understanding and Using the Documents Tree 

 

The Documents Tree allows for the organization of your documents in Folders or nodes. Basically you 

are not limited to the number of folders you can create and use. You can also create as many levels of 

these folders as maybe needed (parent – child folders). The supplied illustration shows the elements of a 

typical tree control. 

Create a Document Folder 

Each document in the system will be assigned to a folder or tree node in the Documents Tree. Once a 

folder is created documents can be added to it. 
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To create a new Document “Root” or “Top Level” folder: 

 

• Right mouse clicking within a Documents Tree section will invoke a popup menu. 

• Click on the Add Top Folder option. 

• From the invoked dialog enter the name you want to use for this folder and click OK. 

To create a new “Sub Folder” or “Child Node”: 

• Move to the Documents Tree and click and select the folder that you want to add a new sub 

folder to. 

• Right mouse click within the Documents Tree section to invoke a popup menu. 

• Click on the Add Sub Folder option. 

• From the invoked dialog enter the name you want to use for this folder and click OK. 

To Remove a Folder: 

• Move to the Documents Tree and click on the folder you want to remove. 

• Ensure there are no child folders or documents assigned to this folder. If there are items then 

either move and reassign these items or delete them. You cannot remove a folder if anything is 

assigned to it. 

• Right mouse click on the folder you want to remove to invoke a popup menu. 

• Click on the Remove Folder option. 

To Rename a Folder: 

• Move to the Documents Tree and click on the folder you want to rename. 

• Right mouse click on the folder you want to remove to invoke a popup menu. 

• Click on the Rename Folder option. 

• From the invoked dialog edit the folder name to the way you want it and then click OK. 

To move a Folder to the Top Level or Root position: 

• Move to the Documents Tree and click on the folder you want to move. 

• Right mouse click on the folder you want to move to invoke a popup menu. 

• Click on the Move Folder to Root (Top Level) option. 
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To move a Folder and Reassign its position in the tree: 

• Move to the Documents Tree and click on the folder you want to move. 

• Left mouse click and hold on the folder you want to move. 

• Drag the folder over the folder you want to move it to. 

• Release the mouse button to drop the folder in to its new location. 

Add a New Tree Document 
• Move to the Tree Document folder. 

• Move to the Documents Tree and click on the folder you want to add a document to. 

• Right click on the folder to invoke the Pop Up menu. 

• Select the Add Document option. 

  

• Move to the Document Details group and edit your document. 

• Click on Save Changes option in the ribbon. 

Document Details Explained 

Document Description 
This alpha numeric field can accept up to 40 characters and is used to describe the document. This is 

also shown in the Documents Tree. 
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External Link 
This field holds the complete path to a file saved to disk. 

To set a document link: 

• Move to the External Link field and click on the attached ellipsis (…) button. 

• From the invoked File Open dialog box browse to where the file is stored. 

• Select the file and click Open. 

To view a linked document: 

• Move to a record that contains a linked document. 

• Click on the Open Link button. 

Print Tree Document 
To receive a print preview of the current Tree Document: 

• Click on the Print Document button. 

Details 
There is no size limitation to this alpha numeric field, and this field can contain any information you 

want. You can also insert Vendor information by clicking on the Insert Vendor button. Selecting a 

vendor from the grid, and clicking Select. 

To edit the Details information using our Text Editor, click on the Edit Details button found in this area. 

Add a Property Record 
To add a new property record: 

• Move to the ribbon and click on the Add New option. This will create a new blank record in the 

database. 

• Move through the various tabs and edit the new record. 

Save Changes 
To save changes to the main record, click on the Post (✓ check) button in the Data Control located 

within the ribbon’s Quick Access toolbar. 

To save changes to the main record and all the underlying records (inventory, tree documents, etc.), 

click on the Save Changes button found in the ribbon control. 

Print Options 
To print the current property record: 

• Locate and select the item you want to print. 
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• Open the File menu and expand the Print Options menu by clicking on it. 

• Click on the Print Option of your choice: 

o Print Record - Allows printer selection and other options before printing. 

o Direct Print - Sends the document directly to the default printer. 

o Print Preview - Provides a print preview of the current record. 

Search 
To perform a search on the Properties database: 

• Move to the Properties tab in the ribbon. 

• Click on the Search option.  

• Refer to the Search section of the Common Features chapter for more information. 
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Safety Management 

We know that many times you’ll find that the person responsible for maintenance is often responsible 

to oversee safety performance as well. With the Safety Management module we give you the tools to 

track accidents, do complete investigations on incidents, and make analyzes of incidents to prevent 

further occurrences, and more. 

 

This module also allows you to track workmen compensation claims and costs, create and track safety 

inspections and create a safety punch list. It’s also provides the means to turn incidents or punch list 

items into work orders. These work orders can also be tracked from within this module. So if you need 

safety management in your workplace, this module should provide you with the resources to get the job 

done. 

This module is essentially made up of four different, but related internal components. You have 

Accidents (incidents), Workers Compensation, Safety Inspections and a Punch/Tasks list component. Our 

discussion on this module will be broken down into these segments or components. 

Navigating the Safety Management Module 
The following outlines the possible options that can be used in the navigation between the components 

of this module. 

The navigation bar is located on the left side of the screen, and can be used to navigate through the 

components of this module. 
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• Click on a group within the Navigation Bar to branch to that 

component. The groups are the larger of the available items shown, with 

larger text and icons. 

• Once a group is expanded, you can click on one of the available 

options to active that option or feature. 

To open components simply click on its name. Options include: 

• Incident Reports 

• Workers Compensation 

• Safety Inspections 

• Safety Task List 

 

Incident Reports 

The Accidents and Incidents section is where you can track incidents in your workplace, and analyze 

these incidents with the built in reports. By analyzing this information problem areas can be identified 

and corrective action can be taken. Accidents can cost a company a lot of money as employees miss 

work, increased workers compensation costs, and property damage. 

One area this section shines is in recordkeeping. You can keep detailed records on every incident within 

the database, and the documents can also be printed to provide for hard of these records. The 

advantage of keeping the incidents in a database, as opposed to just hard copies, is that the information 

can be more readily analyzed and reported on. 

Ribbon Control 
The comprehensive functionality of the Incident Reports component is provided via a set of Ribbon 

tabbed pages. Ribbon pages are structurally and visually split into logical groups. Each of these groups 

includes commands that perform specific functions. 

HOME TAB 

 

The following are the elements on the Home ribbon tab, reading left to right: 

• Add New – Create a new blank record in the database. 
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• Save Changes – Saves all current changes from all elements of a record (master save). 

• Print Incident - Allows printer selection and other options before printing. 

• Quick Print - Sends the document directly to the default printer. 

• Print Preview - Provides a print preview of the current record. 

• Create Work Order – Invokes the Work Order Creation wizard that will allow the creation of a 

work order based on the current incident. 

• Workers Comp. – Invokes the workers compensation Claim Editor that will allow you to track 

this type of information. 

• Associate Report – Invokes an associate report where the involved employee can record what 

happened in their own words. 

• Witness Reports – Invokes the witness reports routines where you can add and view witness 

reports. 

• Filter Wizard – Invokes the Incident Wizard that lets you specify sorting and filtering criteria as 

it applies to incident records. 

• Default Filter – Reapplies the default filtering criteria to the incidents database (show all). 

• Search - Invokes the search/find routine on the Lookup Grid. 

• Exit Module – Closes and exit the current module. 

REPORTS TAB 

 

The following are the elements on the Home ribbon tab, reading left to right: 

• Report Wizard - Invokes the Incident Wizard that lets you specify sorting and filtering criteria as 

it applies to the creation of your report. 

• Incident Fields – Invokes the Incident Fields dialog that allows for the creation of a report based 

on incident fields. 

Features of the Incidents Component 
There are many features of the Incidents Component, with the majority of these features found on 

either the tabbed pages found there, or within the tabbed ribbon control. We are going to explain the 

use of these features as we move through the tabbed pages.  

Lookup Tab 
This tab helps in locating incidents by grouping, filtering and sorting them. All the records in the current 

filter are located in the grid found here. To select a record and make it the active record, the user needs 
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only to click on the item from within the grid. Once selected the user can click on the other tabs to view 

or edit the record itself. 

The following image illustrates the features available on the Lookup tab: 

 

The functions of the Lookup tabs are used through-out the system and are fairly common regardless of 

the modules that use them. Please review the chapter on Common Features to read about the 

functionality of the controls located on this tab. Apply special attention to the following: 

• Using the Lookup Grids 

• Searching 

Other Tabs 
With the exception of the Lookup tab, each of the other tabs in this component all deal with different 

elements of the current record or incident. 

Details Tab 
Under the Details tab you can setup information on the involved employee and general details about 

the incident. 

Employee Information 
This section allows you to record information as it applies to the employee implicated in the incident. 

The following illustrates the elements of this group. 

 

Employee Name 
This alpha numeric field can contain up to 40 characters and is used to record the name of the person 

involved in the incident. 
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Reference  
This alpha numeric field can contain up to 30 characters and is used to record the employee reference 

id. 

Sex  
This alpha numeric field can contain up to 6 characters and is used to indicate the gender of the 

employee. Set this field by selecting an option from the drop down list. 

Shift  
This alpha numeric field can contain up to 15 characters and is used to record the employee’s assigned 

shift or crew. 

Position  
This alpha numeric field can contain up to 30 characters and is used to record the employee’s job title. 

Age  
This numeric only field is used to record the employee’s age at the time of the incident. 

Employee Lookup 
Click this button to invoke the Employee Database dialog where you can select an employee from a 

lookup list. To use this feature: 

• Click on the Employee Lookup button. 

• When the lookup dialog loads, move to the grid and select the record you want to use. 

• Click on the Select button. 

Incident Details 
This section allows you to record the what, when and where type information as it relates to the current 

incident. The following illustrates the elements of this section: 

 

Incident Type 
Selectable from the drop down list, this field specifics the type of incident that occurred. Options 

include: 

• First Aid 

• Loss Time 

• Near Miss 

• Medical Treatment 
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• Restricted Work 

• Property Damage 

• Other 

Date of Incident 
This date only field is used to indicate the date of the incident. Set this field by using the attached 

calendar. 

Time of Incident 
This alpha numeric field can contain up to 15 characters and is used to record time of the reported 

incident. 

Date Reported 
This date only field is used to indicate the date the incident was reported. Set this field by using the 

attached calendar. 

Treatment Provided 
Selectable from the drop down list, this field specifies the type of treatment that was provided as it 

relates to the incident. Options include: 

• None 

• In-House 

• Hospital/Clinic 

Work Status 
Selectable from the drop down list, this field indicates the employee’s work status immediately 

following the incident. Options include: 

• Returned 

• Did Not Return 

Nature of Injuries 
This alpha numeric field can contain up to 30 characters and is used to record the general nature of 

injuries or the body parts affected. 

Equipment Damaged 
This alpha numeric field can contain up to 60 characters and is used to specify the name of the 

equipment that was damaged. You can also set this field by accessing the Equipment and Assets 

database. To assign from the database: 

• Click on the Ellipsis (…) button attached to this field. 

• When the lookup dialog loads, move to the grid and select the record you want to use. 

• Click on the Select button. 
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Nature of Damage 
This alpha numeric field can contain up to 30 characters and is used to record the type of damage that 

occurred. 

Estimated Costs 
This is a numeric only field and is used to record (if known), the estimated cost of the damage. Set this 

field by using the attached calculator. 

Specific Location 
This alpha numeric field can contain up to 30 characters and is used to specify the location of the 

incident. 

Name of Witness 
This alpha numeric field can contain up to 30 characters and is used to record the name of the primary 

witness. You can actually record as many Witness Reports as needed. 

Details of Incident 
This section allows you to record the details as it relates to the incident. The following illustrates the 

elements of this section: 

 

The alpha numeric field here has no size limitations. You can edit the field with the Text Editor by 

clicking on the Edit button found in this section. 

General Tab 
Under the General tab you can setup information on job procedures, risk evaluation and medical 

treatment provided. 

Job Procedures 
This section allow you to specify and job related procedures that were provided, and who made the 

work assignment. The following illustrates the elements of this section: 
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Were any specific job procedures included 
Answer this question by selecting an answer as provided in the drop down list adjacent to this field. 

Person making the work assignment  
This alpha numeric field can contain up to 30 characters and is used to record the person making the 

work assignment. To assign from the database: 

• Click on the Select button adjacent to this field. 

• When the lookup dialog loads, move to the grid and select the record you want to use. 

• Click on the Select button. 

Instructions given to employee prior to starting work 
There is no size limitations to this alpha numeric field. Use this field to record any special instructions 

provided to the employee prior to the commencement of the work. 

Risk Evaluation 
This section allows you to specify the severity and recurrence probability. 

 

Loss Severity Potential 
Selectable from the drop down, this field would indicate the Loss Severity Potential is the cause of the 

incident is not corrected. Options include: 

• Major 

• Serious 

• Minor 

Probability of Recurrence 
Selectable from the drop down, this field would indicate the probability that incident could happen 

again if the cause of the incident is not corrected. Options include: 

• Frequent 

• Occasional 

• Rare 

Root Cause Assignment 
This section allows you to specify the Root Cause of the incident. 
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The Root Cause field of the Incident document is somewhat different from the other fields of incident 

reports.  This field does not show up on any of the printed documents but is used exclusively for 

reporting. This field lets you group like incidents on reports, and you should try to reuse the same 

description as often as possible. Good descriptions for this field maybe ducking under, machine 

malfunctions, running, horseplay, and so on. Hopefully, you can see how this may come in handy for 

grouping like causes on reports. 

This alpha numeric field can contain up to 30 characters and best to set this field by selecting an item 

from the drop down list. If this cause is not available, you can add it by clicking on the Manage button 

adjacent to this field. 

Medical Treatment Provided 
This section allows you to record the medical treatment provided to an injured employee. The following 

illustrates the elements of this section: 

 

The alpha numeric field here has no size limitations. You can edit the field with the Text Editor by 

clicking on the Edit button found in this section. 

Causes Tab 
This tab allows you to provide details about the causes of the incident. 

Immediate Cause 
This section allows you to record the substandard acts of conditions that caused the incident.

 

The alpha numeric field here has no size limitations. You can edit the field with the Text Editor by 

clicking on the Edit button found in this section. 
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Basic Causes 
This section allows you to record the underlying causes of the incident. This could include items such as 

job or personal factors, and so on.  

 

The alpha numeric field here has no size limitations. You can edit the field with the Text Editor by 

clicking on the Edit button found in this section. 

Action - Review Tab 
This tab allows you to record Corrective Action to help prevent further incidents, and your Health and 

Safety team’s review of the incident. 

Corrective Action 
This section allows you to record the steps taken to prevent incident from happening again. The 

following illustrates the elements of this section: 

 

The alpha numeric field here has no size limitations. You can edit the field with the Text Editor by 

clicking on the Edit button found in this section. 

Health and Safety Review 
This section allows you to record the Health and Safety committee review of the incident. The following 

illustrates the elements of this section: 

 

The alpha numeric field here has no size limitations. You can edit the field with the Text Editor by 

clicking on the Edit button found in this section. 
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Investigation Tab 
This tab allows you to provide sign-offs for the investigation of the incident as shown in the following 

illustration: 

 

All of these named fields can contain 30 alpha numeric characters each and can be directly typed in, or 

set by selecting employees from the Employee Database.  

To set these fields from the Employees Database: 

• Click on the Select button adjacent to the field you’re working with. 

• When the lookup dialog loads, move to the grid and select the record you want to use. 

• Click on the Select button. 

To set the date values on this tab, simply select the date from the attached calendars. 

Attachments Tab 
On this tab you can create links to external, supporting documents that relate to the incident. These 

could include pictures and other related documents.  

You can attach as many external files as you would like to a record. These attachments can include 

images, mechanical drawings, PDF files, MSDS sheets and more. For more information on this feature, 

please refer to the Attachments section of the Common Features chapter. 

The following illustrates the elements found in this section: 
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Saving Changes 
Whenever you edit an incident record, you must save your changes to retain these edits. 

To Save Changes: 

• Move to the Home tab in the ribbon and click on the Save Changes option. This option saves all 

changes to all elements of the record. 

OR 

• Move to the data control in the Quick Access toolbar and click on the Post/Save Changes 

button.  

 

Creating a New Incident  
To create a new incident record: 

• Move to the Home tab in the ribbon and click on the Add New button. 

• When prompted about using the wizard, click on the No button. 

• Move through the fields of the various tabs and edit the information found there. 

• Move to the Home tab in the ribbon and click on the Save Changes option. 

Creating a New Incident with the Wizard 
In this tutorial we will try to accomplish two things. The first will be to outline the steps in creating an 

incident using the Incident Creation Wizard, and while we’re at it, show the features of this wizard. 

The Incident Creation Wizard is used to create a new incident tracking record. The wizard style of this 

dialog was designed to help ease the creation process by guiding you through the steps. 
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Note: The input fields of this wizard are same as those found on the main tabs of this component. The 

information outlined previously on these tabs will outline these fields in greater detail. If needed, please 

refer to the main tabs sections of this chapter for more information.  

1. Move to the Home tab in the ribbon and click on the Add New button. 

 
2. When prompted about using the wizard, click on the Yes button. This will invoke the Incident 

Creation Wizard. 

3. Move to the Employee tab if not already there. The following illustrates the elements of this 

tab: 
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4. Move to and click on the Select Employee button. This will invoke the Employees Database 

lookup dialog. 

 
5. Select the employee record you want to assign from those listed in the grid. 

6. Click on the Select button. 

7. Set up the other fields on this tab that wasn’t automatically filled in for you when the employee 

was selected. 

8. Move to the Specifics tab by either clicking on the tab or clicking the Next button. 

 
9. Move to the Type of Incident drop down and select an item from the list that best describes the 

type of incident this related to. 

10. Move to the Date of Incident field and assign this information from the attached calendar. 

11. Move to the Time of Incident field and type in the time this incident occurred. 

12. Move to Treatment Provided drop down and make the appropriate selection from the list. 

13. Move to the Work Status drop down and select if the employee returned to work or not. 
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14. Move to the Nature of Injuries-Body Parts section and either type in this information, or select 

an item from the drop down list. 

15. Move to Incident Location field and type in where the incident took place. 

16. Move to the Name of Witness field and type in the name of any witness. 

17. Move to the Asset tab by either clicking on the tab or clicking the Next button. 

 
18. Move to the Equipment Damaged field and click on the Select button adjacent to this field. This 

action will invoke the Equipment and Assets lookup dialog. 

 
19. Select the equipment record you want to assign from those listed in the grid. 

20. Click on the Select button. 

21. Move to the Nature of Damage field and type in the damage that was done to the item. 

22. If known, move to the Estimated Cost of Damage field and enter this amount. 
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23. Move to the Details tab by either clicking on the tab or clicking the Next button. 

 
24. Move to the Description of Incident field and provide details about the incident. 

25. Move to the Job-Risk tab by either clicking on the tab or clicking the Next button. 

 
26. Answer the ‘Were any specific job procedures involved?’ question by selecting a response from 

the drop down list. 

27. Move to the Person making the work assignment field and type in this information. You can 

also select an employee from Employees Database by: 

a. Clicking on the Select button adjacent to this field. 

b. Select the employee record you want to assign from those listed in the grid. 

c. Click on the Select button. 

28. Move to the Instructions employee was given prior to starting work field and enter (if any) this 

information. 

29. Move to the Loss Severity Potential drop down and select the appropriate item you want to 

assign. 

30. Move to the Probability of Recurrence drop down and select the appropriate item you want to 

assign to this item. 
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31. Move to the Treatment-Root Cause tab by either clicking on the tab or clicking the Next button. 

 
32. Move to the Medical Treatment Provided area and enter the treatment that was provided and 

who provided the treatment. You can also use the Text Editor to edit this information by clicking 

on the Edit button found in this area. 

33. Move to the Root Cause area, and using the drop down list, assign a root cause for the incident. 

34. Move to the Causes tab by either clicking on the tab or clicking the Next button. 

 
35. Move to the Immediate Cause area and enter what substandard acts or conditions caused the 

incident. You can also use the Text Editor to edit this information by clicking on the Edit button 

found in this area. 

36. Move to the Basic Cause group and enter what underlying items that may have caused the 

incident. You can also use the Text Editor to edit this information by clicking on the Edit button 

found in this area. 

37. Click on the Save and Close button to save and create the incident record. 
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Incident Wizard 
The Incident Wizard is used as the Filter Wizard and as the Report Wizard. The following illustration 

shows the main elements of this wizard. 

 

Incident Wizard - Criteria Tab 
The following illustration shows the elements of the Criteria tab: 

 

• To assign values to these fields: 

o Move to the appropriate fields and select the item you want to assign from the drop 

lists found here. 

• To clear the assignments: 
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o Move to the appropriate field and click on the Use All button adjacent to them. 

Incident Wizard - Criteria Tab 
The following illustration shows the elements of the Dates tab: 

 

To assign date values: 

• Move to the Start Date field and using the drop down calendar, select the starting date of your 

filtering criteria. 

• Move to the End Date field and using the drop down calendar, select the ending date of your 

filtering criteria. 

• To ignore or use all available dates, check the Include All Dates checkbox. 

Incident Wizard - Sort Tab 
The following illustration shows the elements of the Sort tab: 

 

• To setup the field to sort by: 

o Move to Sort By drop down list, and select one of the available fields. 
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Incident Wizard – Finish 

• Click on the Accept button when done setting up the criteria. 

Printing an Incident Record/Report 
The following image shows a preview an Incident Report: 

 

To print an incident record: 
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• Locate and make active the incident record you want to print. 

• Move to the Home tab in the ribbon and locate the Print Options group. 

• Click on one of the available options found in this group. Options include: 

o Print Incident - Allows printer selection and other options before printing. 

o Quick Print - Sends the document directly to the default printer. 

o Print Preview - Provides a print preview of the current record. 

Deleting an Incident Record 
To delete or remove an Incident Record from the database: 

• Locate and make active the record you want to remove. 

• Move to the Quick Access toolbar and click on the Delete Record option.  

 
• When prompted about the deletion, click on the Yes button. 

Creating a New Work Order 
You can create a work order based on an incident by: 

• Locate and make active the incident you want to create a work order for. 

• Move to Home tab in the ribbon and click on the Create W.O. option. This will invoke the Work 

Order Creation Wizard. 

• Refer to the Common Features chapter and the Work Order Wizard section to find how to use 

this wizard. 

Creating a New Workers Compensation Claim 
Workers Compensation Claims are based on Incidents Reports. Therefore all new claims must be 

initiated from within the Incidents Reports component. 

To create a new Workers Compensation claim: 

1. Locate and make active the incident that you want to base the claim on. 
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2. Move to the Home tab and click on the Workers Comp. option. 

  
3. When prompted about creating a new claim, click on the Yes button. If a claim already exists 

for this incident, this step will be skipped. 

4. This action will invoke the Claim Editor as shown in the following illustration:  

 
Incident Summary: This section is for information only and cannot be edited. It provides basic 

information on the incident this claim is being based on. 

5. If you want to record an activity as it related to this claim, move to the Activities History tab. If 

you don’t to add an activity record at this time, skip to step 11. 
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6. Click on the Append (+) within the Data Control located on this tab. 

 
7. When prompted, move to the input area and type it the activity description you are adding. 

Click on the OK button when done. 

 
8. When prompted, move to the input area and enter any costs associated with this activity. Click 

on the OK button when done. If there are no associated costs, click on the Cancel button. 

 
9. Once the activity has been added, you can edit the date of the activity by: 

a. Move to the Date column of the activity you just added and click in this column. 

b. Click on the Down Arrow here to invoke the calendar. Set the date using this calendar. 

10. Repeat the above steps for each activity you want to add. 
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11. Move to the Specifics tab by either clicking on the tab or clicking the Next button. 

 
12. Move to the Claim Number field and enter this alpha numeric information. 

13. Move to the Date Claim Opened field and using the attached calendar, set this value. 

14. Move to the Date Claim Closed field and using the attached calendar, set this value. 

15. Move to the Insurance Carrier field and either type in this information or you can select an 

insurance carrier from a database. To select the insurance carrier: 

 
a. Click on the ellipsis (…) button adjacent to the Insurance Carrier field to invoke the 

Insurance Carriers lookup. 

b. Select the company you want to assign by clicking on the record from within the grid 

and then clicking the Select button. 

16. If the claim is closed, move to the Claim Closed checkbox and place a checkmark here by 

clicking on it. 
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17. Move to the Medical tab by either clicking on the tab or clicking the Next button. 

 
18. Move to the Attending Physician field and either type in this information or you can select a 

physician from a database. To select the physician: 

 
a. Click on the ellipsis (…) button adjacent to the Attending Physician field to invoke the 

Physicians lookup. 

b. Select the physician you want to assign by clicking on the record from within the grid 

and then clicking the Select button. 

19. Move to the Date of Last Examination field and using the attached calendar, set this value. 

20. Move to the Condition of Employee when last examined field and type in this alpha numeric 

information. You can also click on the Edit button to edit this information with the Text Editor. 
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21. Move to the Notes tab by either clicking on the tab or clicking the Next button. 

 
22. Move to edit field found on this tab and enter any notes you want to make of the current 

claim. You can also click on the Edit Notes button to edit this information with the Text Editor. 

23. Click on the Close button when done editing the claim record. 

Associate Report 
This report is the facts of the incident as described by the employee or employees involved. You can 

create more than one Associate report per main incident if needed. 

 

To create an Associate Report for the Incident: 

• Locate and make active the incident that you want to base the report on. 

• Move to the Home tab and click on the Associate Report option. 

• When the Associate Report loads, move to the ribbon and click on the Add Record option. 
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• Move through the various tabs and fields of this report and fill in or setup the appropriate 

information for each field. 

• Return to the ribbon and click on the Save Record option to save changed or edited information. 

Understanding the Associate Report 
In this section we are going to outline the different elements of the Associate Report. 

Associate Report – Ribbon 
The functionality of the Associate Reports sub-component is provided via the Ribbon control. Options 

on this ribbon are structurally and visually split into logical groups. Each of these groups includes 

commands that perform specific functions. 

 

The following are the elements on the Associate Report ribbon tab, reading left to right: 

• Add New – Creates a new blank record supporting the selected incident as found in the Incident 

Report section. 

• Save Record – This option saves any recent changes to the current record. 

• Print Preview – This option provides a print preview of the current report. 

• Exit – Exits this screen and returns to the Incident Report screen. 

Associate Report: Incident Details 

 

This is a non-editable region and is used to identify the Incident Report this supporting document is 

based on. 

Associate Report:  Facts – Job Steps tab 
This tab only contains one element, and is used to record what job steps were being performed with the 

incident occurred. 
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This alpha numeric field has no size limitations. You can edit this information with the Text Editor by 

clicking on the Edit button. 

Associate Report:  Causes tab 
This section contains two main elements: What Happened and What Caused the Incident. 

Cause tab: What Happened  
This section allows the associate to record in their own words what they think happened. 

 

Cause tab: What Caused the Incident 
This section allows the associate to record in their own words what they think may have actually cause 

the incident. 

 

Associate Report:  Prevention - Associate tab 
This section contains two main elements: Prevention recommendations and the Associate making this 

report. 

Prevention - Associate tab: Prevention 
This section allows the involved associate to make their recommendations on how to help prevent 

similar incidents from occurring again. 
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Prevention - Associate tab: Associate 
This section allows you to specify who made this report and the date it was made.  

 

• Associate’ Name – This is the name of the person making this report. You can either directly 

type in this field or select an employee from lookup. To select an employee from lookup: 

o Move to and click on the Select button. This will invoke the Employee Database lookup 

screen. 

o Move to the grid and select the record you want to assign and then click Select. 

• Date – This is the date this report was created. Set this field by using the attached calendar. 

To Receive a Print Preview of the Associate Report 

 

• Locate and make active the report that you want to print. 

• Move to the ribbon and select the Print Preview option. 
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Witness Report 
This report is the facts of the incident as described by someone that actually witnessed the incident. You 

can create more than one Witness report per main incident if needed. 

 

To create a Witness Report for the Incident: 

• Locate and make active the incident that you want to base the report on. 

• Move to the Home tab and click on the Witness Report option. 

• When the Witness Report loads, move to the ribbon and click on the Add New option. 

• Move through the various tabs and fields of this report and fill in or setup the appropriate 

information for each field. 

• Return to the ribbon and click on the Save Changes option to save changed or edited 

information. 

Understanding the Witness Report 
In this section we are going to outline the different elements of the Associate Report. 

Witness Report – Ribbon 
The functionality of the Witness Reports sub-component is provided via the Ribbon control. Options on 

this ribbon are structurally and visually split into logical groups. Each of these groups includes 

commands that perform specific functions. 
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The following are the elements on the Witness ribbon tab, reading left to right: 

• Add New – Creates a new blank record supporting the selected incident as found in the Incident 

Report section. 

• Save Changes – This option saves any recent changes to the current record. 

• Print Preview – This option provide a print preview of the current report. 

• Close – Exits this screen and returns to the Incident Report screen. 

Witness Report: Incident Details 

 

This is a non-editable region and is used to identify the Incident Report this supporting document is 

based on. 

Witness Report – Description tab 
This tab is used to provide a basic description of the incident being reported: 

Witness - Description tab: This report pertains to 
Selectable from the drop down list available here. This field would specify the category this incident 

relates to. Options include: 

• Personal Injury 

• Property Damage 

Witness - Description tab: Description of Property 
Use this alpha numeric field to provide a description of the damaged property. You can also click on the 

Edit button to edit this information with the Text Editor. 

 



Maintenance Coordinator – Professional Features 

 

Simplicity Software Technologies Inc. | Witness Report – What Happened tab 348 

 

Witness - Description tab: State the Nature of Injuries 
Use this alpha numeric field to provide a description of the injuries the employee obtained because of 

the incident. You can also click on the Edit button to edit this information with the Text Editor 

 

Witness Report – What Happened tab 
This tab provides the witness’s account of what happened as it related to the incident. 

Witness – What Happened Tab – What Took Place 
This field allows the witness (in their own words) to describe what happen. 

 

The drop down here allows the witness to specify if they actually seen this happen or was told about it. 

Witness – What Happened Tab – Non Eye Witness 
This section allows this person to record their non-eye witness account of the incident. 

 

The drop down here allows the witness to specify if the employee returned to work or not, immediately 

after the incident occurred. 

Witness – What Happened Tab – Injured Complains 
This section allows the witness to record any complains of injuries the employee may have made. 
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Witness Report – Witness tab 
The elements of this tab allows for the recording of any objects that may have been used and the name 

of the person  making this report. 

 

Witness – Witness tab – Objects Involved 
This section allows the witness to specify any objects or tools that may have been in use when the 

incident occurred. 

Witness – Witness tab – Properly Reported 
Selectable from the drop down list, this allows the witness to specify if they think the incident was 

properly reported. 

Witness – Witness tab – Witness Information 
Information in this section allows you to specify information about the reporting witness. The following 

specifies the elements of this section: 

• Name of Witness – This alpha numeric field specifies the name of the witness. 

• Date – This specifies the date of this report and is selectable from the attached calendar. 

• Job Title – This alpha numeric field is used to specify the job title of the witness. 

• Reference – This alpha numeric field is used to specify the witness employee reference id. 

• Select – Clicking this button allows you to select the witness from the Employee Database 

lookup. To select an employee from lookup: 

o Move to and click on the Select button. This will invoke the Employee Database lookup 

screen. 

o Move to the grid and select the record you want to assign and then click Select. 

Filtering the Incident Database 
You have two method of filtering the incident database. Using the default filter, or using the Filter 

Wizard. 
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Filter Wizard 
This option allows you to filter the database by criteria that you specify. To use this option: 

• Move to the Home tab in the ribbon and click on the Filter Wizard option. This will invoke the 

Incident Wizard. Please refer to the Incident Wizard section of this chapter to view how to use 

this feature. 

Default Filter 
This option filters the database by default setting which is view all. To filter by this option: 

• Move to the Home tab in the ribbon and click on the Default Filter option. 

Search 
To perform a search on the Incidents database: 

• Move to the Home tab in the ribbon. 

• Click on the Search option.  

• Refer to the Search section of the Common Features chapter for more information. 

Report Wizard Report 
The Report Wizard Report is actually multiple reports in one. It really depends on the grouping as 

assigned on the Group tab of the wizard. Options include: 

• Dates – Create an Incident Date Report. 

• Incident Types – Create an Incident Types Report. 

• Work Status – Create an Work Status Report 

• Treatment – Create an Treatment Report 

The following illustrates a basic ‘Incidents by Dates Report’: 
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• Move the Reports tab in the ribbon and click on the Report Wizard Report option. This action 

will invoke the Incident Wizard. Please refer to the Incident Wizard section of this chapter on 

how to use this wizard.  

• This report produce a chart to help represent the data returned. You are allowed to edit this 

chart before continuing with the finished report. To learn about the features of this Designer, 

please look at the Chart Designer section of the Reports and Graphics module. 

• When done modifying the chart, close the Designer to view the final report. 

Incident Fields Report 
This report allows you to breakdown incidents by individual fields. This helps you gain insight to what’s 

happening in your work place. 

To create an Incident Field Report: 
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• Move the Reports tab in the ribbon and click on the Incident Fields option. This will invoke the 

Incident Fields Report wizard. 

 
• Move to the Incident Fields tab, and move to the list of available fields. 

• Select Incident field you want to base your report on from those listed. 

• Move to the Report Dates tab by either clicking on that tab, or clicking the Next button. 

 
• Move to the Start Date field and using the drop down calendar, select the starting date of your 

filtering criteria. 

• Move to the End Date field and using the drop down calendar, select the ending date of your 

filtering criteria. 

• To ignore or use all available dates, check the Include All Dates checkbox. 

• This report produce a chart to help represent the data returned. You are allowed to edit this 

chart before continuing with the finished report. To learn about the feature of this Designer, 

please look at the Chart Designer section of the Reports and Graphics module. 
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• When done modifying the chart, close the Designer to view the final report. 

Workers Compensation 

In this section we will be outlining the Work Compensation component of the Safety Management 

module. Workers Compensation Claims are handled as part of an incident report, and are treated as an 

extension to of this record. The two features are basically dependent on one another. 

 

Workers Compensation Claims – Ribbon 
The functionality of the Workers Compensation Claims component is provided via the Ribbon control. 

Options on this ribbon are structurally and visually split into logical groups. Each of these groups 

includes commands that perform specific functions. 

 

The following are the elements on the Home ribbon tab, reading left to right: 

• Save Changes – This option saves any recent changes to the current record. 
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• Delete – Removes the selected record from the database. 

• Physicians Database – Invokes the Physicians Database dialog. 

• Insurance Carriers – Invokes the Insurance Carriers database dialog. 

• Print Preview – Provides a print preview of the current claim. 

• Claims Reports – Allows for the creation of claim reports. Options include: 

o Open Claims (Date Range) 

o Closed Claims (Date Range) 

• Claims Costs -Allows the creation of a Claims Costs Report based on a date range. 

• Open Claims – Filters the database to include only claims with a status of open. 

• Default Filter – Reapplies default filter settings to the claims database. 

• Close – Close the claims database and move control to the Incidents Report screen. 

Claims: Lookup Tab 
This tab helps in locating calims by grouping, filtering and sorting them. All the records in the current 

filter are located in the grid found here. To select a record and make it the active record, the user needs 

only to click on the item from within the grid. Once selected the user can click on the other tabs to view 

or edit the record itself. 

The following image illustrates the features available on the Lookup tab: 

 

The functions of the Lookup tabs are used through-out the system and are fairly common regardless of 

the modules that use them. Please review the chapter on Common Features to read about the 

functionality of the controls located on this tab. Apply special attention to the following: 

Claims: Details Tab 
The Details tab, and the other support tabs located on it, is for maintaining the main elements of a 

workers compensation claim. 

Claims: Incident Summary 
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This is a non-editable region and is used to identify the Incident Report this supporting document is 

based on. 

Claim: Activities History 
This section is used to record any activities that you want to track as they relate to the current claim. 

The following image illustrates the section: 

 

Add Activity 
If you want to record an activity as it related to this claim: 

• Move to the Activities History group and click on the Append (+) button within the Data 

Control located here. 

 
• When prompted, move to the input area and type it the activity description you are adding. 

Click on the OK button when done. 
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• When prompted, move to the input area and enter any costs associated with this claim. Click 

on the OK button when done. If there are no associated costs, click on the Cancel button. 

 
• Once the activity has been added, you can edit the date of the activity by: 

a. Move to the Date column of the activity you just added and click in this column. 

b. Click on the Down Arrow here to invoke the calendar. Set the date using this calendar. 

• Click on the Post/Save (✓) button to save your changes. 

• Repeat the above steps for each activity you want to add. 

Edit Activity 
To edit a pre-existing activity: 

• Move to list of activities and double mouse click in the cell you want to edit. This will invoke edit 

mode. 

• Edit the cell’s contents, clicking Enter to leave edit mode when done. 

• Click on the Post/Save (✓) button to save your changes. 

Delete Activity 
To delete a pre-existing activity: 

• Move to the list of activities and click in the activity record you want to delete.  

• Click on the Delete (-) button to remove the record. 

• Click on the Post/Save (✓) button. 

Claim Specifics – Sub Tab 
This tab is a sub tab found on the Details tab and is used to record specific information about the claim 

as shown in the following illustration: 
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Claim Number 
This alpha/numeric field can contain up to 30 characters and is used to record the claim number as 

issued. 

Date Claim Opened 
This date only field is used to specify the date the claim was opened and can be set by using the 

attached calendar. 

Date Claim Closed 
This date only field is used to specify the date the claim was closed and can be set by using the attached 

calendar. 

Insurance Carrier 
This alpha/numeric field can contain up to 50 characters and is used to specify the Insurance Carrier 

handling this claim. You can either type directly into this field or select a carrier from the database. To 

select the insurance carrier: 

• Click on the ellipsis (…) button adjacent to the Insurance Carrier field to invoke the Insurance 

Carriers lookup. 

• Select the company you want to assign by clicking on the record from within the grid and then 

clicking the Select button. 

Claim Closed 
Check this checkbox when the claim is closed. 

Medical – Sub Tab 
This tab is a sub tab found on the Details tab and used to record medical information about the claim as 

shown in the following illustration: 
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Attending Physician 
This alpha/numeric field can contain up to 50 characters and is used to specify the physician handling 

this claim. You can either type directly into this field or select a physician from the database. To select 

the a physician: 

• Click on the ellipsis (…) button adjacent to the Attending Physician field to invoke the 

Physicians lookup. 

• Select the physician you want to assign by clicking on the record from within the grid and then 

clicking the Select button. 

Date of Last Examination 
This date only field is used to specify the date the employee was last seen by the attending physician 

and can be set by using the attached calendar. 

Condition of Employee when last examined 
This alpha/numeric field has no size limitations and is used to record the employee condition at their 

last examination. You can either type directly into this field or use the Text Editor by clicking on the Edit 

button. 

Attachments – Sub Tab 
This tab is a sub tab found on the Details tab and used to maintain attachments to the current record. 

These could be copies of the Attending Physician’s Statements, and other supporting documents. The 

following illustrates the elements of this tab: 
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For more information on this feature, please refer to the Attachments section of the Common Features 

chapter. 

Claims: Notes Tab 
There is basically only a single element on this tab and that’s the editor that you can record notes as 

they relate to the current claim. This alpha/numeric field has no size limitations. You can edit these 

notes using the built-in Text Editor by clicking on the Edit button. 

 

Physicians Database 
The Physicians Database allows you to maintain information of physicians and is also used as a 

lookup/assignment dialog when dealing with Workers Compensation Claims.  

The following illustration shows the elements of the Lookup tab:  
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You select and make a record active by clicking on it from within the grid. 

The following image illustrates the elements of the Details tab: 

 

• Physician Name – This alpha/numeric field can contain up to 50 characters and is used to 

identify the physician. 

• Office Name – This alpha/numeric field and can contain up to 50 characters and is used to 

indicate the office or business name of the physician. 

• Telephone Number – This alpha/numeric field can contain up to 15 characters and represent 

the main telephone number. 

• E-Mail Address – This alpha/numeric field has no size limitation. Clicking on the ellipsis button 

here will open the default email application with the email address information inserted for you. 

• Mailing Address – This alpha/numeric field has no size limitation and is used to indicate the full 

mailing address as it relates to the record. 

• Notes - This alpha/numeric field has no size limitation and is used to record any notes you want 

to provide on the current record. 

Accessing the Physicians Database 
To open the Physicians database: 

• Move to the ribbon and click on the Physicians Database option. 
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Add a new Physician Record 
To add a new physician record: 

• Move to the data control and click on the Append (+) button. 

• Move to the Details tab, and edit the fields found there. 

• Move to the data control and click on the Post/Save (✓) button to save your changes. 

Deleting a Physician Record 
To delete an existing record: 

• From the Lookup tab, select and make active the record you want to remove. 

• Move to the data control and click on the Remove (-) button. 

• When prompted about the deletion, click Yes. 

Insurance Carriers Database  
The Insurance Carriers allows you to maintain information of workers compensation insurance carriers 

and is also used as a lookup/assignment dialog when dealing with Workers Compensation Claims.  

The following illustration shows the elements of the Lookup tab:  

 

You select and make a record active by clicking on it from within the grid. 



Maintenance Coordinator – Professional Features 

 

Simplicity Software Technologies Inc. | Insurance Carriers Database 362 

 

The following image illustrates the elements of the Details tab: 

 

• Agent’s Name – This alpha/numeric field can contain up to 50 characters and is used to identify 

the assigned insurance agent. 

• Company Name – This alpha/numeric field and can contain up to 50 characters and is used to 

indicate the office or business name of the insuring company. 

• Telephone Number – This alpha/numeric field can contain up to 15 characters and represent 

the main telephone number. 

• E-Mail Address – This alpha/numeric field has no size limitation. Clicking on the ellipsis button 

here will open the default email application with the email address information inserted for you. 

• Mailing Address – This alpha/numeric field has no size limitation and is used to indicate the full 

mailing address as it relates to the record. 

• Notes - This alpha/numeric field has no size limitation and is used to record any notes you want 

to provide on the current record. 

• Policy No – This alpha/numeric field can contain up to 50 characters and indicate the policy 

number you have with the insurance carrier. 

Accessing the Insurance Carriers Database 
To open the Insurance Carriers database: 

• Move to the ribbon and click on the Insurance Carriers option. 

Add a new Insurance Carrier 
To add a new carrier record: 
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• Move to the data control and click on the Append (+) button. 

• Move to the Details tab, and edit the fields found there. 

• Move to the data control and click on the Post/Save (✓) button to save your changes. 

Deleting an Insurance Carrier Record 
To delete an existing record: 

• From the Lookup tab, select and make active the record you want to remove. 

• Move to the data control and click on the Remove (-) button. 

• When prompted about the deletion, click Yes. 

Printing a Worker Compensation Claim 
To preview a workers compensation claim: 

• Move to and make active the record you want to print. 

• Move to the ribbon and click on the Print Preview option. 

 

Claims Reports 
You have two options for Claims Reports, with both of these options dealing with a date range. The 

following report options are available: 
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• Open Claims (Date Range) 

• Closed Claims (Date Range) 

The following illustrates an example of one of these reports: 

 

To create a Claims Report: 

• Move to the ribbon and click on the Claims Reports option. 

• Click on one of the options available. 

 
• From the invoked Date Range dialog setup the Start Date and End Date fields to specify the 

dates you want to report on. 

• Click on the OK button. 

Claims Costs Report 
This report returns cost information for a date range that you specify. The report presents the returned 

data in the forms of a chart with the totals for each month. 

To create a Claims Costs Report: 

• Move to the ribbon and click on the Claims Costs option. 
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• From the invoked Date Range dialog setup the Start Date and End Date fields to specify the 

dates you want to report on. 

• Click on the OK button. 

• This report produce a chart to help represent the data returned. You are allowed to edit this 

chart before continuing with the finished report. To learn about the feature of this Designer, 

please look at the Chart Designer section of the Reports and Graphics module. 

Filter the Claims Database by Open Claims 
To filter the Claim Database to view only open claims: 

• Move to the ribbon and click on the Open Claims option. 

Filter the Claims Database by the Default Filter 
To filter the Claim Database to view all claims: 

• Move to the ribbon and click on the Default Filter option. 
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Safety Inspections 

As you know regular safety inspections are essential in keeping your plant safe, clean, and in compliance 

with various regulations. With the Safety Inspections component it’s an easy task to create and 

administer regular safety inspections. This feature incorporates its own scheduler which will 

automatically generate future inspections for you. 

A Typical Inspection Layout 
The following illustrates the layout of a typical inspection document: 

 

Inspections – Ribbon 
The functionality of the Safety Inspections component is provided via the Ribbon control. Options on 

this ribbon are structurally and visually split into logical groups. Each of these groups includes 

commands that perform specific functions. 
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SAFETY INSPECTIONS TAB 

 

The following are the elements on the Safety Inspections ribbon tab, reading left to right: 

• Add New – Create a new blank inspection record. 

• Save Changes – Saves all current changes from all elements of a record (master save). 

• Generate Inspections – Allows you to generate and print a date range of inspections. 

• Edit Inspections – Allows you to edit inspections. 

• Inspections Report – Invokes the Inspection Wizard that allows you to specify the criteria to 

base your report on. 

• Close – Close this component and branches control back to Incident Reports. 

FILTERS TAB 

 

The following are the elements on the Filters ribbon tab, reading left to right: 

• Filter Wizard – Invokes the Inspection Wizard that allows you to specify the criteria to filter the 

database on. 

• Not Regenerated – Filters the database by all inspections that have not yet regenerated. 

• Default Filter – Filters the database by all open inspections. 

Features of the Inspection Component 
There are many features of the Safety Inspections Component, with the majority of these features found 

on either the tabbed pages found there, or within the tabbed ribbon control. We are going start by 

explaining the use of these features as we move through the tabbed pages. 

Inspections:  Lookup Tab 
This tab helps in locating inspections by grouping, filtering and sorting them. All the inspections in the 

current filter are located in the grid found here. To select an inspection and make it the active record, 

the user needs only to click on the record from within the grid. Once selected the user can click on the 
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other tabs to view or edit the record itself. Also note that double clicking on a record will move you to 

the Details tab showing the selected record. 

The following image illustrates the features available on the Lookup tab: 

 

The functions of the Lookup tabs are used through-out the system and are fairly common regardless of 

the modules that use them. Please review the chapter on Common Features to read about the 

functionality of the controls located on this tab. 

Inspections: Details Tab 
This tab allows you to setup the specifics about an inspection such identification and recurrence 

information. 

Inspection Description 
This section allows you to record inspection description information to help identify the document. The 

following illustrates the elements of this section: 

 

Inspection Description 
This alpha/numeric field can contain up to 60 characters and is used to help identify the document. 

Inspection Reference 
This field is generation for you by the application and is used to help identify the document. These 

numbers use the following format: yymm – xx. Where yy equals the year of document creation; mm 

equals the month of creation and xx is a sequential number. 

Inspection Scheduling 
There is only one element in this section as shown in the following illustration: 
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This date only field would indicate the date you want the inspection to occur. You can set the value of 

this field using the attached calendar. 

Inspection Status 
There is only one element in this section as shown in the following illustration: 

 

Selectable from the drop down list, this is the status indicator as it applies to the current inspection 

document. Options include: 

• Ready 

• Oh Hold 

• Completed 

• Canceled 

Inspection Recurrence 
The information in this area is used to tell the application at what frequency to recreate the inspection. 

The following image illustrates the elements of this section: 

 

Frequency 
This Frequency field allows you to specify the frequency at which the recurring inspection will recreate 

(regenerate) itself. 

To setup the Frequency: 

• Click on the down arrow attached to this field. 

• Click on the value you want to assign from those listed. 
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Available values are: 

• None 
• Every XX Meters (*see note below) 
• Every XX Days 
• XX Days (Mon-Fri) 
• Daily 
• Daily (Mon-Fri) 
• Weekly 
• Bi-Weekly 
• Every XX Weeks 
• Monthly 
• Bi-Monthly 
• Every XX Months 
• Quarterly 
• Semi-Annually 
• Annually 
• Every XX Years 

 

Every XX Criteria 
If the selected Frequency has XX anywhere in its description, the XX Criteria value must also be 

provided. This field only accepts numeric values. 

To assign the Every XX Criteria value, please do one of the following: 

• Click the up arrow to increase the value here. 

• Click the down arrow to decrease the value here. 

• Click and type in your value in the space provided. 

The value entered here replaces the ‘XX’ criteria of the selected frequency. For example, if you have a 

Frequency of ‘Every XX Months’ selected, and you enter ‘3’ for the XX Criteria, the inspection would 

regenerate ‘Every 3 Months’. 

Do Not Regenerate 
For recurring types of inspections, setting this value will prevent the program from regenerating the 

inspection at the set frequency. Also be aware that as the program executes one of the built-in 

regeneration routines, it will automatically set this flag. This basically does two things: 

• It tells the application and the user that the inspection has already regenerated itself and a new 

one should already be present in the database. 

• It prevents the program from regenerating the ‘same’ inspection again. Thereby preventing 

possible duplicates from being created. 

Checking this checkbox will prevent the inspection from regenerating. 
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Date of Inspection 
There is only one element in this section as shown in the following illustration: 

 

This date only field would indicate the date the inspection took place. You can set the value of this field 

using the attached calendar. 

Inspection Comments 
There is only one element in this section as shown in the following illustration: 

 

This alpha/numeric field has no size limitations and is used to record comments, observations and 

recommendations as it applies to the inspection that was made. You can edit this field with the Text 

Editor by clicking on the Edit button. 

Inspection Assignments 
The assignments made in this section will assist you in grouping your inspections on both the Lookup 

tab, and for use in reports and filtering. The following illustrates the elements of this section: 

 

Classification 
Selectable from the drop down list here, this field represents the Classification you want to assign to this 

inspection. 
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Location 
Selectable from the drop down list here, this field represents the Location you want to assign to this 

inspection. 

Inspection Inspectors 
This section allows you to record the names of up to 3 people that performed the actual inspections. 

The following shows the elements of this section: 

 

Each of these 3 fields can contain up to 30 alpha/numeric characters each. You can either type directly 

in to these fields of select assignments from the Employees Database. To assign from the database: 

• Move to and click on the Select button adjacent to the field you want to make an assignment 

on. 

• From the invoked Employee Database lookup, select the record you want to assign from those 

listed in the grid. 

• Click on the Select button. 

Inspection Group 
This section allows you to view and assign an inspection group to the current inspection, and also edit 

group’s inspection items. The following illustrates the elements of this section: 

 

Inspection List 
This field indicates the name of the checklist currently assigned to this inspection. 

Select Inspection List 
Clicking this button will allow you to assign an inspection checklist to be used by the current inspection 

record. Inspection lists can be assigned to more than one inspection. To assign an Inspection List: 
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• Move to and click on the Select Inspection List button. 

• From the invoked Safety Inspections List dialog, move to the grid and select the item you want 

to assign. 

• Click on the Select button. 

Edit Inspection Tasks 
Clicking this button will invoke the Safety Inspection Items dialog. With this screen you can view and 

edit the group assignments and the inspection items belonging to the groups. For more information on 

this dialog please refer to the following couple of sections. 

Safety Inspection Checklists 
In this section we are going to outline or try to explain the elements of Safety Inspection Checklists. 

• Inspections are documents that are provided to personnel (inspectors) so they can perform 

inspections as outlined in groups (areas), and the items to inspect as assigned to these groups. 

• Inspection Lists help organize related Inspection Groups, and that group’s associated Inspection 

Items. Each main Inspection Document can have only one Inspection List assigned to it. 

However, an Inspection List can be assigned to an unlimited number of main Inspections 

Documents. Basically, an Inspection List contains all groups and items of an inspection. 

• Inspection Groups are assigned to Inspection Lists, and you can assign as many Inspection 

Groups to an Inspection List as needed. Inspection Groups provide a means to divide Inspection 

Items in to logical groups or areas. For clarification on the Inspection document, it is suggested 

to use an area description for these group titles. Examples could be: ‘Lunchroom’, ‘Storage 

Area’, and ‘Production Room’.   

• Inspection Items are the actual items to be inspected. Inspection Items are assigned to 

Inspection Groups, and you can assign as many Inspection Items to an Inspection Group as 

needed. An example of an Inspection Item would be: ‘Ensure there are no slip hazards in the 

area’.  

The following illustrates an Inspection Group and its assigned Inspection Items: 
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Safety Inspection Lists 
Safety Inspection Lists hold the items to be inspected. In order to create inspection items to be checked, 

a list to hold these items must first be created. The following is an illustration of the Safety Inspection 

List dialog: 

 

To add a new item to the Safety Inspection List 

• Invoke the Safety Inspection List dialog by either clicking on the Edit Inspections option in the 

ribbon or moving to the Details tab and clicking the Select Inspection List button. 

• Move to the Data Control and click on the Append (+) button.  

• When prompted to enter a name for this inspection list, enter this in the space provided and 

then click on the OK button. This alpha/numeric field can hold up to 50 characters.  

 



Maintenance Coordinator – Professional Features 

 

Simplicity Software Technologies Inc. | Edit Inspection Tasks 375 

 

• Click on the Post/Save Changes (✓) button to save the changes. 

To edit an item in the Safety Inspection List 

• Move to the grid and double click in the cell that holds the item you want to edit. This action will 

invoke edit mode. 

• Edit the text. 

• Click on the Post/Save Changes (✓) button to save the changes. 

Deleting an item in the Safety Inspection List 
Note: Deleting the selected inspections list will delete all associated inspection items at the same time. 

• Move to the grid and select the item you want to remove. 

• Move to the data control and click on the Remove (-) button. 

 
• When prompted about the deletion, click on the Yes button. 

Edit Inspection Tasks 
Inspection Tasks would indicate the items to be inspected as arranged in groups. To edit the items to be 

inspected, this sequence must first be followed: 

• Creation and selection of the Inspection List. 

• Creation and selection of an Inspection Group. 

• The Editing of the Inspection Items. 

The following illustrates the elements of the Safety Inspection Items Editor:  
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To access the Safety Inspections Items Editor 
From the ribbon control: 

• Move to the ribbon and click on the Edit Inspections option. 

• From the invoked Safety Instructions List, select the List that contains the items you want to 

access or edit from those listed in the grid. 

• Click on the Select button to invoke the Safety Inspections Items dialog. 

Adding a New Group or Area 
To add a new group or area: 

• Move to the Data Control on the left of the screen (inspection groups) and click on the Append 

(+) button. 

 
• When prompted to enter a name for the new group, enter this in the space provided and then 

click on the OK button. This alpha/numeric field can hold up to 40 characters. 

• Return to the same data control and click on the Post/Save Changes (✓) button to save the 

changes and add the group. 
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Adding a New Inspection Item 
To add a new inspection item: 

• Move to the grid of all the groups or areas and select the group you want to add an inspection 

item to by selecting it. 

• Move to the Data Control on the right side of the screen (inspection items) and click on the 

Append (+) button. 

 
• When prompted to enter a new inspection item, enter this in the space provided and then click 

on the OK button. This alpha/numeric field can hold up to 80 characters. 

• Return to the same data control and click on the Post/Save Changes (✓) button to save the 

changes. 

Creating a New Inspection 
To create a new inspection record: 

• Move to the ribbon and click on the Add New button. 

• Move through the fields of the Details tab and edit the information found there. 

• Move to the ribbon and click on the Save Changes option. 

Saving Changes 
Whenever you edit a record, you must save your changes to retain these edits. 

To Save Changes: 

• Move to the ribbon and click on the Save Changes option. 

OR 

• Move to the data control in the Quick Access toolbar and click on the Post/Save Changes 

button.  
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Generate Inspections 
With the Generate Inspections routines you can generate a date range of inspection records. Once 

generated, you can then print some or all of these records. The following illustrates the elements of this 

feature: 

 

To Generate a Date Range of Inspections 

• Move to the ribbon and click on the Generate Inspections option. 

• From the invoked Generate Inspections dialog, move to and click on the Generate button. 

 
• From the invoked Date Range dialog, move to the Start Date field, and using the attached 

calendar, select the starting date that you want to use. 

• Move to the End Date field, and using the attached calendar, select the ending of Inspection 

generation. 

• Click on the OK button. 
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• You now have the following print options: 

o Preview Selected – Clicking this button will provide a print preview of the selected 

record. 

o Print Selected – Clicking this button will send the selected inspection record to the 

printer. 

o Print All – Clicking this button will send all inspection records, as shown, to the printer. 

 Inspections Wizard 
The Inspections Wizard is used to create the Inspections Report, and is also used as the Filter Wizard. 

This wizard will be outlined next.  

The following illustrates the common feature of the Inspections Wizard: 

 

CRITERIA TAB 
The following are the elements of the Criteria tab: 
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• Status – Selectable from the drop down list, this is the Status indicator to filter by. Click the Use 

All button to ignore this criteria. 

• Classification – This field criteria is selectable from a Lookup dialog. Click on the Use All button 

to ignore this criteria. 

• Location – This field criteria is selectable from a Lookup dialog. Click on the Use All button to 

ignore this criteria. 

DATES TAB 
This tab allows you to specify the date range of inspection records to filter by. The following illustrates 

the elements of this tab: 

 

• Start Date – This is the start date of the filtering range and is set by using the attached calendar. 

• End Date – This is the end date of the filtering range and is set by using the attached calendar. 

• Use All Dates – Checking this checkbox will ignore date criteria. 

SORT TAB 
This field allows you to specify which field to sort by. The following illustrates the elements of this tab: 
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• Selectable from the drop down list, this field specifies how the returned data should be sorted. 

Options include: 

o Scheduled Dates 

o Inspection Dates 

o Reference 

Accept Criteria 
Once you’re done setting up your criteria, move to and click on the Accept button to apply the options 

you have setup. 

Inspections Report 
The following illustrates the elements as found on an Inspection Report: 

 

To create the Inspections Report: 

• Move to the Safety Inspections tab in the ribbon and click on the Inspections Report option. 

• This report use the Inspections Wizard to setup the criteria to base the report on. Please refer 

to the Inspection Wizard section of this chapter on how to use this wizard. 
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Filter Wizard 
The Filter Wizard allows you to apply special filtering options on the Inspections database. To use the 

Filter Wizard: 

• Move to the Filters tab in the ribbon and select the Filter Wizard option. 

• This filter uses the Inspections Wizard to setup the criteria to filter the database by. Please refer 

to the Inspection Wizard section of this chapter on how to use this wizard. 

Not Regenerated Filter 
This option filters the Inspections database by all inspection records that have yet to regenerate 

themselves. This can be useful when you want to turn off regeneration on selected inspections. To filter 

the database by Not Regenerated Inspections: 

• Move to the Filters tab in the ribbon and select the Not Regenerated option. 

Default Filter 
This option removes any custom filtering that has been applied to the database and returns to the 

default filter (all open). To reapply the default filter: 

• Move to the Filters tab in the ribbon and select the Default Filter option. 

Print Options 
To print the current inspection record: 

• Locate and select the record you want to print. 

• Open the File menu and expand the Print Options menu by clicking on it. 

• Click on the Print Option of your choice: 

o Print Inspection - Allows printer selection and other options before printing. 

o Quick Print - Sends the document directly to the default printer. 

o Print Preview - Provides a print preview of the current record. 
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Safety Tasks List 

Any good safety program is sure to generate a list of things that need attention. These can come from 

the results of safety inspections, suggestions, and incidents. The punch list allows you to keep track on 

these items and can actually create work orders form this list. 

 

To access the Safety Task List: 

• Move to and click on the Safety Task List tab in the Navigation Bar. 

Safety List - Ribbon 
The functionality of the Safety Task List is provided via the ribbon control. This control is structurally and 

visually split into logical groups. Each of these groups includes commands that perform specific 

functions. 
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The following are the elements on the Safety Tasks List ribbon control, reading left to right: 

• Add New – Creates a new task record and opens it in the Safety Task Editor. 

• Edit Task – Allows you to edit and delete a pre-existing task.  

• Print – Prints the task record as it related to the selected record. 

• Print Preview – Provides a print preview of the task record. 

• Print List – Prints the current list of tasks. 

• Default Filter – Filters the database by documents with an open status. 

• View All – Allows you to view all tasks regardless of status. 

• Close - Exits Personal Task List and invokes the menu screen. 

Adding a New Task 
To add a new task: 

• Move to the Safety Tasks List screen. 

• Move to the ribbon and click on the Add New button.  

• Follow the instructions on using the Safety Task Editor as found in this chapter. 

Editing a Task 
To edit a pre-existing task: 

• Move to the Safety Tasks List screen. 

• Move to the list of tasks and select the task you want to edit. 

• Move to the ribbon and click on the Edit Task button.  

• Follow the instructions on using the Safety Task Editor as found in this chapter. 

Printing a Task 
You can print the selected work order: 

• Select and make active the task record you want to print. 

• Locate the Print Options group in the ribbon. 

• Click on the Print or Print Preview options. 

Print Tasks List 
To print the entire tasks list as currently shown: 

• Move to the Safety Tasks List screen. 

• Move to the ribbon and click on the Print List option. 



Maintenance Coordinator – Professional Features 

 

Simplicity Software Technologies Inc. | Safety Tasks Editor 385 

 

Safety Tasks Editor 
Tasks are created and edited using the Task Editor. This editor allows you to setup specifics about a task. 

 

Safety Tasks Editor - Ribbon 
The functionality of the Safety Tasks Editor is provided via the ribbon control. This control is structurally 

and visually split into logical groups. Each of these groups includes commands that perform specific 

functions. 

The ribbon found here has two tab pages, Tasks and Format. The Tasks page is exclusive to the editor 

and will be explained. The Format page deals with formatting the main body of the tasks and share 

features of the Rich Text Editor. Please refer to the Rich Text Editor chapter for information on the 

options available on the Format ribbon page. 

  

The following are the elements on the Task page in the ribbon control, reading left to right: 

• Save and Close – Saves any changes made and closes this editor. 
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• Delete Task – Deletes and removes the loaded task from the database. 

• Mark as Completed – Moves through the various task fields marking the task as completed. 

• Create Work Order – Create a new work order based off the selected task. 

• Check Spelling – Checks the spelling as it applies to the main body of the task. 

• Cancel and Close – Closes the editor without applying any changes made to the task. 

Elements of the Task Editor 
The following is an outline of the data input fields as it relates to the Safety Tasks Editor: 

 

• Subject – This alpha/numeric field can contain up to 100 characters. Use this field to provide a 

brief identification for the task. 

• Priority – Selectable from the drop down list, this would indicate the priority you are assigning 

to the tasks. Option include: High Importance, Normal and Low Importance. 

• Start Date – This date only field would indicate the scheduled date work on this task will 

commence. 

• Due Date – This date only field would indicate the date you would like this task to be completed 

by. 

• Completion Date – This date only field would indicate the actual date the task was completed. 

• Status – Selectable from the drop down list, this would indicate the current status of the task 

Options include: Not Started, In Progress, Completed, On Hold and Deferred. 

• Completed – When checked, this would indicate that the task has been completed. 

• Requested By – This alpha/numeric field can contain up to 30 characters. Use this field to show 

who requested this task. You can select an employee by clicking on the ellipse button attached 

to this field. 

• Classification – This alpha/numeric field can contain up to 30 characters. Use this field to assign 

a classification to the tasks. 

• Percent Completed – This field is used to indicate how much of the task has been completed. 

This numeric only field will accept values in the range of 0 to 100. 

• Main Editor – This area is used to outline the complete task. There is no size limitation to this 

field and it makes use of a rich text editor allowing for many formatting options. 

Creating a Work Order from Task List 
You can create a work order based on a task by: 

• Locate and make active the task you want to create a work order for. 

• Move to the ribbon and click on the Edit Task button.  

• Move to Task tab in the ribbon and click in the Create Work Order option. This will invoke the 

Work Order creation wizard. 
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• Refer to the Common Features chapter and the Work Order Wizard section to find how to use 

this wizard. 

Purging Older Tasks Records 
Once you’ve been using the Safety Tasks for a while, you may want to purge or delete some of the 

older, completed tasks out of the database. To do this: 

 

• Move to the Safety Tasks List screen. 

• Move to the list of tasks and right-mouse click on the grid. 

• Select the Purge Completed (Dates) option. 

• From the invoked calendar, select the ending date of the purge. All completed tasks prior to this 

date will be removed from the database. 

 

• Click on the Accept button. 

When prompt about the deletion, click on the OK button to proceed 
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